# Contents

**Chapter 1: About this Guide** .................................................. 1
  - Who Should Read This Guide? ............................................. 2
  - System Changes ................................................................. 3
  - Notation Conventions ......................................................... 5

**Chapter 2: About Courses** .................................................... 7
  - Course Catalog and Schedule of Classes—What's the Difference? .. 8
  - Types of Courses ............................................................... 9
  - Overview of Course Management ......................................... 11

**Chapter 3: About PeopleSoft Course Information** ....................... 13
  - What Is the PS Course Information System? ......................... 14
    - The Course Information System ...................................... 15
  - Making Sure It’s the Right Data ........................................ 16
    - Effective Dating ............................................................ 16
    - Control Tables, Lookup Buttons, and Search Results ........... 17
    - Adding Rows ................................................................. 17
    - Using the Navigation Controls in the Header Bar ................ 18
  - Signing In and Out ........................................................... 21
    - Signing In to the System ................................................ 21
    - Signing Out ................................................................. 25
  - Understanding PeopleSoft Page Groups ................................ 27
    - Course Information Page Groups ..................................... 29
  - Using the Find an Existing Value Page ............................ 30
    - Retrieving a Single Record ............................................ 30
    - Retrieving a List of Records ......................................... 32
    - Working Through a Search List ...................................... 35
    - Using a Lookup Button to Find Field Values .................... 36

**Chapter 4: Maintaining Course Information** ............................. 39
  - About the Course Catalog ............................................... 40
  - Adding a New Course ....................................................... 43
    - Establishing a New Course on the Catalog Data Page ............. 43
    - Adding Topics for a New Course ...................................... 52
    - Associating the Course with a Subject Area ....................... 53
    - Cross-Listing a Course .................................................. 55
    - Defining Course Requirements ...................................... 57
    - Assigning an Instructor to the Course .............................. 59
    - Defining Course Components ........................................ 62
Contents

Changing Course Information ................................................ 66
Accessing the Course Catalog ............................................. 68
Changing the Grading Basis ............................................... 75
Changing the Academic Structure ...................................... 77
Adding or Changing a Cross-Listing ................................. 79
Adding a New Topic .......................................................... 85
Changing the Instructor-in-Charge ..................................... 87
Changing the Course Attributes ........................................ 91
Changing Components ...................................................... 92
Changing the Course Requirements ................................... 99
Saving Your Changes ....................................................... 102

Submitting a Course for Approval ....................................... 103
Tracking Your In Progress Courses .................................... 103
Submitting a Course ........................................................ 105

Course and Class Synchronization ..................................... 107
Running the Course/Class Synchronization Process ............ 108

Chapter 5: Scheduling Classes .......................................... 113
Selecting Courses from a Previous Term ......................... 114
Locating Courses from Prior Terms ................................. 115
Printing Worksheets ......................................................... 119
Identifying Courses to be Copied ..................................... 125

Copying Courses to the New Term ..................................... 126
Copying One or More Courses ........................................ 126

Scheduling a New or Updated Course ............................... 131
Accessing the Schedule New Course Page Group .................. 133
Creating the Sections ....................................................... 135
Selecting the Topic for This Term ..................................... 138
Adding Attributes ............................................................ 140
Entering a Description for the Offering .............................. 142
Adding the Sample Reading List ....................................... 144
Adding Additional Information ....................................... 146
Setting the Grading Requirements ..................................... 148
Scheduling the Section Meetings ....................................... 150
Setting Enrollment Controls ........................................... 158
Setting the Reserve Capacity ........................................... 162
Setting the Reserve Capacity Release Date ....................... 165

Adding and Deleting Sections in the Schedule ................... 168
Accessing the Schedule of Classes Page Group ................. 169
Adding a New Class Section ............................................. 171
Deleting a Section ............................................................ 179

Changing the Time and Day of an Offering ....................... 181
Changing a Standard Meeting Pattern ............................. 181
Changing to a Non-Standard Meeting Pattern ................... 185
Assigning Student-Specific Permissions ........................................... 273

**Appendix A: Glossary** .......................................................... 279

**Appendix B: Tips and Techniques** ........................................... 285
- Running Processes ........................................................................ 286
- Run Controls ............................................................................... 286
- Using the Process Scheduler Request Page ................................. 288
- Using the Process Monitor .......................................................... 290
- Setting Your User Defaults ......................................................... 291
- Inserting Special Characters in Descriptions ............................... 294
- Locating Your Network Printer Name .......................................... 297
- PDF Reports ................................................................................ 301
  - Creating a Report in PDF Format .............................................. 301
  - Displaying a PDF Report ....................................................... 302
  - Saving a PDF Report Without Displaying It ........................... 306
- Viewing an Instructor’s Schedule ................................................. 308

**Appendix C: Announcement Process** ......................................... 311
- Preparing to Run the Announcement ......................................... 312
  - Choosing a Drive Letter ......................................................... 312
  - Mapping the Drive ............................................................... 313
  - Creating a Shortcut to the Announcement Folder .................... 314
- Running the Undergraduate Announcement ............................... 317
  - Viewing and Saving a Report ............................................... 320

**Index** ...................................................................................... 325
About this Guide

Who Should Read This Guide? .................................................. 2
System Changes ................................................................. 3
Notation Conventions ......................................................... 5
Who Should Read This Guide?

This Academic Departments User Guide for the PeopleSoft Student Administration Course Information System is for staff members of the academic offices. The staff collects, updates, and reviews information about courses that will be published in the Graduate School Announcement, Undergraduate Announcement, and in the Course Offerings publications. This user guide contains information about viewing, updating, and printing course information, scheduling classes, assigning classrooms, and managing course enrollment.
This release includes changes to support the following features:

 dévelops Provisional Save
You will now be able to save course or schedule changes provisionally until you are ready to submit the course to the Dean for approval. When you make a change that formerly would have changed the approval status to Pending, the status will change instead to In Progress. You will be able to save the change and come back to it later for further changes. The course will not change to an approval status of Pending until you submit the course.

Changes to sections in the Schedule of Classes that would formerly have changed the Course Catalog entry to an approval status of Pending will also now default to an approval status of In Progress. To submit such a change in the Schedule of Classes, you will need to submit the course for approval from the Course Catalog.

Note: For new courses, you must still submit hard copy information to the Dean’s Office.

The search page for both the Course Catalog and the Schedule of Classes has been modified to allow you to search for courses or classes by the Course Approved status. This will allow you to generate a search results list of all entries that are In Progress, or Pending, or Approved, and work through the list, as needed.

Once a course or class has been submitted for approval, the status will change to Pending, and you will not be able to make any further changes until the course has been approved.

Tip! Some changes are allowed in the Schedule of Classes while the course is pending.

Class Sections Page
This new page summarizes scheduled class sections for quick review, and allows you to make enrollment updates to multiple classes from one page. This page is particularly useful during the enrollment period, when you need to monitor class enrollments closely. You will be able to change the enrollment capacity of a section, or stop further enrollment in a section from this page.
Chapter 1: About this Guide

✵ Changes to support streamlined course enrollment

- **Optional Components**
  New information is included on the Components page of the Course Catalog. A checkbox labeled *Optional Component* will be displayed, but greyed out (or dimmed). This checkbox will be selected (✓) automatically for precepts, drills, films, and ear training sections. This change has been made to support changes for streamlining the enrollment process.

  ![Note]
  **Note:** Optional is an internal designation; students are required to enroll in the section, but not through SCORE.

- **Tentative Sections**
  Again, to support future changes for streamlining enrollments, precepts, drills, films, and ear training components in the Schedule of Classes will have a default status of Tentative. You may no longer use the Tentative status as a way to hold a section back in case other sections reach maximum enrollment.

  ![Important]
  **Important!** Do not change the Status of a precept, drill, film, or ear training component from Tentative to Active. If you change the status of one of these components to Active, the Registrar’s website, Course Offerings, SCORE, and other reports and processes will not function properly.

There will be no change in how you enter course information or schedule classes; it will just look slightly different. Optional components will still need to be assigned meeting times, enrollments and room capacities:

- You may still use TBA for optional component meeting times, but you must assign a real meeting time by the room assignments deadline if you need a room assigned by the Classroom Assignment Coordinator.
- The room capacity is still required for classroom scheduling.
- Although students will no longer enroll in these precepts, drills, films, and ear training sections using SCORE, Blackboard will pick up the enrollment capacities set in the Schedule of Classes.

The five-digit class number will no longer appear next to precepts, drills, films, and ear training sections in the Course Offerings booklet or on the Registrar’s web site. However, each of these sections will still be assigned a class number in CIS.
Notation Conventions

The following conventions are used in this document:

Table 1: Notation Conventions

<table>
<thead>
<tr>
<th>Convention</th>
<th>Example</th>
<th>Used for</th>
</tr>
</thead>
<tbody>
<tr>
<td>Menu names separated by the greater-than symbol</td>
<td>Navigate to Manage Student Records &gt; Establish Courses &gt; Use &gt; Course Catalog</td>
<td>Navigation path</td>
</tr>
<tr>
<td>Text in bold, sans serif</td>
<td>1002</td>
<td>Field values—you select or type</td>
</tr>
<tr>
<td>Text in italic, sans serif</td>
<td>mm/dd/yyyy</td>
<td>Text or codes indicating the format of the value you enter in a field</td>
</tr>
<tr>
<td>Text in italics, with a light bulb icon in the margin</td>
<td>Tip! You can type this value directly, rather than selecting it from the list.</td>
<td>Tips—information that is useful, but not required</td>
</tr>
<tr>
<td>Text in a bordered paragraph, with a pushpin icon in the margin</td>
<td>Note: There are separate codes that can be used to satisfy the writing...</td>
<td>Notes—information you need to know</td>
</tr>
<tr>
<td>Italic text in a bordered paragraph, with an exclamation point icon in the margin</td>
<td>Important! Do not leave File as the Output Destination.</td>
<td>Important information that you must be aware of to avoid problems</td>
</tr>
<tr>
<td>Bold text preceded by a checkmark in the margin</td>
<td>To add a topic:</td>
<td>The start of a step-by-step procedure</td>
</tr>
</tbody>
</table>
About Courses

Course Catalog and Schedule of Classes—What’s the Difference? . . 8
Types of Courses . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 9
Overview of Course Management . . . . . . . . . . . . . . . . . . . . . . . . . . 11
In PeopleSoft terms, a course is an instructional set of components dealing with a particular subject. Courses are defined in the PeopleSoft Course Catalog, which is the database that contains all the information stored about all courses. Princeton’s Undergraduate Announcement and Graduate School Announcement publications are created from the data stored in the Course Catalog. However, the Course Catalog also includes courses that don't appear in the Announcement, such as one-time-only courses, Junior Independent Work, and Senior Thesis.

The Schedule of Classes contains the sections or components of a course that are scheduled for a particular term. In each new term, courses that have been scheduled before are selected for copying (rollover) to the new term. Any new courses are scheduled using the Schedule New option, based on the Course Catalog definition. Some types of changes to existing courses also require them to be scheduled as new courses, even if they were scheduled in a previous term.

The PeopleSoft Schedule of Classes contains the information used to create Princeton’s Course Offerings publication, and to schedule the classes into which students will be able to enroll.
Types of Courses

There are three types of courses offered at Princeton that you will be entering in the Course Catalog:

- Permanent Courses
- Topics Courses
- One-Time Only Courses

Permanent Courses

Most courses fall into this category. These are courses that are approved for the permanent curriculum and appear in the Announcement publications. Permanent Courses can be seminars, lectures, and courses with labs and other special sections. Undergraduate permanent courses use the numbers from 100–499, while graduate courses use the numbers from 500–699.

The following permanent courses require special processing:

- **Cross-listed Course**
  A cross-listed course is listed in two or more departments, and may have the same or a different catalog number. The course is defined by the home department, using an additional offering for each other department that offers the course. When printed in the Announcement and Course Offerings publications, the course title prints in each department, with the course information and schedule in the home department, and a cross reference in the other departments.

- **Junior Independent Work / Senior Thesis**
  These are the courses used for Junior Independent Work and Senior Thesis. Although most of these courses are not published, they must be included in the course catalog. The Office of the Registrar enters these courses and numbers them in the 900 series within each department.

Departments handle the credits for independent work differently—some departments count independent work as 2 separate terms of 1 credit each, some count it as one term of 2 credits.
**Topics Courses**

Although the catalog number and title of a topic course remain the same, the topic itself may change each time the course is offered. Specific undergraduate topics courses may be offered up to 3 times. Specific graduate topics courses may be offered any number of times. A student may repeat the course for credit, provided the topic and course content are different each time the course is taken.

**One-Time Only Courses**

These courses are proposed to be offered only once, but for undergraduate courses, may be offered up to 3 times. Graduate one-time-only courses are offered only once. These courses appear in the Course Offerings publications, but may not appear in the Announcement publications if information about them is not known in time.

The following two types of one-time-only courses are initiated by students, and might not appear in the Announcement or Course Offerings:

- **Reading Courses**
  Only the initiating student enrolls in the course. Undergraduate reading courses use catalog numbers under 100 (for example, 091). Graduate reading courses use catalog numbers in the 700 series. The catalog numbers are repeated as needed each term, but the topic is different every time.

- **Student-Initiated Seminars**
  These are similar to reading courses, except they are not one-on-one. They are small, up to 10 or 12 students. Student-initiated seminars use 2-digit numbers prefixed with ST, such as ST01.

In addition to the courses entered by the academic departments, the Course Catalog contains other courses not maintained by the academic departments. For example, Freshman Seminars are entered into the Course Catalog by the Freshman Seminars Program staff, with a subject area of FRS. Offered only to freshmen, these classes are listed in a separate booklet in the Fall, but are included in the Spring Course Offerings booklet. Freshman Seminars appear in the course offerings listed on the Registrar’s web site, but are not printed in the Undergraduate Announcement.
Overview of Course Management

The current body of courses offered at Princeton appears in the PeopleSoft Course Catalog database. Departmental users are responsible for updating the Course Catalog with new courses and changes to existing course characteristics, such as components, additional topics, and instructors.

When a course has been added or modified, and submitted for approval, a dean (Graduate or Undergraduate, depending on the course) either approves it, or requests the department to make adjustments to the information.

The Course Catalog is the foundation for the Announcement publications. The data must be correct and approved in the Course Catalog in order to appear correctly.

When it is time to prepare the Schedule of Classes for a term, a department follows this general procedure:

1. Departmental users print pre-worksheet course lists for the courses they expect to offer in the next term. This list shows the information about selected courses offered in previous terms, back to the fall term of 1990. The departmental user selects the courses for which worksheets will be printed, based on the information in the pre-worksheet course list. Worksheets can be printed for any course offered from the 1995–1996 academic year through the present.

2. The departmental user prints the worksheets and distributes them to the faculty members who will teach the classes. If changes are required from the previous offering of the course, the faculty member marks the worksheet for the departmental user to enter.

3. Based on the worksheets, the departmental user identifies the courses to be copied (rolled) into the next term’s Schedule of Classes. Any new courses are scheduled using the Schedule New option, based on the Course Catalog definition. Some types of changes to existing courses also require them to be scheduled as new courses, even if they were scheduled in a previous term.
4. When the courses have been copied into the new term, changes can be made to the information in the Schedule of Classes for the new term, including changes to the description, grading requirements, reading & writing assignments, and scheduled sections. Any changes requiring approval must be submitted to the Dean’s Office. When all changes have been edited and proofed, the Course Offerings publication is printed and distributed.
About PeopleSoft
Course Information

What Is the PS Course Information System? 14
The Course Information System 15
Making Sure It's the Right Data 16
Effective Dating 16
Control Tables, Lookup Buttons, and Search Results 17
Adding Rows 17
Using the Navigation Controls in the Header Bar 18
Signing In and Out 21
Signing In to the System 21
Signing Out 25
Understanding PeopleSoft Page Groups 27
Course Information Page Groups 29
Using the Find an Existing Value Page 30
Retrieving a Single Record 30
Retrieving a List of Records 32
Working Through a Search List 35
Using a Lookup Button to Find Field Values 36
What Is the PS Course Information System?

The PeopleSoft Course Information System is part of a distributed Student Administration system. The Course Information System allows authorized users in the academic departments to create and update courses, and print course worksheets, proofs, and various other reports. The Dean of the College, the Dean of the Graduate School, and the Office of the Registrar still maintain their oversight and approval functions.

With PeopleSoft Student Administration, students can register for the academic year, as well as add and drop courses online.

Although the PeopleSoft Course Information System provides the distributed processing that allows departments to enter their own course information, the system uses a centralized database to store the information, regardless of where that information originated. The database consists of linked tables that are updated to remain in sync as data is entered and changed. Thus, a course description entered by the English department can be viewed and approved by the Dean of the College, and used to generate the Undergraduate Announcement.

The PeopleSoft Student Administration Module has a number of key capabilities:

- **Secured access.** Security features prevent unauthorized users from seeing confidential information or changing data unintentionally. Your access is determined by your role as a staff member or student.

- **Real-time data.** Data is entered directly into the database at the source, and can then be viewed by anyone with the necessary security. You are not viewing a copy of the real data, but the actual data, and if that data changed at 10:45, you will be able to see the changed data at 10:46.

- **Increased accuracy.** Data must be entered in a standard format, so it is accurate and accessible to other users. For example, certain values that must be in upper case are converted to upper case regardless of how they are entered.

- **Increased consistency.** PeopleSoft uses control tables to populate search results lists with appropriate values. You can choose from these lists for many fields. This makes data entry easier resulting in more accurate reporting, analysis, and record keeping, and ensures that data is entered consistently by all operators.
The Course Information System

The Course Information System (CIS) provides the tool for managing course information—adding, changing, and scheduling courses & classes. Departmental users in the academic departments can enter the data themselves, and can print their own worksheets for selecting and changing the class data in the Schedule of Classes publication, and print proofs to preview what will appear in the Course Offerings.

The central office staff approves both new courses and changes to existing courses online, and can edit course information. The CIS is the source for the CAFSIS reports.

The PeopleSoft Course Information system captures information to create the undergraduate & graduate school Announcement publications, and the Course Offerings publications.
Making Sure It’s the Right Data

How information is stored affects how it reacts when you add, change, and delete items. You must understand how the information is stored to be certain that you are accessing the correct data.

Effective Dating

The PeopleSoft Student Administration system stores many records by effective dates. This allows you to keep all the data, past and present, in one database. Effective dating is used to save historical data rather than deleting it, while still allowing current data to be updated when information changes. Historical data can be viewed, but is not included in any current processing.

The effective date is used to determine which record is current at any given time, and controls which data is used by transactions, as shown in the following table.

<table>
<thead>
<tr>
<th>If the effective date is…</th>
<th>The record is…</th>
</tr>
</thead>
<tbody>
<tr>
<td>The most recent date that is less than or equal to today’s date</td>
<td>Current. The record became current on the effective date, and has not been superseded by another record.</td>
</tr>
<tr>
<td>A date earlier than the effective date on the record that is current</td>
<td>Historical. The record has been superseded by a more recently effective row.</td>
</tr>
</tbody>
</table>

Examples of effective dated material:

- **Current** A course that is currently available for scheduling.
- **History** An old course description that has since been updated with new information.

The effective date controls which data is used in an action, such as scheduling a class. When you schedule classes, the effective date of each course is compared to the start date of the term. If the course is not effective on or before the start date of the term, it cannot be scheduled for that term. Changes dated after the first day of the term will be effective for any term after the current term.

For example, if you change a course in October that is offered in the Fall and Spring, the change will affect only the Spring offering.
Control Tables, Lookup Buttons, and Search Results

The PS Student Administration system stores information that defines the structure and processing rules in control tables. Separate control tables contain subject areas, component (section) types, distribution areas, grading bases, and so on. These control tables provide the data that is presented in search results lists. These lists provide appropriate values that you can select to populate many fields in page groups.

You build search results lists by clicking on the Lookup button that is located to the right of certain fields. This button takes you to a Lookup page for that particular field. On the Lookup page is a Lookup button which you can click to display a search results list containing all valid values for that field. Other fields on the Lookup page enable you to refine or limit the search. See “Using the Find an Existing Value Page,” on page 30 for more information about how to use the Lookup page.

Adding Rows

Rows are groups of fields that can appear multiple times within a record. For example, all of the information about a component of a course in the Course Catalog is stored in one row of the course entry. If there are multiple components for the course, there will be multiple rows of component data, and when you create a course with multiple components (lecture, lab, precept, etc.), you must add a row for each component.

Sometimes, a row can be a complete record. For example, when you add a new effective-dated row in order to change an existing course, the entire course record is duplicated, so you can make changes where they are needed without re-entering the data that is not changing. Adding effective-dated rows also leaves a historical record of the course changes.

To insert a row, click the Add Row button next to the field or set of fields that you want to add. To add an effective-dated row, click the Add Row button in the area with the Effective Date field.

If you need to delete a row, click the Delete Row button. The Add Row and Delete Row buttons are always found paired.
Using the Navigation Controls in the Header Bar

When you need to change or verify a row (for example, to ensure that you are on the correct one before adding another row), use the navigation controls in the header bars to locate the row that you want.

You can use the navigation bar to locate the rows in either of two main ways—View 1 and View All.

**View 1.** The default display mode is View 1. In this mode the other navigation controls in the header bar are enabled.

- The Previous \[\text{Previous}\] and Next \[\text{Next}\] buttons advance one record backward and forward, respectively.
- The First link displays the most recently entered row of data (also known as the top-of-stack record) for Components. Sections however, appear in alphabetic order so the First link might not contain the most recently entered data. The Last displays the last row of data.

**Tip!** As you move through the rows using the navigation controls, keep an eye on the fields to see which ones change until you locate the one you want.

**View All.** In this mode you can view all the rows for the field or group of fields at once. You scroll down the page until you find the row that you want. For instance Figure 2 shows all the class section rows in a single scrollable window.

**Tip!** To see a summary list of scheduled classes for a course, use the Class Sections page. See .... for details.
A horizontal line and the label, "Session:" marks the beginning of a new Class Section.
**Find.** Some header bars have a Find link (active in the View 1 mode) that enables you to go to a row without having to move through all of them in sequence. When you click Find the Explorer User Prompt is displayed, into which you can type the alphanumeric code of the section you want (for example, L01 or P06), and click the OK button. This brings the desired section into view.

![Figure 3: Explorer User Prompt](image-url)
Signing In and Out

The PeopleSoft Student Administration and Human Resources systems share a single database. Since the data contained in this database is largely confidential, access is restricted. Your security administrator has given you access to the PeopleSoft CIS module.

Tip! CIS access is restricted by department/program and academic career (graduate or undergraduate). If you will be covering for another administrator, you should request access for their area as well as your own.

Your University NetID has been set as your CIS User ID. This user ID, along with your LDAP password, allows you to perform the course management functions required for your position. It is your responsibility to ensure that your password does not become known to anyone else.

Note: The University Financials system, which is also a PeopleSoft system, uses a different database, and may use a different password.

Signing In to the System

You access the PeopleSoft systems through a browser. Microsoft Internet Explorer (version 5.5 or higher) is the preferred browser for PCs.

Important! Some people may use more than one PeopleSoft system, such as Financials and Student Administration. Only one PeopleSoft system should be open on your desktop at one time. You must sign off any open PeopleSoft system before you sign into another one.

To sign into the PeopleSoft Administrative Module:

1. Open a browser instance and navigate to Princeton University’s home page (Figure 4).

Tip! You can go directly to Princeton’s PeopleSoft Home Page by typing this web address in the browser’s location field: www.princeton.edu/hrsa, then press the Enter key.
2. In the left column, click on the **Administration** link. The Administration page is displayed.
3. Click on the **Course Information Systems** link. The PeopleSoft Home Page is displayed.

![PeopleSoft Home Page](image)

**Figure 6: Princeton’s PeopleSoft Home Page**

4. Click on either of the **Log In** links. The PeopleSoft Sign In page is displayed (Figure 7).

**Important!** It is recommended that you create a navigation shortcut (such as Favorites) to Princeton’s PeopleSoft Home Page and not the PeopleSoft Sign In page because the home page provides information about system outages.
5. Type your User ID and LDAP password in the User ID and Password fields, respectively. Passwords are case-sensitive. Your password appears as asterisks as you type.

**Note:** If you have forgotten your password, contact a Help Desk consultant at 258-HELP or 258-4357. To obtain a userID, complete and submit the PeopleSoft Access Request Form on the web at www.princeton.edu/asa.

6. Click the Sign In button to log in to the PeopleSoft system. The home page for the PeopleSoft application is displayed.
Signing In and Out

Figure 8: The CIS Home Page

**Tip!** Once in CIS, you may want to resize the browser window to best accommodate the contents of the PeopleSoft page, or press F11 to put the window into full screen mode.

**Signing Out**

You can sign off at any time, by clicking the Sign Out link in the banner section of every page. You must save any changes before signing out, but you can return to a saved course or class at a later time to make further changes, until you submit it for approval.

**Note:** Signing out does not cancel processes that are currently running or scheduled.
To log off:

1. Click the **Sign Out** link in the banner at the top right of the page.

   **Note:** If you close the browser the system will log you off, but as long as you have one browser instance open (even if it is minimized), you are still logged onto the system. If you navigate away from the PeopleSoft pages, you are still logged on.

2. If you have unsaved changes, you will be presented with a save dialog box.

   ![Save Dialog Box](image)

   If you click OK, you are returned to the page. To sign out without saving your changes, click the Cancel button.

   **Note:** For security, you should close the browser after you log off.
Understanding PeopleSoft Page Groups

In PeopleSoft applications, data is grouped into related fields, which are presented on one or more related pages. A set of related pages is called a page group, and is presented as a series of tabbed pages in a browser window. The name of the page group is the last name in the navigation path at the top of the window.

Figure 10: Page Group Tabs

Each page within a page group has its own name, which is displayed in the page tab (often abbreviated).

CIS pages and page groups are accessed through the Manage Student Records > Establish Courses menu. The Establish Courses > Use menu and its page groups are shown in Figure 11.
You can open new pages without closing the current page or page group by clicking the **New Window** link on the page. This opens a new browser instance which you can use to access a different page group, while your original page group remains open in the other browser.

**About Page Groups**

Pages may be grouped together to show that the information they contain is shared or related. For example, the Schedule of Classes page group is divided into eight pages. These pages are grouped together to form a logical arrangement of information about any scheduled class, and guide you to related information or activities.

Pages in a group are treated as a single entity when you save data. This means that when you click the **Save** button from any page in a page group, data on all pages in the group is saved to the database. If the system encounters a required field that you have not completed on any page in the group, you will receive an error message.

To display any of the pages in a group, click on the tab for that page. To navigate to a new page group you can click on a menu in the navigation path. Called ‘breadcrumbs’ in PeopleSoft, the navigation path provides a trail of the menu links that you can use to return to a particular menu level.
# Course Information Page Groups

The Course Information System has several different page groups that are used for different purposes. The following table describes the purpose of the most frequently used page groups, and shows the navigation to get there.

<table>
<thead>
<tr>
<th>Purpose</th>
<th>Page Group</th>
<th>How to get there</th>
</tr>
</thead>
<tbody>
<tr>
<td>To add or update courses in the Course Catalog database</td>
<td>Course Catalog</td>
<td>Manage Student Records &gt; Establish Courses &gt; Use &gt; Course Catalog</td>
</tr>
<tr>
<td>To update class and schedule information for the <em>Course Offerings</em></td>
<td>Schedule of Classes</td>
<td>Manage Student Records &gt; Establish Courses &gt; Use &gt; Schedule of Classes</td>
</tr>
<tr>
<td>To schedule a class for the first time after the course has been added or updated in the Course Catalog.</td>
<td>Schedule New Course</td>
<td>Manage Student Records &gt; Establish Courses &gt; Schedule New Course</td>
</tr>
<tr>
<td>To copy (roll) classes from a previous term into a new term</td>
<td>Prior Term Copy</td>
<td>Manage Student Records &gt; Establish Courses &gt; Process &gt; Prior Term Copy</td>
</tr>
<tr>
<td>To generate the Pre-Worksheet Course List</td>
<td>Pre-Worksheet Course List</td>
<td>Manage Student Records &gt; Establish Courses &gt; Report &gt; Pre-Worksheet Course List</td>
</tr>
<tr>
<td>To generate the Worksheets, and Proofs</td>
<td>Course Worksheet/Proof</td>
<td>Manage Student Records &gt; Establish Courses &gt; Report &gt; Course Worksheet/Proof</td>
</tr>
<tr>
<td>To select Courses of Interest from another department for listing under your department/program</td>
<td>Courses of Interest</td>
<td>Manage Student Records &gt; Establish Courses &gt; Setup &gt; Courses of Interest</td>
</tr>
<tr>
<td>To grant student-specific permission to a student for a particular course in a given term</td>
<td>Class Permission Numbers</td>
<td>Manage Student Records &gt; Establish Courses &gt; Use &gt; Class Permission Numbers</td>
</tr>
<tr>
<td>To update enrollment capacity or stop further enrollment in a section during enrollment</td>
<td>Class Sections</td>
<td>Manage Student Records &gt; Establish Courses &gt; Use &gt; Class Sections</td>
</tr>
</tbody>
</table>
Using the Find an Existing Value Page

When you navigate to a PeopleSoft page group, the system displays a Find an Existing Value page. This page allows you to look up and select records from search results based on the information you enter.

To retrieve a single record, follow the next procedure, “Retrieving a List of Records”. For details about retrieving a group of records, See “Retrieving a List of Records,” on page 32.

Retrieving a Single Record

The following procedure describes how to search for and retrieve a specific record.

Note: The steps in this section describe how to use the search feature in any Find an Existing Value page. The example uses the Schedule New Course page group.

To retrieve a single record:

1. When you click on a page group menu item, the Find an Existing Value page for that group is displayed. Figure 13 shows an example of the Find an Existing Value page for the Schedule New Course page group.

![Figure 13: Find an Existing Value Page](image)
2. In the Academic Institution field, enter PRINU if it has not be set as an operator default.

3. Enter values in the Term field, the Subject Area, and Catalog Nbr fields, then click the Search button. If a single record match is found the first page of the page group is displayed.

4. Scroll to the bottom of the page. Because only a single record was retrieved, the Return to Search button is the only button of the three search list buttons that is displayed. (Return to Search, Next in List, and Previous in List buttons are displayed when a search has found multiple records.)

Clicking on the Return to Search button takes you back to the Find an Existing Value page, where new criteria can be entered for a search.
Retrieving a List of Records

The following procedure shows how to use the Lookup and Search functions to retrieve multiple records for display and possible update.

**Note:** The steps in this section describe how to locate a list of records, using the Schedule New Courses page group as an example.

To retrieve a list of records:

1. When you click on a page group menu item, the Find an Existing Value page for that group is displayed. Figure 16 shows an example of the Find an Existing Value page for the Schedule New Course page group.

2. In the Academic Institution field, enter PRINU if it has not be set as an operator default.

3. In the Term field, enter the 4-digit numeric code if it has not be set as an operator default, or use the Lookup button to find it. (See “Using a Lookup Button to Find Field Values,” on page 36 for more information).

4. In the Subject Area field, enter the 3-character code for the department, or use the Lookup button to find it. For example, if you want to look at all courses in the Physics department, enter PHY.
Tip! You can set your operator defaults to display your Subject Area. See “Setting Your User Defaults,” on page 291, for more information.

5. Click the Search button to display the Search Results.
A list of all the records that fit the specified criteria is displayed in the Search Results on the same page. In this case, all the records show a Subject Area of **PHY**.

6. In the Search Results list, click any of the links in the line that contains the course that you want. The first page of the page group is displayed for the record you chose.
If the Search Results list is too long, you can search again using values that will result in a more precise list of records. For example, you can include more letters in a partial name, add other criteria such as the Academic Career, or use one of the key values such as the catalog number.

**Note:** If, after entering more search criteria, you are taken immediately to the page without seeing any search results, it’s because the search found only one record that matched your criteria.

**Working Through a Search List**

When you are working in a page group with records from a search list, the search list buttons at the bottom of each page become enabled. You can then use the Return to Search, Next in List, and Previous in List buttons at the bottom of the page to work through the list, record by record.

![Search List Buttons](image)

These buttons allow you to navigate forward and backward through the retrieved records in the search list:

- To display the next record in the search list, click the Next in List button. If this button is disabled, you are viewing the last record in the list.

- To display the previous record in the search list, click the Previous in List button. If this button is disabled, you are viewing the first record in the list.
Click the Return to Search button to return to the search results on the Find an Existing Value page, where you can scroll through the generated list of records, select a particular record in the list, or perform another search.

**Using a Lookup Button to Find Field Values**

The Lookup button located next to many fields will take you to a Lookup page for that field. On the Lookup page you can search for all values valid for that field. For example if you don’t know the code for a particular field, or if your operator defaults haven’t been set to display them, you can click the Lookup button to display a Lookup page.

**To lookup a value for a field:**

1. To find a value for a field (such as the 4-digit numeric code for a term), click the Lookup button next to the field.

2. Click the Lookup button to display all appropriate values.

   **Tip!** For some fields, you may want to enter search criteria on the Lookup page, but it is generally not necessary.
3. Scroll down the list if necessary to locate the value that you want, and click on any link in the line containing it. You are returned to the Find an Existing Value page with the field filled in.
## Maintaining Course Information

<table>
<thead>
<tr>
<th>Topic</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>About the Course Catalog</td>
<td>40</td>
</tr>
<tr>
<td>Adding a New Course</td>
<td>43</td>
</tr>
<tr>
<td>Establishing a New Course on the Catalog Data Page</td>
<td>43</td>
</tr>
<tr>
<td>Adding Topics for a New Course</td>
<td>52</td>
</tr>
<tr>
<td>Associating the Course with a Subject Area</td>
<td>53</td>
</tr>
<tr>
<td>Cross-Listing a Course</td>
<td>55</td>
</tr>
<tr>
<td>Defining Course Requirements</td>
<td>57</td>
</tr>
<tr>
<td>Assigning an Instructor to the Course</td>
<td>59</td>
</tr>
<tr>
<td>Defining Course Components</td>
<td>62</td>
</tr>
<tr>
<td>Changing Course Information</td>
<td>66</td>
</tr>
<tr>
<td>Saving and Submitting Changes</td>
<td>66</td>
</tr>
<tr>
<td>After A Course Has Been Approved</td>
<td>67</td>
</tr>
<tr>
<td>Accessing the Course Catalog</td>
<td>68</td>
</tr>
<tr>
<td>Changing the Grading Basis</td>
<td>75</td>
</tr>
<tr>
<td>Changing the Academic Structure</td>
<td>77</td>
</tr>
<tr>
<td>Adding or Changing a Cross-Listing</td>
<td>79</td>
</tr>
<tr>
<td>Adding a New Topic</td>
<td>85</td>
</tr>
<tr>
<td>Changing the Instructor-in-Charge</td>
<td>87</td>
</tr>
<tr>
<td>Changing the Course Attributes</td>
<td>91</td>
</tr>
<tr>
<td>Changing Components</td>
<td>92</td>
</tr>
<tr>
<td>Changing the Course Requirements</td>
<td>99</td>
</tr>
<tr>
<td>Saving Your Changes</td>
<td>102</td>
</tr>
<tr>
<td>Submitting a Course for Approval</td>
<td>103</td>
</tr>
<tr>
<td>Tracking Your In Progress Courses</td>
<td>103</td>
</tr>
<tr>
<td>Submitting a Course</td>
<td>105</td>
</tr>
<tr>
<td>Course and Class Synchronization</td>
<td>107</td>
</tr>
<tr>
<td>Running the Course/Class Synchronization Process</td>
<td>108</td>
</tr>
</tbody>
</table>
Chapter 4: Maintaining Course Information

About the Course Catalog

The Course Catalog database contains the permanent information about courses—information that does not generally change from year to year or term to term. This information is used in printing the Undergraduate Announcement each year.

Sometimes new courses are added, or information about the course is changed—for example, a course with a lecture and class components is changing to a lecture and labs. When this happens, the Course Catalog database must be updated, and the changes must be submitted to and approved by a dean. Undergraduate courses are approved by the Dean of the College. Graduate courses are approved by the Graduate School.

You enter and change Course Catalog information on the five pages of the Course Catalog page group, each accessible by clicking its tab.

![Figure 23: Pages in the Course Catalog Page Group](image)

Pages in the Course Catalog Page Group

- **Catalog Data**—On this page of the Catalog Page Group, you can enter the course type and title, effective date, and the grading basis. You can also enter the course description, attributes, topics, and distribution area on this page. Course descriptions, distribution areas, and attributes that you enter on this page will be printed in the Announcement.
✦ Offerings—You can define the subject area, catalog number, and academic career for a course, and specify the subject area & catalog number of any cross-listings for the course. You can also see the Course Approved status on this page. The Enrollment Requirement Group area on this page (formerly known as Course Requirements or Requisites) is where you can specify student groups in order to control enrollment online.

✦ Instructors—You can add the instructor in-charge of the course. A course may have up to three instructors in-charge. The instructor(s) listed here will be listed in the Course Offerings and on the Registrar’s web site.

✦ Components—You can specify the components that are included in the course, such as labs, precepts, lectures, etc., section sizes, final exam type, etc.

Note: This is not the Schedule of Classes. You have only one of each component type here.

Tip! The Optional Component checkbox on this page is selected (✓) automatically for all precepts, drills, ear training, and film components.

✦ PU Catalog Submit—You can submit a course for the dean’s approval. When you click on the Submit button, the course approval status will change from In Progress to Pending.

When a course is added, or certain course information is changed, the Course Approved field, which shows the approval status of the course, has a status of In Progress. Once the course is submitted for approval, the status changes to Pending. As long as the approval status is In Progress or Pending, a course will not appear in the Announcement or Course Offerings publications, or on the Registrar’s web site, although it can be scheduled.

Once a course has been added, submitted, and approved, several fields are disabled (grayed-out, or dimmed) to prevent departmental users from changing the values. These fields include the Course Title, Transcript Title, Catalog Number, Catalog Description, Distribution Area, Course Type, and Subject Area. If you need to make a change to any of these fields after the course has been approved, you must send an e-mail or memo to the Dean’s Office indicating the course, the change, and why the change is needed.
Tip! The approval status of an approved new course that has never been offered can also revert to In Progress when certain information is changed in the Schedule of Classes pages. See “Changing Descriptive Info in the Schedule,” on page 187, for more information on which fields will return the course approval status to In Progress.

Undergraduate courses are approved by the Dean of the College. Graduate courses are approved by the Graduate School.

In order to indicate which courses have been added or changed, and need to be reviewed, a report is generated by the system for the Office of the Dean of the College and the Graduate School. This report will show the status, subject area, catalog number, and the new and old value of the field that was changed for each course that was added or changed.
Adding a New Course

To add a new course to the Course Catalog database, use the Course Catalog page group. When a new course is added, the PeopleSoft system assigns it a unique Course ID number. The Course ID is displayed at the top of each page that shows course or class information.

When you select the Course Catalog menu option, the Find an Existing Value page is displayed. To begin adding a new course, click the Add a New Value link on the Find an Existing Value page. If you are already in the Course Catalog page group, you can return to the Find an Existing Value page by clicking the Return to Search button, or you can click the Add button to go straight to the Add a New Value page.

When you save a new course, the Course Approved status of the course is In Progress. This status allows you to re-open the course and make further changes, if, for example, you review the proof for the new course and find an error.

Each time you open a course that is in progress to make further changes, you must add a new effective-dated row for those changes. You may add as many effective-dated rows as necessary with the In Progress status. Because you may enter multiple effective-dated rows for a set of changes, you should start with an effective date earlier than the current date. This will allow you to save the course and return to it later on the same day, adding a new effective-dated row at that time for further changes.

Establishing a New Course on the Catalog Data Page

The first page in the Course Catalog page group is Catalog Data, which establishes the course and provides basic information about the new course.

To establish a new course:

1. Navigate to Manage Student Records > Establish Courses > Use > Course Catalog. The Find an Existing Value page is displayed.
2. Click the **Add a New Value** link at the bottom of the Find an Existing Value page. The Add a New Value page is displayed.

3. Click the **Add** button to display the Catalog Data page.
Adding a New Course

4. On the Catalog Data Page, click the Calendar button to the right of the Effective Date field, then select a date prior to today’s date from the drop-down calendar, or enter the date in mm/dd/yy format.

**Note:** It is recommended that you use an Effective Date before today’s date, so that you will be able to save your work and return to it on the same day. If you use today’s date as the Effective Date, you will not be able to return to the course to make further changes until the next day.

Changes effective after the first day of the term will not apply to that term. If today’s date is later than a week before the first day of the term and the change should be effective for this term, select a date at least two weeks before the first day of the term.

Figure 26: The Catalog Data Page for a New Course

5. In the Course Type field click the Lookup button to display a new page with one of these choices:

- **OTO** One Time Only
- **PRM** Permanent
- **TPC** Topics Course
6. Click either the abbreviation or the full name of the desired course type. See “Types of Courses,” on page 9 in Chapter 2, for a full description of the course types.

   **Note:** If you select TPC (Topics Course), you must complete the Course Topics area at the bottom of the Catalog Data page. If you do not complete the Course Topics area for a TPC course, a warning is displayed when you attempt to save the course.

When you select the course type you are returned to the Catalog Data page with the *Course Type* field filled in.

7. In the *Long Course Title* field, type the full course title just as it should appear in the *Announcement* publication, then press the *Tab* key.

   The course title must be 100 or fewer characters—if longer, the system truncates it to 100.

   The *Transcript* and *Short Title* fields will fill in with the first 40 and 30 characters of the title, respectively.

   a) If the abbreviated title in the *Transcript* field is not what should appear on transcripts, simply type over the default value with the correct value.

   b) If the abbreviated title in the *Short Title* field is not what should appear on pages and lists, simply type over the default value with the correct value.

   **Tip!** If the value is too long to fit in the field, you can scroll to see the remaining characters by pressing the right or left arrow keys. You can also jump to the beginning of the value by pressing the *Home* key, or to the end of the value by pressing the *End* key.

8. In the *Description* field, type the permanent description of the course, as you want it to appear in the Course Catalog. The description can be as long as 650 characters.

   **Note:** Do not include the instructor or component meeting information in the description. This information will be determined from other fields in the Course Catalog.
If the description already exists in another file, such as a Word file, you can copy it from that file and paste it into the Description field. However, bold and underscore formatting will not be translated from the Word file when you copy the text here.

**Tip!** When copying formatted text from Word, select the text to be copied, press Ctrl + Spacebar to remove the formatting, and then press Ctrl + C to copy the text. This prevents the inclusion of odd characters resulting from Word formatting codes.

To specify character formatting, you must enter a code before and after the text to be formatted:

- For **bold text** use braces, for example `{text}`
- For underscored **text** use brackets, for example `[text]`
- For **combined formats** use all relevant pairs `{[text]}`

To enter special characters, such as à, è, ü, ß, etc., use the Unicode character mapping, described in “Inserting Special Characters in Descriptions,” on page 294.

**Note:** The PeopleSoft database contains Course Catalog descriptions for courses offered since 1996, although it will contain course titles and other information back many more years.

9. For most courses you can leave the default values in the Course Units/Hours/Count fields. If required for your department or program, you may update the Minimum Units field.

10. Scroll down to the Course Grading area.
11. In the *Grading Basis* field, select the grading basis for the course from the drop-down list. This field determines what grading basis a student may select for the course, if the student may select a grading basis.

- */NC*: Select this option if the course is a graduate course that may be taken for credit or no credit.

- */AUD/NC*: Select this option if the course is a graduate course that may be taken for credit or no credit, or may be audited.

- A-F,P,Aud*: Select this option if the course may be taken for a letter grade, Pass/D/Fail, or audit. This is the regular grading basis for most courses at Princeton.

- Audit Only*: Select this option if the course may only be audited.

- Na, npdf*: Select this option if the course may only be taken for a letter grade. Pass/D/Fail and Audit are not available for this course.

- No Audit*: Select this option if the course may not be audited, but may be taken for a letter grade or Pass/D/Fail.
12. In the Grade Roster Print field, leave the default value, Component, since Princeton is not yet using PeopleSoft for grading.

13. In the Repeat for Credit Rules area, leave the Repeat for Credit checkbox deselected (†).

14. Scroll down, if necessary, to the Additional Course Information area.

No P/D/F  Select this option if the course may not be taken on a Pass/D/Fail basis, but may be taken for a letter grade or audited.

P/D/F Only  Select this option if the course may only be taken on a Pass/D/Fail basis.

Note: Other options that appear in the drop-down list for this field are used by the Registrar’s Office, or by students when they choose courses online.

15. In the Additional Course Information area the Consent field is disabled. With Web enrollment, the number of students who can enroll in a class is controlled by the enrollment capacity, and optionally, the reserve capacity, set in the Schedule of Classes.
Tip! The value that is displayed in the disabled Consent field will vary, depending on the Course Attribute value. If the Attribute is APPL, the Consent value will be Department Consent. Otherwise, the Consent value will be No Consent.

16. In the Distribution Area field, if the course does not satisfy a distribution area requirement or is a graduate course, leave the default value, NONE.

If the course does satisfy a distribution area requirement, click the Lookup button and on the Lookup Distribution Area page that is displayed, click the Lookup button.

![Figure 29: Distribution Areas for New Course]

From the Search Results, click any of the links on the line that you want.

Note: A unique requirement designation, “W”, is used for courses that satisfy the writing requirement.

17. Leave the Equivalent Course Group field blank.

18. If you want course attributes to appear as part of the course description in the Announcement or Course Offerings publications, you must enter the Course Attribute and Course Attribute Value for each attribute that applies.
19. Select a Course Attribute Value by using the Lookup button. Attributes include:

**APPL**
By application/interview only (printed in *Course Offerings*). The student must apply for permission to take the course, or an interview may be required.

**Important! If APPL is specified here, you must also select the Student Specific Permission checkbox in the Schedule of Classes.**

The Attribute Value for this Attribute is **BY APPL.**

**CONR**
Required for concentrators (printed in *Course Offerings*). Students who are concentrating in this subject area must take this course.

The Attribute Value for this Attribute is **RQ CNCNTRS.**

**OFFR**
Term offered (printed in *Announcement*). Indicates whether the course is offered in the Fall, the Spring, or both terms, or not offered this term.

The Attribute values for this attribute are: **BOTH** (Fall and Spring), **FALL, SPRING, NOTTYR** (Not offered this year).

20. If more than one attribute applies to a course, add additional rows by clicking the Add Row button, and repeat Step 18 and Step 19.

![Figure 30: Adding Attributes](image-url)
Adding Topics for a New Course

Sometimes courses will have a different focus for each of several different terms. For example, a course may be offered in both the Spring and Fall, but the Spring course focuses on one aspect of study, and the Fall course focuses on another.

When a course has several different areas of study, you can enter each focus as a topic. Then when the course is scheduled for a term, the topic that will be studied that term can be selected from this list.

To add topics for a new course:

1. In the Course Catalog page group, scroll down to the Course Topics area on the Catalog Data page.

2. In the Course Topic Title field, type the full topic title (up to 70 characters) as you want it to appear in the Course Offerings.

3. To add additional topics, click the Add Row button, and repeat Step 2 for each Topic.

Note: If you selected a course type of TPC on the Catalog Data page, you must complete the Topics on the Catalog Data page. If you selected a course type of PRM or OTO, the Topics area will be blank.
4. Click the Transcript Topic tab to review the transcript topic titles.

5. The Transcript Topic Title field is populated by the first 40 characters of what you entered in the Course Topic Title field. If you want a different title to appear in the transcript other than the title that is displayed in Course Offerings, simply type over the default title.

![Image: The Transcript Topic Tab in the Course Topics Area of the Catalog Data Page]

The Registrar’s Office sets the values on the Course Topics Repeat for Credit tab.

**Associating the Course with a Subject Area**

The Offerings page associates a new course with an academic group, subject area, and academic career, and in addition, establishes the Catalog Number.

If a course is cross-listed with another department, the cross-listing is established here. The home department, not the cross-listing department, adds the cross-listed offering, and maintains the data on all other pages for the course. For more information, see “Cross-Listing a Course,” on page 55.

To associate the course with a subject area:

1. In the Course Catalog page group, click the Offerings tab to display the Offerings page.
When you are adding a new course, the value of the Course Offering Nbr field is set to 1 by default.

2. In the Catalog Nbr field, type the catalog number, for example, the 101 of PHY101. The Subject Area field will provide the alphabetic part of the catalog code.

3. In the Academic Group field, select the Academic Group using the Lookup button. The options are:

   ARCG       School of Architecture. Use for Graduate courses only.
   ENGR       Engineering. Use for graduate or undergraduate courses.
   HUMN       Humanities. Use for graduate or undergraduate courses.
   INTDS      Interdisciplinary. Use for graduate or undergraduate courses that don’t fall into any specific group. All academic Programs (as opposed to departments) must use this value.
   NATS       Natural Sciences. Use for graduate or undergraduate courses.
   SOCS       Social Sciences. Use for graduate or undergraduate courses.
   SPEC       Special. Do not use for course information.
   WWSG       Woodrow Wilson School. Use for Graduate courses only.
Tip! You can set the Academic group to default to your particular academic group. See “Setting Your User Defaults,” on page 291.

4. In the Subject Area field, use the Lookup button to locate the subject area you want, or just type the subject area code if you know it.

   Tip! You can type the value directly, rather than selecting it from the Search Results.

5. Tab out of the Subject Area field. The Academic Organization field should fill in automatically. If it does not, use the Lookup button to find the correct value.

6. In the Academic Career field, if the field is not filled in by default, type one of the following:

   UGRD for undergraduate courses
   GRAD for graduate courses

Cross-Listing a Course

If a course is cross-listed with another department, the cross-listed course is established by the home department using the Offerings page of the Course Catalog page group. The home department maintains all course data.

For example:

- The Physics department—the home department—offers the course Mathematical Methods of Physics, PHY 403, which is cross-listed with the Mathematics department.
- Mathematics department cross-lists the course as MAT 407, Elementary Mathematical Physics.

The Physics department would enter MAT 407 as a second offering of the PHY 403 course, which the Physics department maintains and schedules.

Note: If there are two offerings for an undergraduate course—the regular course and the cross-listing—both offerings must be approved. If the second offering is not approved, you will not be able to make any changes to either offering.
To cross-list a course with another department:

1. On the Offerings page, click the Add a New Row button. The Course Offering Nbr field is incremented by 1.

2. In the Catalog Nbr field, type the numeric part of the catalog number for the cross-listed course.

   Important! Make sure you use the correct number for the cross-listed course. Using the example on page 55, the number would be the 407 of MAT 407, not the 403 of PHY 403.

   Tip! The Subject Area value will provide the alphabetic part of the catalog code.

3. Use the Lookup button in the Academic Group field to select the Academic Group for the cross-listed course.

   ARCG  School of Architecture. Use for Graduate courses only.

   ENGR  Engineering. Use for graduate or undergraduate courses.

   HUMN  Humanities. Use for graduate or undergraduate courses.
Tip! You can type these values directly, rather than selecting from the Search Results.

4. In the Subject Area field, click the Lookup button. On the page that is displayed, click the Lookup button, then select the cross-listing department.

5. In the Academic Organization field, use the Lookup button to locate your department or type in your department code. To carry forward our example, you would select PHY for the Academic Organization.

6. If the Academic Career field hasn’t filled in already with default values, enter UGRD for an undergraduate course and GRAD for a graduate course.

Defining Course Requirements

Course requirements are those pre-requisites that are enforced by the system at the time of enrollment during online course selection.

Requirements are set using the Requirement Group fields, which can indicate restrictions such as, Open Only to Concentrators, or Juniors and Seniors Only.

INTDS  Interdisciplinary. Use for graduate or undergraduate courses that don’t fall into any specific group. All academic Programs (as opposed to departments) must use this value.

NATS  Natural Sciences. Use for graduate or undergraduate courses.

SOCs  Social Sciences. Use for graduate or undergraduate courses.

SPEC  Special. Do not use for course information.

WWSG  Woodrow Wilson School. Use for Graduate courses only.

Note: For the cross-listed course (Course Offering Nbr 2) use the Academic Group of the home department, not the cross-listing department.
Requirement Groups are also used to set reserve capacity in the Schedule of Classes. However, there is a different degree of restriction, depending on where you set the requirement groups:

- In the Course Catalog, the Requirements Group **limits enrollment** to only those students who satisfy the criteria defined in the Requirement Group.

- In the Schedule of Classes, the Reserve Capacity setting only **reserves seats** for those who satisfy the criteria defined in the Requirement Group. Others who do not meet the criteria can enroll in the class as long as there are seats available that have not been reserved.

**Note:** You can select only one Requirement Group per course on the Offerings page in the Course Catalog. If a course is open to concentrators in two departments, use the Reserve Capacity page in the Schedule of Classes to control enrollment. See “Setting the Reserve Capacity,” on page 162 for more information.

**✔ To define requirements for the course:**

1. In the Course Catalog page group, click the Offerings tab.

**Important!** Use the Requirement Group only for restrictions you want enforced, not for informational comments. These restrictions are enforced during online course selection.

2. Scroll down to the Enrollment Requirement Group area.
Assigning an Instructor to the Course

If you want the name of the instructor for the course to appear in the Announcement and Course Offerings publications and other preliminary reports, you must assign the instructor in the Course Catalog. The instructor assigned to a course in the Course Catalog is the person in charge of the overall course.

When you schedule the course in the Schedule of Classes, the instructor’s name is loaded as the instructor for the primary component. When you schedule the class for a term, you can assign instructors for individual components, and if desired, you can override the instructor for the primary component; however, the name in the Schedule of Classes (SOC) will appear only in the CAFSIS reports, not in the publications or proofs.

On the Instructors page of the Course Catalog page group you can assign up to 3 instructors-in-charge for each course. All 3 names will appear in the Announcement and Course Offerings publications, as well as on the Course Proof. In addition, all 3 names will be carried over to the schedule for the primary component when you schedule the course.
In the future, grading will be controlled through PeopleSoft, so you must enter at least one instructor in the Catalog. This instructor will be carried over to the Schedule of Classes as the instructor who may approve grades in PeopleSoft. Preceptors and other instructors may still be added into the Schedule of Classes for CAFSIS, but they will only be able to enter grades in PeopleSoft, not approve them.

**Note:** Only the instructors who have grading approval authority should be entered in the Catalog. If you want a different individual to be assigned grading approval authority, you will need to contact the Course Offerings Administrator to assign this authority, after you add the instructor in the Catalog and the Schedule of Classes.

**To assign an instructor to the course:**

1. On the Course Catalog page group, click the Instructors tab.

![Figure 36: The Instructor Page for a New Class](image)

2. In the first Instructor field, use the Lookup button to find an Instructor. The Lookup Instructor page is displayed. To list instructors and staff from all departments, click the Lookup button.
Adding a New Course

If you want to limit the search results to the instructors in your own department, you can enter your 3-character department code in the Academic Organization field before clicking on the Lookup button.

Likewise, if you know the name, or the first few letters of the name, you can enter the characters you know in the Last Name and First Name fields, and click the Lookup button to display only the instructors with names that start with those characters.

3. Select the instructor from the search results by clicking anywhere in the row.

Note: If you cannot locate the name of the instructor you want in the Course Catalog, and you know the instructor has been entered by HR with an Active status effective before the start of the term, contact the Help Desk.

4. To add a second and third Instructor, repeat Step 2 and Step 3 for the second and third Instructors.
Defining Course Components

Each course is composed of one or more components—different instructional modes or meeting types, such as labs, studios, lectures, seminars, and precepts. The primary component is the graded component.

<table>
<thead>
<tr>
<th>Component Type</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Laboratory</td>
<td>The hands-on, workshop component of a science course, usually held in a laboratory. A lab is never the primary component of a course.</td>
</tr>
<tr>
<td>Class</td>
<td>An instructional unit combining formal presentations, review, and problem solving interaction between the students and teacher. A class component is sometimes a stand-alone component, and sometimes offered with a lecture. However, it is a primary component only if it is the only component type.</td>
</tr>
<tr>
<td>Drill*</td>
<td>The intensive, practical language training component of a language course. A drill is never the primary component of a course.</td>
</tr>
<tr>
<td>Ear Training*</td>
<td>The intensive, practical, musical training component of a course. Ear training is never the primary component of a course.</td>
</tr>
<tr>
<td>Film*</td>
<td>The component of a course where films are presented and watched for review in another component of the course. Film is never the primary component of a course.</td>
</tr>
<tr>
<td>Lecture</td>
<td>A large class, usually presented in an auditorium-style setting, which is largely non-interactional. If a course has a lecture component, it is the primary, graded component, and includes all enrolled students.</td>
</tr>
<tr>
<td>Precept*</td>
<td>The small interactional meetings, usually limited to about 15 students each. There are typically several precepts for each lecture. A precept is never the primary component of a course.</td>
</tr>
<tr>
<td>Seminar</td>
<td>Interactional classes that are usually several hours in duration, with 15 to 18 students. Typically, the only component of a course, in which case it is the primary, graded component.</td>
</tr>
<tr>
<td>Studio</td>
<td>A hands-on, workshop component of a visual arts, theater, dance, or architecture course. A studio component is usually the primary component of a course.</td>
</tr>
</tbody>
</table>

* Defaults to Optional Component on the Course Catalog Components page.

You define the types of components that can be scheduled for a course on the Components page of the Course Catalog page group. However, the actual scheduling of the individual components is done on the Schedule of Classes page.
To streamline student enrollment in SCORE, and to minimize schedule conflicts during enrollment, certain components—precepts, drills, ear training, and film components—will appear in the Course Catalog as optional components. This designation will occur automatically when you add one of these components. They will not be listed as optional in the Announcement or Course Offerings publications; this designation is used only for internal PeopleSoft processing.

To define the course components:

1. In the Course Catalog page group, click the Components tab.

2. From the Course Component drop-down list, select the component that will be the course’s primary component, most often a Lecture, Class, or Seminar.

3. Leave the Auto Create checkbox deselected (✓).
4. If the component will be graded, select the *Graded Component* checkbox (✓). At Princeton, only the primary component is graded in PeopleSoft.

**Important!** If you select the Graded Component checkbox and another component was already specified as the graded component, the Graded Component checkbox will be deselected automatically for the other component.

**Tip!** The Graded Component checkbox is selected for the first component by default, so if you add the primary component first, you will not need to change the value. If you deselect this checkbox, it remains deselected by default for each component you add, although you can change the value if necessary.

5. If the component is the primary, graded component, select the *Primary Component* checkbox (✓). After you have defined one component as the primary component, this checkbox will be deselected for any other components you add for the course.

**Important!** If you select the Primary Component checkbox and another component was already specified as the primary component, the Primary Component checkbox will be deselected automatically for the other component.

**Tip!** This checkbox is selected for the first component by default, so if you add the primary component first, you will not need to change the value. Once you deselect this checkbox, it remains deselected by default for each of the remaining components you add, although you can change the value if necessary.

6. If the component is a precept, drill, ear training, or film component, the *Optional Component* checkbox (which is dimmed) will be selected automatically.

7. Leave the *Instructor Contact Hours* and *Workload Hours* fields blank.

8. The *Default Section Size* field is used to set the default enrollment capacity when you schedule the class. The enrollment capacity in the Schedule of Classes automatically stops enrollment during online course selection when the specified number of students is reached.

Enter the preferred size of the component section. The default for this field is 30 students.
9. From the *Final Exam* drop-down list, select one of the following values:

- **Final**
  There is a final exam, scheduled by the Registrar’s Office during the final exam period.

- **Other**
  There is a term paper, lab report, or project in lieu of a final, or the final exam is scheduled on the last day of class, or there is no final. Select this value for non-graded components.

- **Take Home**
  The final is a take-home exercise.

**Important!** Final Exam is a required field, so you must select a value. If the component is a non-graded component—not the primary component—select Other. For the graded component, you can select any of the values.

10. Leave the *LMS File Type* field blank.

11. Leave the Room Characteristics Required area blank; Princeton is controlling classroom scheduling through Resource25.

12. If there is an additional component for the course, click the Add Row button in the Course Component area and select a component from the drop-down list. Repeat Step 4 through Step 11 as necessary.

13. When you are finished with this page, click the Save button on the bottom left to add the new course information to the database. A message is displayed indicating that the course is in progress, and reminding you to submit the course when you are ready.

![Figure 39: Save Message for In Progress Course Changes](image)

14. Click OK to continue. When you are ready to submit the course for approval, see “Submitting a Course for Approval,” on page 103 for instructions.

15. To schedule a new course, see “Scheduling a New or Updated Course,” on page 131.
Changing Course Information

If a course has changed, for instance, if a component type has changed, or if a new topic will be addressed in a course, you can change the information in the Course Catalog database. When you change course data, you are essentially adding a new, effective-dated record.

If the change affects significant fields, the new record is flagged as **In Progress**, and will not be available on the Registrar’s web site, or printed in the *Announcement* and the *Course Offerings* publications, until it is submitted and approved, although you will be able to schedule the class without waiting for approval. Changes to the Course Catalog must be approved by the Office of the Dean of the College for undergraduate courses, or the Graduate School for graduate courses.

Saving and Submitting Changes

When you make changes that do not require approval, the *Course Approved* status of the course remains **Approved**. However, when you make any change that requires approval, the *Course Approved* status of the course switches to **In Progress**. This allows you to save the course and return to it later with further changes. When you are satisfied that all the changes are correct and no further changes will be needed, you must submit the course for the dean’s approval. Only when you submit the course does the *Course Approved* status change to **Pending**, at which point you may not make further changes until the course has been approved.

Each time you open a course that is **In Progress** to make further changes, you must add a new effective-dated row for those changes. You may add as many effective-dated rows as necessary with the **In Progress** status. Because you may enter multiple effective-dated rows for a set of changes, you should start with an effective date a week or two earlier than the current date. This will allow you to save the course and return to it later on the same day, adding a new effective-dated row at that time for further changes.

You will be able to search for courses based on their approval status. You should search for the courses that are in progress regularly, to verify that you have submitted all changes to the dean’s office. You must submit all new courses and changes that require approval by the deadlines set by the Dean of the College, the Dean of the Graduate School, and the Registrar’s Office.
Before submitting course changes that require approval, you should verify on the course proof that your changes are correct and complete. When you are satisfied with the course proofs, you will use the PU Catalog Submit page of the Course Catalog page group to submit the course for approval.

**Tip!** Clicking on the Submit button changes the top row from *In Progress* to *Pending*, and deletes any prior *In Progress* rows.

When you click on the Submit button on the PU Catalog Submit page, you will be returned to the Find an Existing Value page, where you can search for another course to submit or update.

**Note:** You will use the PU Catalog Submit page of the Course Catalog page group to submit the course for approval, whether the changes were made in the Course Catalog or the Schedule of Classes.

If a course is changed in the Course Catalog after the class has been scheduled, the change is not automatically carried over to the Schedule of Classes. You must run the Course/Class Synchronization process to capture those changes in the Schedule of Classes. For more information on this process, and on which changes are synchronized by this process, see “Course and Class Synchronization,” on page 107.

**After A Course Has Been Approved**

If a new course has been approved, but has never been offered, changes are more strictly controlled than for previously offered courses. In the following table, the Xs indicate changes that must be approved for both new and previously offered courses. The Ns indicate changes that require approval only for new courses.

**Table 4: Course Catalog Changes That Must Be Approved**

<table>
<thead>
<tr>
<th>Change</th>
<th>Undergraduate</th>
<th></th>
<th></th>
<th>Graduate</th>
<th></th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>PRM</td>
<td>OTO</td>
<td>TPC</td>
<td>PRM</td>
<td>OTO</td>
<td>TPC</td>
</tr>
<tr>
<td>Component</td>
<td>X</td>
<td>N</td>
<td>N</td>
<td>X</td>
<td>N</td>
<td>X</td>
</tr>
<tr>
<td>Cross Listing</td>
<td>X</td>
<td>X</td>
<td>X</td>
<td>X</td>
<td>X</td>
<td>X</td>
</tr>
<tr>
<td>Grading Options</td>
<td>N</td>
<td>N</td>
<td>N</td>
<td>X</td>
<td>N</td>
<td>X</td>
</tr>
<tr>
<td>Instructor in Charge</td>
<td>N</td>
<td>N</td>
<td>N</td>
<td>X</td>
<td>N</td>
<td>X</td>
</tr>
<tr>
<td>Requirement Group</td>
<td>N</td>
<td>N</td>
<td>N</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Topic</td>
<td></td>
<td>X</td>
<td></td>
<td></td>
<td></td>
<td>X</td>
</tr>
</tbody>
</table>
Chapter 4: Maintaining Course Information

**Important!** After a course has been approved, you will not be able to change these fields:

- Course Title
- Catalog Number
- Description
- Distribution Area
- Course Type
- Subject Area

You cannot change the Transcript Title once it is entered and saved.

If a change is required for these fields, send an email or a memo to the Dean’s Office requesting the change and explaining why it is necessary. Be sure to include the Subject Area and Catalog Number of the course. If the Dean’s Office approves the change, they will enter it in the Course Catalog and approve the course.

Approved changes made in the Course Catalog will be reflected in the Undergraduate Announcement, depending on whether the course is a graduate or undergraduate course, as well as in SCORE, the Registrar’s Web site, and the Course Offerings. It is important to note that if a course is not approved (either pending or in progress) when the Announcement is printed, information about the course won’t appear in any of the course listings.

### Accessing the Course Catalog

Changes to course information are made in the Course Catalog page group.

When you select the **Course Catalog** from the menu you are taken to the Find an Existing Value page. From that page you have two ways to access course information:

- **Access an individual course.** You can access a course directly, if you know sufficiently specific parameters such as the Subject Area and Catalog Number. The system will find only one course that fits those parameters, and take you directly to the Catalog Data page in the Course Catalog page group.

- **Access a list of courses.** Enter a parameter (such as Subject Area or Course Approved status) for the course or courses that you want to work on, then from the resulting list, click on the desired course. This takes you to the Catalog Data page for the selected course.
The advantage of accessing a list of courses is that you don’t have to initiate a new Search for the next course that you need to work on. You can easily return to the original search list by clicking the Return to Search button at the bottom of any Course Catalog page. Alternatively, if you have a number of successive changes to make (for example, in all the courses in one Subject Area), you could merely click the Next in List and the Previous in List buttons to view the Course Catalog data for each course in turn.

To create catalog data for a new course you can click the Add Mode button to go straight to the Add a New Value page. See “Adding a New Course,” on page 43 for more information.

To access an individual course:

1. Navigate to Manage Student Records > Establish Courses > Use > Course Catalog. The Find an Existing Value page is displayed.

2. In the Subject Area field, type the subject area code directly into the Subject Area field (for example, PHY), then press the Enter key, or select your subject area via the Lookup button.

Tip! To display your subject area automatically on the Find page, you can set your operator defaults. See “Setting Your User Defaults,” on page 291.
3. Type the catalog number into the Catalog Nbr field (for example, 101 for PHY101), and press the Enter key to display the course in the Course Catalog page group.

![Figure 41: The Catalog Data Page with Greyed-out Fields](image)

Notice that several fields are grayed-out, indicating that they are protected—you cannot change them.

**Tip!** If changes are required in these fields, you must notify the Dean’s Office, and they will make the change. You can notify them by memo or e-mail, but be sure to include the Subject Area and Catalog Number of the course, the field to be changed, the changed value, and the reason for the change.

4. Make a note of the Effective Date of the course, then click the Add Row button (at the upper right of the page) to add a new effective-dated row for the course. All of your changes on any page in this page group will be made in this new row.

Notice in Figure 42, that the rest of the data for the course is copied from the currently active record.
5. In the **Effective Date** field, enter a date *later* than the effective date of the currently active record (noted in Step 4). You can use the Calendar button to select a date. Unless you want the change to be effective in the current term, today’s date will usually be acceptable. If today’s date is later than a week before the first day of the term, select a date at least two weeks prior to the first day of the term.

**Note:** You cannot use a date in the future for the Effective Date.

**Tip!** If you are making a change that requires approval, it is recommended that you use an effective date several days prior to the current date, to allow multiple updates (each with a new effective-dated row) on the same day.

The page is redisplayed after you enter the **Effective Date**, with protected fields—fields that cannot be changed—appearing greyed-out.

Changes on any page in the Course Catalog page group will be effective as of the new date.
To access a list of courses in your subject area:

1. Navigate to **Manage Student Records > Establish Courses > Use > Course Catalog**. The Find an Existing Value page is displayed.

   ![Figure 43: The Find an Existing Value page](image)

   **Tip!** To display your subject area automatically in the Catalog Data page without typing or selecting it, you can set your operator defaults. See “Setting Your User Defaults,” on page 291.

2. Type the subject area code directly into the **Subject Area** field (for example, **FRE** or **PHY**) or select it using the **Lookup** button.

3. To list only courses that are in progress, select **In Progress** from the **Course Approved** field.

4. Press the Enter key, or click the **Search** button to display the list of all courses in the subject area, as shown here in Figure 44.
5. Scroll down the list if necessary, and click the course you want to change. The Course Catalog Data page group is displayed with the data for the selected course:

6. Make a note of the value in the current *Effective Date* field.
7. Click the Add Row button to add a new, effective-dated row for this course. All of your changes will be made in this new row.

Notice, in Figure 46, that the rest of the data for the course is copied into this new row from the previous row.

![Image of the page showing the Add Row button and the Effective Date field]

8. In the Effective Date field, enter a date later than the effective date of the currently active record (noted in Step 6). You can use the Calendar button to select a date.

Unless you want the change to be effective in the current term, today’s date will usually be acceptable. If today’s date is later than a week before the first day of the term, select a date at least two weeks prior to the first day of the term.

**Tip!** If you are making changes that require approval, it is recommended that you use an effective date several days prior to the current date, to allow multiple updates (each with a new effective-dated row) on the same day.

The page is redisplayed after you enter the Effective Date, with protected fields—fields that cannot be changed—appearing greyed-out.

Changes on any page in the Course Catalog page group will be effective as of the new date.
Changing the Grading Basis

The *Grading Basis* field determines what grading basis a student may select for the course, where the student can select a grading basis. The *Grading Basis* field is found on the Catalog Data page of the Course Catalog page group.

**Note:** If you change the Grading Basis of an approved new undergraduate course that has never been offered, the course approval status changes to **In Progress**. You may continue to make changes until you submit the course for approval, at which point the course approval status will change to **Pending**, and you will not be able to make any further changes.

To change the grading basis for a course:

1. If you are not already on the Catalog Data page for the course you are changing, access the course, add a new row, and enter the effective date, as described in “Accessing the Course Catalog,” on page 68.

2. Scroll down to the Course Grading area.

![Figure 47: Scroll to the Course Grading Area]
Chapter 4: Maintaining Course Information

3. In the *Grading Basis* drop-down list, select one of the following grading bases for the course:

- */NC: Select this option if the course is a graduate course that may be taken for credit or no credit.
- */AUD/NC: Select this option if the course is a graduate course that may be taken for credit or no credit, or may be audited.
- A-F,P,Aud: Select this option if the course may be taken for a letter grade, Pass/D/Fail, or audit. This is the regular grading basis for most courses at Princeton.
- Audit Only: Select this option if the course may only be audited.
- Na, npdf: Select this option if the course may only be taken for a letter grade. Pass/D/Fail and Audit are not available for this course.
- No Audit: Select this option if the course may not be audited, but may be taken for a letter grade or Pass/D/Fail.
- No P/D/F: Select this option if the course may not be taken on a Pass/D/Fail basis, but may be taken for a letter grade or audited.
- P/D/F Only: Select this option if the course may only be taken on a Pass/D/Fail basis.

Other options that appear in the drop-down list for this field are used by the Registrar’s Office, or by students when they select courses online.

4. If you have made all the changes for this course, click the *Save* button at the bottom left of the page. A message is displayed, indicating the status of the course.

**Note:** If the *Course Approved* status changes to *In Progress*, you must submit the course for approval when you have verified that your changes are complete and correct, as described in “Submitting a Course for Approval,” on page 103.

5. Click the *OK* button to continue.
Changing the Academic Structure

Academic structure data includes the following:

✧ Academic Group—Natural Sciences, Humanities, etc.
✧ Academic Organization—department or program
✧ Academic Career—graduate or undergraduate

These fields are all on the Offerings page of the Course Catalog page group. They rarely change, and never without discussion with the Dean of the College or the Graduate Office.

To change the academic structure:

1. Access the course and add a new row as described in “Accessing the Course Catalog,” on page 68.

   **Important!** These fields should not be changed without discussing the change with the Dean of the College or the Graduate Office.

2. After adding a new row on the Catalog Data page and entering the effective date, click the Offerings tab to display the Offerings page.

   ![Figure 48: The Offerings Page after Adding a New Row for the Course](image-url)
3. To change the Academic Group, click the Lookup button to the right of Academic Group field.

4. On the Lookup Academic Group page that is displayed, click the Lookup button, then select a new value from the Search Results page:

- **ARCG**: School of Architecture. Use for Graduate courses only.
- **ENGR**: Engineering. Use for graduate or undergraduate courses.
- **HUMN**: Humanities. Use for graduate or undergraduate courses.
- **INTDS**: Interdisciplinary. Use for graduate or undergraduate courses that don’t fall into any specific group.
- **NATS**: Natural Sciences. Use for graduate or undergraduate courses.
- **SOCS**: Social Sciences. Use for graduate or undergraduate courses.
- **SPEC**: Special. Not used for course definitions.
- **WWSG**: Woodrow Wilson School. Use for Graduate courses only.

5. To change the Academic Organization, select a new value using the Lookup button to the right of Academic Organization field. You will be able to select only the Academic Organization for which you have authorization.

6. To change the Academic Career, type the appropriate value (UGRD for undergraduate, GRAD for graduate courses) over the existing value in the Academic Career field.

7. If you have made all the changes for the course, click the Save button at the bottom left of the page. A message is displayed, indicating the status of the course. Click OK to close the message box and continue.
Adding or Changing a Cross-Listing

Cross-listings are entered in the Course Catalog as a second offering of a course in the home department. The home department maintains the cross-listing, along with all the other information about the primary offering. If a cross-listing needs to be added, changed, or deleted, the home department is responsible for making those changes.

Changes to cross-listings (including deletions) must be approved by the Dean of the College.

**Note:** If you add a cross-listing to a graduate course, the original offering will remain **Approved**, but the new offering will be **In Progress**, and the course must be submitted for approval. If there are two offerings for an undergraduate course—the regular course and the cross-listing—both offerings will change to **In Progress**, and the course must be submitted for approval.

To add a cross-listing for an existing course:

1. Access the course and add a new row as described in “Accessing the Course Catalog,” on page 68.
2. Click the Offerings tab to display the Offerings page.

![Image of the Offerings page](image)
3. Click the **Add Row** button.

The *Course Offering Nbr* field is incremented by 1 and most of the fields are cleared as seen in Figure 50, on page 80.

![Figure 50: New Row for Adding a Cross Listing](image)

4. In the *Catalog Nbr* field, type the catalog number for the cross-listed course—the other department’s listing, not the home department. The *Subject Area* value will provide the first part of the catalog code.

5. Select the *Academic Group* for the cross-listed course using the **Lookup** button:

   - **ARCG**: School of Architecture. Use for Graduate courses only.
   - **ENGR**: Engineering. Use for graduate or undergraduate courses.
   - **HUMN**: Humanities. Use for graduate or undergraduate courses.
   - **INTDS**: Interdisciplinary. Use for graduate or undergraduate courses that don’t fall into any specific group. All academic Programs (as opposed to departments) must use this value.
   - **NATS**: Natural Sciences. Use for graduate or undergraduate courses.
   - **SOCS**: Social Sciences. Use for graduate or undergraduate courses.
6. In the Subject Area field, use the Lookup button to select the cross-listing department.

7. In the Academic Organization field use the Lookup button to select your department or type your department code.

8. In the Academic Career field, enter the value UGRD for an undergraduate course, or GRAD for a graduate course.

9. In the Course Status area on the right side of the page, the Allow Course to be Scheduled checkbox is selected but grayed-out.

The course will be printed as a cross-listing in the Announcement and the Course Offerings publications, the Registrar’s Web site, and reports, but will not be scheduled separately from the home department’s primary offering.

The completed cross-listed offering will look something like Figure 27.

![Figure 51: The New Cross-Listed Offering](image)

10. If you have made all the changes required for this course, click the Save button. The Course Approved status will change to In Progress for a new graduate offering, or for both offerings if the course is an undergraduate course.

### SPEC
Special. Do not use for course information.

### WWSG
Woodrow Wilson School. Use for Graduate courses only.

Tip! You can type these values directly, rather than selecting them from the Search Results.
11. When you have verified that your changes are complete and correct, you must submit the course for approval, as described in “Submitting a Course for Approval,” on page 103.

✔ To change a cross-listing:

1. Access the course and add a new row as described in “Accessing the Course Catalog,” on page 68.

2. After adding the new row, click the Offerings tab to see the Primary Offering.

![Figure 52: The Offerings Page Showing the Primary Offering](image)

3. View the cross-listings for the Primary Offering in either of two ways:

   - Click the Next button in the Course Offering Header. This displays the next cross-listing for the current Primary Offering, as seen in Figure 53.
Click the View All/View 1 link in the Course Offering Header. This displays the details of the current primary offering and all cross-listed offerings, as seen in Figure 54.
4. Make any changes that are required.

5. If you have made all the changes required for this course, click the Save button. The Course Approved status will be In Progress for both offerings for an undergraduate course, or for the offering that has changed for a graduate course.

6. When you have verified that your changes are complete and correct, you must submit the course for approval, as described in “Submitting a Course for Approval,” on page 103.

To delete a cross-listing:

1. Access the course and add a new row as described in “Accessing the Course Catalog,” on page 68.

2. When a new row has been added, click the Offerings tab.

3. Click the Next button in the Course Offering Header to display the cross-listing for the current Primary Offering.

4. Locate the Course Offering Nbr field. The value 2 displayed in the field indicates a cross-listed offering.

5. Click the Delete Row button to delete the cross-listed course, the second offering. You are prompted to verify that you really want to delete the second offering.

6. If you have made all the changes required for this course, click the Save button to save your changes. The Course Approved status will be In Progress.

7. When you have verified that your changes are complete and correct, you must submit the course for approval, as described in “Submitting a Course for Approval,” on page 103.
Adding a New Topic

Before you can select a topic for the schedule of classes for a term, the topic must be entered in the Course Catalog definition of the course. If a new topic needs to be added to a course definition, use the Course Topics area in the Catalog data page to add the new topic. The course must be a Topics course—the Course Type field value must be set to TPC.

**Note:** Do not change or delete an existing topic, since this may interfere with the correct numbering of topics, which would result in the wrong topic being listed in the Course Offerings and on transcripts.

Additional course topics must be approved by the Dean of the College or the Graduate School.

To add a topic:

1. Access the course and add a new row as described in “Accessing the Course Catalog,” on page 68.
2. When the new row has been added, scroll down to the Course Topics area.
3. Click the Add Row button of the last topic to add a new topic row.

**Important!** Do not change or delete an existing topic, since this may interfere with the correct numbering of topics, which would result in the wrong topic being listed in the Course Offerings and on transcripts.

4. Type the topic title in the Course Topic Title field. This title can be up to 70 characters long.

5. When you have entered the title, click the Transcript Topic tab.
6. If the Transcript Topic Title is not appropriate for printing on the transcript, type over the displayed text with a more appropriate title of up to 40 characters.

7. If you have made all the changes required for this course, click the Save button. The Course Approved status will be In Progress.

8. When you have verified that your changes are complete and correct, you must submit the course for approval, as described in “Submitting a Course for Approval,” on page 103.

**Changing the Instructor-in-Charge**

If a new instructor has taken charge of the course, you can change the instructor-in-charge on the Instructor page of the Course Catalog page group. If there are fewer than three instructors already assigned to the course, you can add another instructor; however, there cannot be more than three instructors-in-charge of a single course.

For an existing undergraduate course, or an existing graduate one-time-only course, changing the instructor-in-charge does not require approval; the Course Approved status will remain Approved if you change the Instructor. For any other course, changing the Instructor will change the approval status to In Progress.
To change the instructor-in-charge:

1. Access the course and add a new row as described in “Accessing the Course Catalog,” on page 68.

2. When the new row has been added, click the Instructor tab to display the Instructor page.

3. Click the Lookup button next to the instructor that you want to change.
You are not limited to instructors in your own department. If you do want to limit the Search Results list to the instructors in your own department, enter your 3-character department code in the Academic Organization field.

If you know the name, or the first few characters of the name, you can enter them in the Last Name or First Name fields, then click the Search button to display only those instructors whose names begin with those characters.

4. Select the instructor from the Search Results by clicking anywhere in the row.

**Note:** If you cannot locate the name of the instructor you want in the Course Catalog, and you know the instructor has been entered by HR with an Active status effective before the start of the term, contact the Help Desk.

5. If you have made all the changes required for this course, click the Save button. For existing undergraduate courses, or existing graduate one-time-only courses, the Course Approved status will remain Approved.
For any new course, and for any graduate permanent or topics course, the Course Approved status will be **In Progress**. When you have verified that your changes are complete and correct, you must submit the course for approval, as described in “Submitting a Course,” on page 105.

**Note:** If you have already scheduled the class for the term, you must also change the instructor in the Schedule of Classes; the Course/Class Synchronization process will not change the instructor.

**To add a new instructor:**

1. Access the course and add a new row as described in “Accessing the Course Catalog,” on page 68.

2. When the new row has been added, click the Instructor tab to display the Instructor page.

3. Click the **Lookup** button next to a clear Instructor field, then on the Search page that opens, click the **Lookup** button.

4. Select the instructor from the Search Results by clicking anywhere in the row.

**Note:** If you cannot locate the name of the instructor you want in the Course Catalog, and you know the instructor has been entered by HR with an **Active** status effective before the start of the term, contact the Help Desk.

5. If you have made all your changes for this course, click the **Save** button. For existing undergraduate courses, or existing graduate one-time-only courses, the Course Approved status will remain **Approved**.

For any new course, and for any graduate permanent or topics course, the Course Approved status will be **In Progress**. For these courses, when you have verified that your changes are complete and correct, you must submit the course for approval, as described in “Submitting a Course,” on page 105.

**Note:** If you have already scheduled the class for the term, you must also change the instructor in the Schedule of Classes; the Course/Class Synchronization process will not change the instructor.
Changing the Course Attributes

You can change the course attributes on the Catalog Data page.

To change the course attributes:

1. Access the course and add a new row as described in “Accessing the Course Catalog,” on page 68.
2. Scroll down to the Course Attributes area on the Catalog Data page.
3. To change a Course Attribute, use the Lookup button of the attributes that you want to change, and select a different attribute. For information on the Attributes, see page 51.

   Tip! If you change the Attribute to APPL, the Consent value in the Additional Course Information area of the Catalog Data Page will be changed to Department Consent. If you remove an APPL Attribute, the Consent value will be changed to No Consent.

4. To add an attribute to a course, click the Add Row button, then select the Course Attribute Value using the Lookup button.

   Note: The Course Attribute Value field will be cleared if you change the Course Attribute field.
5. If you have made all the changes required for this course, click the **Save** button. If you have made other changes that require approval, the approval status will be **In Progress**, and you must remember to submit the course for approval when you have verified that your changes are complete and correct.

**Changing Components**

If you need to change or add a course component, use the Components page of the Course Catalog page group. Changes to the components of a course require approval for all approved new courses, for all permanent courses, and for graduate topics courses.

**Important!** Change components in the Course Catalog only if you are adding or changing the **types** of components that make up the course. If you are adding or changing the **sections** of the components offered in a term, make those changes in the Schedule of Classes.

**To change an existing component:**

1. Access the course and add a new row as described in “Accessing the Course Catalog,” on page 68.

2. When the new row has been added, click the Components tab to display the Components page.

![Figure 60: The Components Page of the Course Catalog Page Group](image-url)
3. To change a Course Component, click in the Course Component field, and select a component type from the drop-down list. For a list of component types with explanations see Table 3, on page 62, or the Finding Course Catalog Data quick reference card.

4. If the component is no longer a primary, graded component, deselect the Graded Component and Primary Component check boxes. If the component has become the primary, graded component, select the Graded Component and Primary Component check boxes.

**Note:** One of the components must be the primary, graded component. If you deselect these check boxes for one component, you must select them for another component. If you select these check boxes for a component, the primary component designation for any other component will be removed.

5. To change the final exam type, click the Final Exam field, and select the correct value from the drop-down list:

   - **Final**
     There is a final exam, scheduled by the Registrar’s Office during the final exam period.
   - **Other**
     There is a term paper, lab report, or project in lieu of a final, or the final exam is scheduled on the last day of class, or there is no final. Select this value for non-graded components.
   - **Take Home**
     The final is a take-home exercise.

6. If you have made all the changes required for this course, click the Save button. The Course Approved status will be In Progress.

7. When you have verified that your changes are complete and correct, you must submit the course for approval, as described in “Submitting a Course for Approval,” on page 103.

**Note:** If you have already scheduled the class for the term, you must run the synchronization process after changing a component or adding a new component in the Course Catalog.
To add a new component:

1. Access the course and add a new row as described in “Accessing the Course Catalog,” on page 68.

2. When the new row has been added, click the Components tab to display the Components page.

3. Click the Add Row button to display a new component row.

![Clicking the Add Row Button Displays a New Component Row](image)

4. Click in the Course Component field and select the new component from the drop-down list. See Table 3, on page 62 for a list of component types with explanations.

5. Leave the Instructor Contact Hours blank.

6. The Default Section Size field is used to set the enrollment capacity default when you schedule a class. Enter the section size you want used by default for all sections of this component type. The enrollment capacity will cause enrollment to stop automatically when the specified number of students have selected the section (during online course selection). The default value of this field is 30.

7. Leave the Workload Hours field blank.
8. In the *Final Exam* field, select one of the following values:

- **Final**: There is a final exam, scheduled by the Registrar’s Office during the final exam period.
- **Other**: There is a term paper, lab report, or project in lieu of a final, or the final exam is scheduled on the last day of class, or there is no final. Select this value for non-graded components.
- **Take Home**: The final is a take-home exercise.

*Tip! This is a required field, so you must select a value. If the component is a non-graded component (not the primary component), select Other. For the graded component, you can select any of the values.*

9. Leave the *LMS File Type* field blank.

10. Leave the *Auto Create* checkbox deselected (☐).

11. If this is the primary component, select the *Graded Component* checkbox (☑) and the *Primary Component* checkbox (☑).

*Tip! If you select the Graded Component and Primary Component check boxes and another component was previously set as the graded component, the other component will lose the graded designation, since only one component can be the graded component.*

*Tip! If you selected the Graded Component checkbox, you must also select the Primary Component checkbox. At Princeton, the primary component is always the graded component.*

12. Leave the default *Instruction Mode*.

13. Leave the *Room Characteristics* field blank, since Princeton is controlling classroom scheduling through Resource25.

14. If you have made all your changes for this course, click the *Save* button. The *Course Approved* status will be *In Progress.*
15. When you have verified that your changes are complete and correct, you must submit the course for approval, as described in “Submitting a Course for Approval,” on page 103.

**Note:** If you have already scheduled the class for the term, you must run the synchronization process after changing a component or adding a new component in the Course Catalog.

**To delete a component:**

1. Access the course and add a new row as described in “Accessing the Course Catalog,” on page 68.

2. When the new row has been added, click the Components tab to display the Components page.

**Important!** Never delete the primary component. Instead, change the component type, and if classes have already been scheduled, synchronize the classes with the course. The synchronization process will change the primary component sections to the new component type.

3. You can locate the component that you want to delete in either of two ways—**View 1** (using the header navigation controls) and **View All** (using the browser’s scroll bar).

![Figure 62: Component Page](image)
View 1. The default display mode is View 1 which shows the rows one-at-a-time, as seen in Figure 63, on page 97. In the Course Component Header bar, click the Previous and Next buttons to move through the rows until you find the component that you want to delete.

![Figure 63: Deleting a Component in View 1 Mode](image)

View All. In the Course Components Header bar, click the View All link in the Course Component Header bar to view all the rows at once. Scroll down until the component that you want to delete is displayed as seen in Figure 64, on page 98.
4. Click the Delete Row button to the right of the Course Component field.

5. If you have finished all the changes for this course, click the Save button. The Course Approved status will be In Progress.

6. When you have verified that your changes are complete and correct, you must submit the course for approval, as described in “Submitting a Course for Approval,” on page 103.

Note: If you have already scheduled the class for the term, you must run the synchronization process after changing or deleting a component, or adding a new component in the Course Catalog.
Changing the Course Requirements

You would change the course requirements on the Offerings page of the Course Catalog page group to make any of these types of modifications:

✧ Limit the enrollment for a course that was previously open to all students.

✧ Change the group that the course enrollment is limited to.

✧ Remove an enrollment limit that was previously set for the course.

For example, you would change the course requirements if a course that was previously listed as open only to concentrators is now open to juniors and seniors, or a course that was open only to juniors and seniors is now open to everyone.

**Important!** Course requirements will be enforced at the time of enrollment. If you have already scheduled the class for the term, you must run the Synchronization process after modifying the Course Requirements to enforce the new requirement during online enrollment.

**Note:** There can be only one requirement group per course, so if a course is open to concentrators in two departments, use the Reserve Capacity in the Schedule of Classes to control enrollments.

Changes to course requirements must be approved for all new undergraduate courses. For previously offered undergraduate courses and for graduate courses, changes to the course requirements do not change the Course Approved status.

**To change a course requirement:**

1. Access the course and add a new row as described in “Accessing the Course Catalog,” on page 68.

2. When the new row has been added, click the Offerings tab, then scroll to the Enrollment Requirement Group area.
3. In the Requirement Group field use the Lookup button to locate the new requirement group.

**Tip!** If you will be using multiple requirement groups, start with the most restrictive requirement group as the first sequence, and move through less restrictive requirement groups in later sequences.

*These are the requirement groups in order of restrictiveness:*

- Most restrictive: XXX Graduate Students Only
  - Open to XXX Concentrators Only
  - Graduate Students Only
  - Seniors Only
  - Juniors Only
  - Sophomores Only
  - Freshmen Only
  - Juniors and Seniors Only
- Least restrictive: Not Open to Freshmen

4. After you have made the change for this course, click the Save button.
5. If the approval status has changed to **In Progress**, be sure to submit the course for approval, as described in “Submitting a Course for Approval,” on page 103.

**To delete a requirement group:**

1. Access the course and add a new row as described in “Accessing the Course Catalog,” on page 68.

2. Click the Offerings tab, then scroll down to the Enrollment Requirement Group area.

3. In the *Requirement Group* field, highlight the entire value and press the *Delete* key to remove the value. Press the *Tab* key or click outside of the field.

   The *Requirement Group* field and the *Long Description* field are cleared.

4. If you have made all the changes for this course, click the *Save* button.

5. If the approval status has changed to **In Progress**, be sure to submit the course for approval, as described in “Submitting a Course for Approval,” on page 103.
Saving Your Changes

All changes to the Course Catalog are entered using a new effective-dated row. You may make changes on any page in the page group, and they will all be saved in the same effective-dated row. However, once you click the Save button, any additional changes to the same course will require another effective-dated row, even if you have not left the Course Catalog page group for the course.

The exception is when adding new courses—you can save your changes as you work, and all of the changes will be saved in the same effective-dated row. However, once you save and navigate away from the page group, you will have to enter another effective-dated row to make further changes.

When you save a course, a message will be displayed indicating the course approval status of the course. If the Course Approved status is In Progress, the message will remind you to submit the changes for approval when they are complete. Click the OK button to continue working.

When you submit a course for approval, the course will be locked in Pending status, and you will not be able to make any further changes until the course is approved.
Submitting a Course for Approval

While you are making changes, the courses will either remain in Approved status or change to In Progress. To allow for revisions during the change process, you will be able to continue to change any course that has a status of In Progress.

However, courses with a status of In Progress must be submitted to the dean for approval before they can be included in the Course Offerings or Announcement publications, or on the Registrar’s web site. In order to meet the printing deadlines for these publications, the Registrar’s Office sets a deadline each term by which time all course changes must be submitted for review and approval.

To be sure that all of your course changes that require approval have been submitted, you should track the courses that have a Course Approved status of In Progress. You can then check the proofs for those courses to verify that the changes are correct and complete before submitting the courses for approval.

Tracking Your In Progress Courses

You can see which courses are in progress using the Find an Existing Value page for the Course Catalog or Schedule of Classes page group. This page allows you to search by Course Approved status, in addition to other search fields.

To search for courses in progress:

1. Navigate to Manage Student Records > Establish Courses > Use > Course Catalog. The Find an Existing Value page is displayed.

   Tip! You can also navigate to the Schedule of Classes page group, but that search will require that you enter a Term. If you are simply tracking your In Progress courses, it is simpler to use the Course Catalog search.
2. If your Subject Area has not been set as a default, enter or select the Subject Area.

3. In the Course Approved field, select In Progress from the drop-down list.

4. Press the Enter key or click the Search button to display a list of courses in progress.
Submitting a Course

When you have entered all the information for a course, and you are sure you will not need to make any further changes, you can submit the saved course for approval. When you submit the course for approval, the Course Approved status in the top row will change to Pending, any other In Progress rows will be deleted, and you will not be able to make any further changes until the course has been approved.

Note: Course sections must be scheduled for the term before you submit the course for approval.

To submit a course for approval:

1. If the course is not already open in the Course Catalog page group, open the course as described in “Accessing the Course Catalog,” on page 68, but do not add a new row.

   Note: You do not need to insert a new effective-dated row to submit a course for approval.

2. Click on the PU Catalog Submit tab to open the Submit page.

Figure 67: The Submit Page
3. Click on the **SUBMIT** button to submit the course for approval. A message is displayed, verifying that the course has been submitted.

![Verification of Submit](image)

Figure 68: Verification of Submit

4. Click the **OK** button to continue. You will be returned to the Find an Existing Value page for the Course Catalog page group.
When a course is added to the database, or if changes are made to an existing course, the course will immediately (or soon thereafter) be scheduled for a term. If the Course Catalog is subsequently changed, those changes do not automatically ‘trickle-down’ into the Schedule of Classes.

You can capture the information from the Course Catalog in the Schedule of Classes in two ways:

- Delete the previously scheduled section(s) and reschedule them using the Schedule New Course option. This is possible only if no students have yet enrolled in the section.
- Run the Course and Class Synchronization process, which allows you to capture the changes in the Schedule of Classes without deleting and rescheduling sections.

If you have changed the following fields in the Course Catalog, and the course has already been scheduled for the new term, you must synchronize changes in the Schedule of Classes. Shaded fields can be changed only by the Dean’s Office after the course has been approved:

- Course Short Title
- Catalog Number
- Grading Basis
- Subject Area
- Academic Group
- Distribution Area
- Academic Career
- Attributes
- Component Type

Run the synchronization process after you receive the approval e-mail from the Dean’s Office.

The following types of changes to the Course Catalog require some additional updates in the Schedule of Classes:

- If you delete a component type for which there are sections scheduled, you will also have to delete those sections in the Schedule of Classes. The sections can be deleted only until the Course Offerings is published. After that, they must be canceled.
• If you add a component type, you must add the new section(s) of that type in the Schedule of Classes.

• If a non-primary component is changed, you must add a row (or rows) in the Schedule of Classes to schedule sections of the new component type, and then delete the row(s) for sections of the old non-primary component.

Note: Primary sections scheduled with a component type that has changed are changed appropriately by the synchronization process.

• If you add a new topic to be used in a class that has already been scheduled, you will have to navigate to open the Basic Data page in the Schedule of Classes, scroll down to the Class Topics area, and select the new topic.

**Running the Course/Class Synchronization Process**

The Synchronize Courses/Classes process is necessary only if you have already scheduled the class for the term, and then changed data in the Course Catalog that would normally be carried down to the Schedule of Classes.

You can run Courses/Classes synchronization in two ways:

✦ The **Print Report Only** option allows you to run the process without actually updating the database. The report allows you to preview any changes that will be made to the Schedule of Classes data when you run the process for the term in update mode. Running the process first in this mode is recommended, as allows you to see what changes will be made should you proceed with the synchronization.

✦ The **Update & Print Report** mode actually updates the Schedule of Classes records in the database with any changes that were made to the pertinent fields in the Course Catalog. When this process is run in update mode, the previous values in the Schedule of Classes are overwritten with the new values from the Course Catalog. This option also provides the report described above, showing the actual updates.

✔ To run the Course/Class Synchronization process:

1. Navigate to **Manage Student Records > Establish Courses > Process > Synchronize Catalog/Classes.**
2. If you have run this process before, click the Search button and choose the Run Control ID for this process from the Results.

If you have never run this process before and have no Run Control ID:

a) Click the Add a New Value link, and enter a name for this run control ID.

b) Click the Add button. (For information on naming run controls see “Creating a New Run Control,” on page 287.)

The Course/Class Synchronization page is displayed as shown in Figure 69.

![Course/Class Synchronization Page](image)

*Figure 69: The Course/Class Synchronization Page*

3. Leave the default of PRINU in the Academic Institution field.

4. In the Term field, type the term code if you know it, or use the Lookup button to find the code for the term which needs to be synchronized with the catalog changes.

    **Note:** This process is necessary only if the class already has been scheduled for this term.
5. Select the appropriate Report Run Mode:

<table>
<thead>
<tr>
<th>Report Run Mode</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Print Report Only</strong></td>
<td>Prints a report that shows the expected results that will occur when you run the process again to update the database.</td>
</tr>
<tr>
<td><strong>Update and Print Report</strong></td>
<td>Updates the Schedule of Classes records in the database with any changes that were made to the particular group of fields in the Course Catalog, then prints the report listing the courses that were actually updated.</td>
</tr>
</tbody>
</table>

6. In the Course Catalog Parameters area, type the Subject Area (if you know it) in the Subject Area field, or use the Lookup button to find the Subject Area for the course which needs to be synchronized with the catalog changes.

7. In the Catalog Number field, type the catalog number for the course you wish to synchronize.

**Tip!** To synchronize all of the courses for a particular subject, enter only the Subject Area, leaving the Catalog Number field blank, and skip Step 8 (unless you are responsible for multiple Subject Areas). This will process all courses scheduled for the term in that Subject Area.
8. To synchronize additional selected courses:
   a) Click the Add Row + button to add a new row.
   b) Enter the Subject Area and Catalog Number for the additional course.
   c) Repeat for each additional course you want to synchronize.

9. Click the Run button. The Process Scheduler Request page is displayed:

![The Process Scheduler Request Page](image)

Figure 71: The Process Scheduler Request Page

10. Leave the Server Name field set to PSUX.

11. Leave the Recurrence and Time Zone fields blank.

12. In the Run Date and Run Time fields, leave the default value. If the Run Date and Run Time fields reflect the date and time of the last synchronization run, click the Reset to Current Date/Time button.

13. In the Process List area, ensure that Synchronize Course & Schedule is selected (✓).

14. In the Type field, choose Printer from the drop-down list.

The Format field defaults to PS and the Output Destination field appears as seen in Figure 72.
15. In the *Format* field, select **HP** to ensure correct formatting of the printed report.

16. In the *Output Destination* field, enter the full path to your network printer, giving the full network name, for example, **hp126alex124**. See “Locating Your Network Printer Name,” on page 297 for instructions on how to determine the name of your network printer.

17. Click the **OK** button to run the process.
# Scheduling Classes

<table>
<thead>
<tr>
<th>Section</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>Selecting Courses from a Previous Term</td>
<td>114</td>
</tr>
<tr>
<td>Locating Courses from Prior Terms</td>
<td>115</td>
</tr>
<tr>
<td>Printing Worksheets</td>
<td>119</td>
</tr>
<tr>
<td>Identifying Courses to be Copied</td>
<td>125</td>
</tr>
<tr>
<td>Copying Courses to the New Term</td>
<td>126</td>
</tr>
<tr>
<td>Copying One or More Courses</td>
<td>126</td>
</tr>
<tr>
<td>Scheduling a New or Updated Course</td>
<td>131</td>
</tr>
<tr>
<td>Accessing the Schedule New Course Page Group</td>
<td>133</td>
</tr>
<tr>
<td>Creating the Sections</td>
<td>135</td>
</tr>
<tr>
<td>Selecting the Topic for This Term</td>
<td>138</td>
</tr>
<tr>
<td>Adding Attributes</td>
<td>140</td>
</tr>
<tr>
<td>Entering a Description for the Offering</td>
<td>142</td>
</tr>
<tr>
<td>Adding the Sample Reading List</td>
<td>144</td>
</tr>
<tr>
<td>Adding Additional Information</td>
<td>146</td>
</tr>
<tr>
<td>Setting the Grading Requirements</td>
<td>148</td>
</tr>
<tr>
<td>Scheduling the Section Meetings</td>
<td>150</td>
</tr>
<tr>
<td>Setting Enrollment Controls</td>
<td>158</td>
</tr>
<tr>
<td>Setting the Reserve Capacity</td>
<td>162</td>
</tr>
<tr>
<td>Setting the Reserve Capacity Release Date</td>
<td>165</td>
</tr>
<tr>
<td>Adding and Deleting Sections in the Schedule</td>
<td>168</td>
</tr>
<tr>
<td>Accessing the Schedule of Classes Page Group</td>
<td>169</td>
</tr>
<tr>
<td>Adding a New Class Section</td>
<td>171</td>
</tr>
<tr>
<td>Deleting a Section</td>
<td>179</td>
</tr>
<tr>
<td>Changing the Time and Day of an Offering</td>
<td>181</td>
</tr>
<tr>
<td>Changing a Standard Meeting Pattern</td>
<td>181</td>
</tr>
<tr>
<td>Changing to a Non-Standard Meeting Pattern</td>
<td>185</td>
</tr>
<tr>
<td>Changing Descriptive Info in the Schedule</td>
<td>187</td>
</tr>
<tr>
<td>Locating the Primary Component Section</td>
<td>188</td>
</tr>
<tr>
<td>Selecting a Different Topic</td>
<td>190</td>
</tr>
<tr>
<td>Changing the Class Description</td>
<td>192</td>
</tr>
<tr>
<td>Changing the Attributes</td>
<td>195</td>
</tr>
<tr>
<td>Changing the Sample Reading List</td>
<td>197</td>
</tr>
<tr>
<td>Changing Additional Information</td>
<td>199</td>
</tr>
<tr>
<td>Changing Grading Requirements</td>
<td>201</td>
</tr>
<tr>
<td>Changing the Instructor for a Section</td>
<td>203</td>
</tr>
<tr>
<td>Changing Enrollment Controls</td>
<td>207</td>
</tr>
<tr>
<td>Changing the Class Status</td>
<td>208</td>
</tr>
<tr>
<td>Changing Enrollment and Room Capacity</td>
<td>211</td>
</tr>
<tr>
<td>Making Changes on the Class Sections Page</td>
<td>213</td>
</tr>
<tr>
<td>Changing Reserve Capacity</td>
<td>218</td>
</tr>
<tr>
<td>Adding Reserve Capacity for an Existing Section</td>
<td>221</td>
</tr>
<tr>
<td>Releasing Reserved Seats</td>
<td>223</td>
</tr>
<tr>
<td>Setting Additional Reserves</td>
<td>225</td>
</tr>
<tr>
<td>Removing Reserve Capacity</td>
<td>228</td>
</tr>
<tr>
<td>Printing Proofs for Review</td>
<td>232</td>
</tr>
</tbody>
</table>
Selecting Courses from a Previous Term

When scheduling courses for a new term, the information in the Schedule of Classes can be derived from a previously scheduled course, or from the Course Catalog. The first step in the process of scheduling courses for a new term is determining whether the course has been offered before, or is new or changed.

Changed and New Courses

If a course has been changed in the Course Catalog or is a new course, you must schedule the course as new in order to capture the information from the Course Catalog.

Tip! If the course is changed in the Course Catalog after you have scheduled the course, you can use the Course and Class Synchronization process to update the Schedule of Classes with the changed information. See “Course and Class Synchronization,” on page 107.

Previously Offered Unchanged Courses

If the course has been offered previously and has not changed in the Course Catalog, locate the best version of the course from prior offerings, then copy the information (roll the information) into the new term. You can then use the Schedule of Classes page group to make any changes to the class information or schedule.

Locating the best version of a course from prior offerings involves locating the courses using the Pre-Worksheet Course List, printing worksheets for the selected courses, and identifying the courses to be copied.

Tip! The best version of a course is the version that matches most closely the course to be offered this term, for example, the course with the same title or topic, taught by the same instructor.

After the course is copied into the new term, any changes to the class information and schedule can be entered in the Schedule of Classes page group.
However, for new courses that had been approved in the Course Catalog, the changes listed in Table 5 will require approval before the course can be printed in the *Course Offerings* publication.

**Note:** If you make a change in the Schedule of Classes that requires approval, you will need to submit the course for approval from the Course Catalog page group. See “Submitting a Course for Approval,” on page 103, for more information.

### Table 5: Schedule Changes That Require Approval

<table>
<thead>
<tr>
<th>Type of Course</th>
<th>Changes Needing Approval</th>
<th>On Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>Undergraduate</td>
<td>Description</td>
<td>Description</td>
</tr>
<tr>
<td></td>
<td>Prerequisites and Restrictions</td>
<td>Additional Information</td>
</tr>
<tr>
<td></td>
<td>Reading/Writing Assignments</td>
<td>Additional Information</td>
</tr>
<tr>
<td></td>
<td>Other Information</td>
<td>Additional Information</td>
</tr>
<tr>
<td></td>
<td>Requirements and Grading</td>
<td>Requirement/Grading</td>
</tr>
<tr>
<td>Graduate</td>
<td>Prerequisites and Restrictions</td>
<td>Additional Information</td>
</tr>
<tr>
<td></td>
<td>Reading/Writing Assignments</td>
<td>Additional Information</td>
</tr>
</tbody>
</table>

**Locating Courses from Prior Terms**

You may want to review key identifying data from several courses in order to determine the courses for which you want to print worksheets. You can do this by printing the Pre-Worksheet Course List, which identifies courses by subject, catalog number, term, course & topic title (if any), and instructor. You can select which courses will be included on the list based on subject area, catalog number, term, and academic career (graduate or undergraduate). You can also print a Pre-Worksheet Course List for a single course, for as far back as Fall 1990.
To run the Pre-Worksheet Course List:

1. Navigate to Manage Student Records > Establish Courses > Report > Pre-Worksheet Course List. The Find an Existing Value page is displayed.

![Figure 73: Finding an Existing Value](image)

2. If you have run this process before, click the Search button on the Find an Existing Value page, then in the Search Results, click the Run Control ID for this process.

If you have never run this process before and have no Run Control ID for this process, click the Add a New Value link, then in the new page that is displayed (Figure 74), enter a name for this run control process and click the Add button. For information on naming run controls, see “Creating a New Run Control,” on page 287.

![Figure 74: Add a New Value – Pre-Worksheet Course List Page](image)

The Pre-worksheet Course List request page is displayed as shown in Figure 75.
3. In the **Subject Area** field, type the 3-character code for your academic department or program or select it using the **Lookup** button. The **Subject Area** is your academic department or program, or a subject area within the department.

The next time you display this page this value will remain set, until you change it.

4. If you want to print a Pre-Worksheet Course List for one specific course, type the catalog number of the desired course in the **Catalog Nbr** field. Otherwise, leave this field blank.

5. In the **Select From Term** field, use the **Lookup** button to select the first term for which you want to see identifying course data.

6. In the **Select To Term** field, use the **Lookup** button to select the last term for which you want to see identifying course data.

7. If you are working on undergraduate courses, leave the **Academic Career** set on **Undergraduate**. If you want to see a list for graduate courses, click the **Graduate** radio button.

8. Click the **Run** button to display the Process Scheduler Request page, as shown in as shown in Figure 76.
9. In the *Server Name* drop-down list, choose the **PSUNX** option.

10. In the *Type* drop-down list, choose the **Printer** option. An *Output Destination* field is displayed.

11. In the *Format* field, select **HP** to ensure correct formatting of the printed report.
12. In the *Output Destination* field, enter the NT printer name (the Windows NT physical share name). Do not put \"\ntprintserver\" in front of the printer name. See “Locating Your Network Printer Name,” on page 297” for instructions on how to determine the name of your network printer.

13. Click the OK button to print the Pre-Worksheet Course List. A sample of the Pre-Worksheet Course List is shown in Figure 78.

<table>
<thead>
<tr>
<th>Subject</th>
<th>Catalog #</th>
<th>Term Code</th>
<th>Term Description</th>
<th>Course Title</th>
<th>Instructor</th>
</tr>
</thead>
<tbody>
<tr>
<td>COS</td>
<td>1 11</td>
<td>09 22</td>
<td>1997-1998 Fall</td>
<td>Computers and Computing</td>
<td>Andrea S. Le Feugh</td>
</tr>
<tr>
<td>COS</td>
<td>1 11</td>
<td>0 9 32</td>
<td>1996-1999 Fall</td>
<td>Computers and Computing</td>
<td>Andrea S. Le Feugh</td>
</tr>
<tr>
<td>COS</td>
<td>1 11</td>
<td>1 0 22</td>
<td>1999-2000 Fall</td>
<td>Computers and Computing</td>
<td>Andrea S. Le Feugh</td>
</tr>
<tr>
<td>COS</td>
<td>1 11</td>
<td>1 0 34</td>
<td>1995-2000 Spring</td>
<td>Computers and Computing</td>
<td>Douglas W Clark</td>
</tr>
<tr>
<td>COS</td>
<td>1 2 6</td>
<td>0 9 22</td>
<td>1997-1998 Fall</td>
<td>General Computer Science</td>
<td>Robert Sedgwick</td>
</tr>
<tr>
<td>COS</td>
<td>1 2 6</td>
<td>0 9 22</td>
<td>1998-1999 Fall</td>
<td>General Computer Science</td>
<td>Robert Sedgwick</td>
</tr>
<tr>
<td>COS</td>
<td>1 2 6</td>
<td>0 9 44</td>
<td>1995-1999 Spring</td>
<td>General Computer Science</td>
<td>Thomas Funkhouser</td>
</tr>
<tr>
<td>COS</td>
<td>1 2 6</td>
<td>1 0 22</td>
<td>1999-2000 Fall</td>
<td>General Computer Science</td>
<td>Randolph Y Wang</td>
</tr>
<tr>
<td>COS</td>
<td>1 2 6</td>
<td>1 0 34</td>
<td>1999-2000 Spring</td>
<td>General Computer Science</td>
<td>Adam Fishelovin</td>
</tr>
<tr>
<td>COS</td>
<td>4 0 5</td>
<td>0 9 22</td>
<td>1999-2000 Fall</td>
<td>Special Topics in Computer Science</td>
<td>Ben Shekli</td>
</tr>
<tr>
<td>COS</td>
<td>4 0 5</td>
<td>0 9 22</td>
<td>1999-2000 Fall</td>
<td>Visual and Audio Design for Computer Displays</td>
<td>Ben Shekli</td>
</tr>
</tbody>
</table>

*Figure 78: A Sample of the Pre-Worksheet Course List*

**Printing Worksheets**

The Pre-Worksheet Course List shows the subject area, catalog number, term code and description, course title and topic, if applicable, and the instructor for each course and term selected. Using this data, you can determine the courses for which you should print worksheets.

You can print worksheets by course, by subject area, by term, and by instructor, depending on the values you enter in the run control request page. The following table shows the values you would enter to print worksheets, starting with the smallest resulting printout and ending with the largest.
### Table 6: Worksheet Options

<table>
<thead>
<tr>
<th>To Print Worksheets for…</th>
<th>Enter values in these fields</th>
<th>Subj. Area</th>
<th>Cat. Nbr</th>
<th>Select From Term</th>
<th>Select Thru Term</th>
<th>Academic Career</th>
<th>Instructor ID</th>
</tr>
</thead>
<tbody>
<tr>
<td>One specific course from one specific term</td>
<td></td>
<td>X</td>
<td>X</td>
<td>The desired term</td>
<td>Same as Select From Term</td>
<td></td>
<td></td>
</tr>
<tr>
<td>One course, each time it was offered by a specific instructor</td>
<td></td>
<td>X</td>
<td>X</td>
<td>The starting term</td>
<td>The ending term</td>
<td></td>
<td>X</td>
</tr>
<tr>
<td>One specific course from several terms</td>
<td></td>
<td>X</td>
<td>X</td>
<td>The starting term</td>
<td>The ending term</td>
<td></td>
<td></td>
</tr>
<tr>
<td>All courses from a specific term offered by a single instructor</td>
<td></td>
<td>X</td>
<td></td>
<td>The desired term</td>
<td>Same as Select From Term</td>
<td></td>
<td>X</td>
</tr>
<tr>
<td>All graduate courses for a single term</td>
<td></td>
<td>X</td>
<td></td>
<td>The desired term</td>
<td>Same as Select From Term</td>
<td>GRAD</td>
<td></td>
</tr>
<tr>
<td>All undergrad. courses for a single term</td>
<td></td>
<td>X</td>
<td></td>
<td>The desired term</td>
<td>Same as Select From Term</td>
<td>UGRD</td>
<td></td>
</tr>
<tr>
<td>All undergraduate courses for several terms</td>
<td></td>
<td></td>
<td></td>
<td>The starting term</td>
<td>The ending term</td>
<td>UGRD</td>
<td></td>
</tr>
<tr>
<td>All graduate courses for several terms</td>
<td></td>
<td>X</td>
<td></td>
<td>The starting term</td>
<td>The ending term</td>
<td>GRAD</td>
<td></td>
</tr>
<tr>
<td>All courses in the subject area for one term</td>
<td></td>
<td>X</td>
<td></td>
<td>The desired term</td>
<td>Same as Select From Term</td>
<td></td>
<td></td>
</tr>
<tr>
<td>All courses in the subject area for multiple terms</td>
<td></td>
<td>X</td>
<td></td>
<td>The starting term</td>
<td>The ending term</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>
To print worksheets:

1. Navigate to Manage Student Records > Establish Courses > Report > Course Worksheet/Proof. The Find an Existing Value page is displayed.

   ![Find an Existing Value Page - Course Worksheet/Proof](Image)

   Your run control will not be confused with another run control of the same name owned by another user.

2. If you have run this process before, click the Search button on the Find an Existing Value page, and choose the Run Control ID for this process from the search results.

   If you have not run this process before and have no Run Control ID for this report, click the Add a New Value link, then in the Add a New Value page that is displayed (Figure 74), enter a name for this run control process, and click the Add button. For information on naming run controls see “Creating a New Run Control,” on page 287.

3. If you are adding your first run control for the Course Worksheet/Proof report, the Run Control Request page is displayed with blank fields.
4. If the Subject Area does not contain the desired value, enter the 3-character code or click the Lookup button and select the value from the Search Results.

5. To print worksheets for a single course, in one or more terms, enter the Course Catalog number (the 101 of PHY101) in the Catalog Nbr field. To print worksheets for all courses that meet the remaining criteria, leave the Catalog Nbr field blank.

6. To print worksheets from one term only, enter the same term code in the Select From Term and the Select Thru Term fields. To print worksheets from several consecutive terms, enter the first desired term in the Select From Term field, and the last desired term in the Select Thru Term field.

7. To limit the worksheets to undergraduate courses, select UGRD in the Academic Career field. To limit the worksheets to graduate courses, select GRAD in the Academic Career field. To print worksheets for both graduate and undergraduate courses, leave the Academic Career field blank.

8. To print worksheets for courses taught by a specific instructor:
   a) Click the Lookup button next to the Instructor ID field and use one of the following two methods to locate the instructor.
Selecting Courses from a Previous Term

- Choose **Name** from the *Search By* drop-down list and enter the first four letters of the Instructor’s last name or the entire last name.
- In the **ID** field enter the Instructor’s name, or the first four numbers of the Instructor’s ID or the entire ID number.

**Note:** Partial names and ID numbers are permitted, but not wildcard characters, such as a question mark (?) or asterisk (*).

b) Press the **Enter** key or click the **Lookup** button, then select the Instructor from the Search Results.

The Run Control Request page shown in Figure 81 creates a single worksheet, for the Physics 101 course from the Fall term of the academic year 2003–2004.

![Figure 81: The Completed Run Control Request Page for a Single Worksheet](image)

9. To print worksheets for more than one course, click the **Add Row** button and repeat Step 4 through Step 8. You may add as many rows as you need for the courses you have identified as likely prospects for copying.

**Note:** If you are printing worksheets for fewer courses than the last time you used this run control, be sure to delete the extra rows.
10. When the Run Control Request page is completed and correct, click the Run button to display the Process Scheduler, from which you can send the report to the printer.

![Process Scheduler Request Page for Worksheets](image)

**Figure 82: The Process Scheduler Request Page for Worksheets**

11. In the *Server Name* drop-down list, choose the **PSUNX** option. An *Output Destination* field is displayed.

12. In the Process List area, select (✓) *Course Information Worksheet*.

13. In the *Type* drop-down list, and choose the **Printer** option. An *Output Destination* field is displayed.

14. In the *Format* field, select **HP** to ensure correct formatting of the printed report.

15. In the *Output Destination* field, enter the NT printer name (the Windows NT physical share name). Do not put “\ntprintserver1” in front of the printer name. See “Locating Your Network Printer Name,” on page 297” for instructions on how to determine the name of your network printer.

16. Click the OK button to print.
Identifying Courses to be Copied

Once you have printed the worksheets, you can distribute them to the professors for review and mark-up. If you needed to print more than one worksheet for a course, the professor can indicate which is the correct course to copy to the next term, based on the information on the worksheets. Any changes to the information that will be printed in the Course Offerings can be marked in the right-hand column.
Copying Courses to the New Term

To print a course in the Course Offerings, these conditions must be met:

- The course must be approved in the Course Catalog as of the start of the new term.
- The course must be active in the new term. To make the course active in the new term, one of the following actions must be performed:
  - The course must be copied (rolled) into the new term from a selected prior term. Once a course has been copied from the prior term, you can make any changes necessary for the next term’s Course Offerings. See “Changing Descriptive Info in the Schedule,” on page 187, for information about changing a course that has been copied from a prior term.
  - The course must be scheduled as a new course in the Schedule of Classes. See “Scheduling a New or Updated Course,” on page 131, for information on how to schedule a course in the Schedule of Classes.

You can copy courses into the new term individually, or in a group based on the subject area. All courses that are copied at one time are copied from the same prior term.

Important! You should never copy all the courses for an entire department from one term to another.

Copying One or More Courses

You can copy one or more courses from the same term at the same time by adding a row for each course you want to copy.

Important! When PeopleSoft does a Prior Term Copy for the course you are copying, it will roll all components regardless of how the course is setup in the Course Catalog, with the exception of subsections, which will not be copied to the new term.
Tip! It is recommended that you start with the term from which you are copying the greatest number of courses (usually the most recent equivalent term). When you have copied all the courses that apply from that term, start again with the term that has the next largest number of courses to be copied, and so on.

To copy one or more courses from the same term:

1. Navigate to Manage Student Records > Establish Courses > Process > Prior Term Copy. The Find an Existing Value Page is displayed.

2. If you have never run this process before, click the Add a New Value link, at the bottom of the page. In the Add a New Value page, type a name, such as Term_Copy, for your run control for this process.

   If you have run this report before, click the Search button on the Find an Existing Value page, and choose the Run Control ID for this process from the Search Results. The Prior Term Copy page is displayed with the values from the previous run.

   Figure 83: The Prior Term Copy Page

3. In the Institution field, type PRINU or use the Lookup button to select PRINU.
4. In the Roll From Term field, click the Lookup button to find the term code for the old term.

5. In the Roll To Term field, click the Lookup button to find the term code for the new term.

6. In the Subject Area field, type the 3-character code or click the Lookup button and select it from the search results.

7. In the Catalog Number field, type the catalog number for the course you want to copy in the Catalog Number field.

8. To copy another course from the same term click the Add Row button, and repeat Step 6 and Step 7. Add as many rows as needed to include every course being copied from the selected term.

9. Click on the Prior Term Copy2 tab, and verify that all Class Status values are checked. If a class status is not checked, sections in that status will not be copied.
10. Verify that the Roll Options that you need are checked. Keep in mind that these options apply to all the classes you are copying with this process.

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Use Catalog Component</td>
<td>Select this option to ensure that if a component type has changed in the Course Catalog since the term you are copying from, sections that don’t match the Course Catalog will not be copied.</td>
</tr>
<tr>
<td>Roll Combined Sections</td>
<td>Select this option if any of the classes you are copying have combined sections, especially lecture sections.</td>
</tr>
<tr>
<td>Roll Room Characteristics</td>
<td>Select this option to copy the room characteristics, unless the room characteristics for the majority of the classes you are copying are changing.</td>
</tr>
<tr>
<td>Roll Meeting Patterns</td>
<td>Select this option if the meeting patterns for the majority of the classes you are copying will not change.</td>
</tr>
<tr>
<td>Roll Instructors</td>
<td>Select this option if the instructors for the majority of classes you are copying will not change.</td>
</tr>
<tr>
<td>Roll Class Notes</td>
<td>It is not necessary to select this; Princeton is not using class notes.</td>
</tr>
<tr>
<td>Roll Reserve Capacities</td>
<td>Do not select this option; reserve capacities are likely to have changed during the add/drop period, and should be reset.</td>
</tr>
<tr>
<td>Roll Class Requisites</td>
<td>Select this option to copy the requisites, which usually do not change.</td>
</tr>
<tr>
<td>Roll Class Attributes</td>
<td>Select this option to copy the attributes, unless the attributes for a majority of the classes you are copying will be changing.</td>
</tr>
</tbody>
</table>

**Tip!** Generally, you will probably want to roll combined sections, room characteristics, class requisites, and class attributes. You may also want to roll meeting patterns and instructors, if they are remaining the same. You would probably not need to roll class notes, and you should not roll reserve capacities. You should always use catalog components.
11. Click the Run button to display the Process Scheduler Request page for the Prior Term Copy process.

![Process Scheduler Request Page for Term Roll](image)

**Figure 84: Process Scheduler Request Page for Term Roll**

12. In the **Server Name** drop-down list choose the **PSUNX** option.

13. Leave the default values for the **Type** and **Format** fields. No report is produced; the system will only update the database.

14. Click the **OK** button to copy the selected courses to the new term.

15. To roll courses from another term, repeat the proceeding process, entering a new **Roll From Term**.

**Important!** Be sure to delete any extra rows if you are copying fewer courses from this term than the last.
The first time a course is scheduled, after it has been added or changed in the Course Catalog, it must be scheduled as a new course, using the Schedule New Course page group. The course must be added to the Course Catalog and then scheduled, before the Dean of the College or the Graduate School will approve it.

You can schedule a new course while it is in progress or pending approval. However, after you have submitted the course for approval, you cannot go back and make changes to it in the Schedule of Classes until the course has been approved.

If a new course has been approved but not yet actually offered, changes to the following fields in the Schedule of Classes, will return the course to the approval status of **In Progress**. You will then have to submit the course for approval from the Course Catalog (see “Submitting a Course for Approval,” on page 103 for complete instructions.

**Table 7: Changes That Must Be Approved**

<table>
<thead>
<tr>
<th>Type of Course</th>
<th>Changes Needing Approval</th>
<th>On Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>Undergraduate</td>
<td>Description</td>
<td>Description</td>
</tr>
<tr>
<td></td>
<td>Prerequisites and Restrictions</td>
<td>Additional Information</td>
</tr>
<tr>
<td></td>
<td>Reading/Writing Assignments</td>
<td>Additional Information</td>
</tr>
<tr>
<td></td>
<td>Other Information</td>
<td>Additional Information</td>
</tr>
<tr>
<td></td>
<td>Requirements and Grading</td>
<td>Requirements/Grading</td>
</tr>
<tr>
<td>Graduate</td>
<td>Prerequisites and Restrictions</td>
<td>Additional Information</td>
</tr>
<tr>
<td></td>
<td>Reading/Writing Assignments</td>
<td>Additional Information</td>
</tr>
</tbody>
</table>

If a course has been offered at least once, and you make changes to the class information in the Schedule of Classes, the course will remain **Approved**; it will not return to the approval status of **In Progress**.
The Schedule New Course page group contains the same pages as the Schedule of Classes page group. The only difference you will see between the two is that the Schedule of Classes page group generally shows more values already filled in. Since the data fields in the Schedule of Classes page group are populated from a previous entry in the Schedule of Classes, all of the required data will be there. In the Schedule New Course page group, the fields are populated from the Course Catalog, which does not contain all the information required for the Schedule of Classes.

The Schedule New Course page group consists of eight pages:

- Basic Data—where you can add sections of the defined components, indicate the course administrator, set Student-Specific Permission for the section, and set course attributes such as Term Offered. If multiple topics are defined for the course you can select the topic to be studied during the term.

- Description—where you can change the description of the course, or add or change the URL for the course web page.

- Sample Reading List—where you can add titles and authors of the documents that will be required for the course. If there are more titles than will fit on the page, you can indicate that the instructor will provide a complete list.

- Additional Information—where you can add further information, such as reading and writing assignments, prerequisites and restrictions, and any other information that needs to be printed in the Course Offerings. Reading/Writing Assignments and Prerequisites & Restrictions are not printed for graduate courses in the Course Offerings.

  \textbf{Note:} The prerequisites and restrictions entered here are not enforced by the system.

- Requirements/Grading—where you can enter the percentage of the course grade contributed by each type of assignment or test. For example, the final is 50% of the grade, the midterm is 30%, and class participation is 20%. This applies only to the primary component section of the course. This information is not printed for graduate courses in the Course Offerings.

- Meetings—where you can enter the pattern of class meeting days and times for each section, and change or add instructors.
Scheduling a New or Updated Course

Tip! The instructor entered in the Schedule of Classes is used only for the CAFSIS report. The instructor printed in the Course Offerings is the one entered in the Course Catalog. The authority to approve grades is also given only to the Instructor(s) listed in the Course Catalog.

- Enrollment Control—where you can change the enrollment capacity for the section. These restrictions will be enforced by the system when the students enroll online.
- Reserve Capacity—where you can set the number of seats reserved for particular groups of students, such as Freshmen, concentrators, or graduate students.

Accessing the Schedule New Course Page Group

When you have added a new course to the Course Catalog, or updated a course that has not already been scheduled for this term, you must schedule the course using the Schedule New Course page group. This is how new information in the Course Catalog is transferred to the Schedule of Classes.

Tip! If you have already scheduled the course before the change is made in the Course Catalog, you can use the Course and Class Synchronization process to capture the changed information in the Schedule of Classes. See “Course and Class Synchronization,” on page 107, for more information.

✔ To access the Schedule New Course page group:

1. Navigate to Manage Student Records > Establish Courses > Use > Schedule New Course. The Find an Existing Value page is displayed.
2. In the *Term* field, type the 3-character code or click the **Lookup** button to find the code for the new term (the term you are scheduling).

**Tip!** You can set your operator defaults to provide the term you are currently scheduling and the subject area by default. See “Setting Your User Defaults,” on page 291 for more information.

3. If the *Subject Area* field is blank, or is not the correct subject area, type the 3-character code for the subject area of the course you are scheduling, or click the **Lookup** button to find the subject area.

4. If you know the catalog number of the course, type it in.

If you do *not* know the catalog number:

a) In the *Academic Career* drop-down list select **Undergraduate** or **Graduate** to reduce the length of the search list.

b) Click the **Search** button to display a search list, as shown in Figure 131, then choose from the results.

c) Locate the desired course and click any link in the row to select it.

This transfers the Course Catalog information to the Schedule of Classes and displays the Schedule New Courses page group. The Basic Data page is displayed, showing the information about the selected course from the Course Catalog.
Creating the Sections

When you open the Schedule New Course page group to add a new course to the Schedule of Classes, the catalog information for that course is loaded into the schedule. However, there are fields in the Schedule of Classes that are not required in the Course Catalog, such as meeting times, sample reading lists, grading requirements, and so on. Use the Schedule New Course page group to add the information required to schedule the course.

The first page, the Basic Data page, is where you add all the sections for each component of the course.

To create sections for a new course:

1. Access the Schedule New Course page group as described in “Accessing the Schedule New Course Page Group,” on page 133. The Basic Data page of the Schedule New Course page group will be displayed, showing the data from the Course Catalog.

2. Leave the Session value at 1, since Princeton has only one session per term.
3. In the Component field, use the Lookup button to go to the Lookup Component page, click the Lookup button and select a component from the search results.

It is recommended that you add the primary component first.

**Note:** On the Lookup Component page, use the Lookup button to display for selection a list of only the component types included in this course. **Do not** use the drop-down list box, since all component types are listed there, and you could select a component type that is not valid for the course.

If you need a description of the component types, see Table 3, on page 62.
4. Enter the section number in the *Class Section* field, using the following format:

1st character | A letter indicating the component type of the section:
--- | ---
B | Lab
C | Class
D | Drill
E | Ear Training
F | Film
L | Lecture
P | Precept
S | Seminar
U | Studio

2nd and 3rd characters | A sequential number within the component type, starting with 01. There will be a new number for each section of the component that meets at a different time period.

4th character | If this is the only section or the first section of the component type meeting at this time, this character is blank. If there are multiple sections meeting at the same time, each section after the first subsection contains a letter in this position, starting with A.

For example, if there are six lab sections, three of which meet at 1:30 on Wednesday, and three of which meet at 7:00 on Wednesday, the sections would be numbered *B01, B01A, B01B, B02, B02A,* and *B02B*.

5. In the *Class Type* field, the value *Enrollment* will be selected by default for all sections of the primary component, and *Non-Enroll* for all other sections. Do not change this value.

6. In the *Associated Class* field, the value 1 will be displayed for all sections of the primary component. The value will be 999 for all other sections. Do not change this value.
7. If an instructor-in-charge was entered in the Course Catalog, that value will be displayed in the Course Administrator field. If more than one instructor-in-charge was entered in the Course Catalog, the Course Administrator field displays the first one.

If you need to change the Course Administrator, use the Lookup button to view all professional staff members in the Search Results list. You can filter the list by entering values in the Lookup page, then clicking the Lookup button.

8. The Academic Organization field is filled from the Course Catalog.

9. For sections of the primary component, if the course requires an application or interview, select (✓) the Student-Specific Permissions checkbox.

Permissions, in conjunction with the APPL attribute (set in the Class Attributes section at the bottom of the Basic Data page), restrict students from selecting the course unless they have been granted permission. See “Assigning Student-Specific Permissions,” on page 273, for information on how to grant the permissions.

Note: To list the course in the Course Offerings as requiring an application or interview, the Student-Specific Permissions checkbox must be checked, and the Course Attribute must be set to APPL in the Schedule of Classes.

10. To add another section, click the Add Row button, and repeat Step 3 through Step 9.

Selecting the Topic for This Term

For Topics courses, you need to select the course topic for this term from the topics entered in the Course Catalog. For any other course type, you can skip this section, and continue with “Adding Attributes,” on page 140.

Important! Make sure the displayed component is the primary component, since topics are associated only with primary components.

Do not add multiple topics for a class.
To select a topic for this term:

1. On the Basic Data page of the Schedule New Course page group, make sure that you are on the primary component of the course.

   ![Figure 88: Check for Primary Component of the Course](image)

2. Scroll down to the Class Topic section, as shown in Figure 89.

   ![Figure 89: Selecting the Topic for an Offering](image)
3. In the **Course Topic ID** field, type the 3-character code or click the **Lookup** button and choose a topic from the search list. Only topics that were entered in the Course Catalog for this course will appear on this list.

4. In the Equivalent Course Group area, leave the **Override Equivalent Course** checkbox deselected (☐), since Princeton does not use equivalent courses. The **Class Equivalent Course Group** field remains disabled and blank.

**Adding Attributes**

Attributes provide information to be printed in the **Announcement** or **Course Offerings** publications. They include the following:

**Enforced by the System:**

**APPL**

By application/interview only (printed in **Course Offerings**). The student must apply for permission to take the course, or an interview may be required.

*Important! If APPL is specified here, you must also check the Student Specific Permission checkbox on the Basic Data page.*

**Not Enforced by the System:**

**CONR**

Required for concentrators (printed in **Course Offerings**). Students who are concentrating in this subject area must take this course.

**OFFR**

Term offered (printed in **Announcement**). Indicates whether the course is offered in the Fall, the Spring, or both terms, or not offered this year. Attribute values for this attribute are **BOTH**, **FALL**, **SPRING**, or **NOTTYR** (Not offered this year).

Unlike a course **Requirement Group** or **Reserve Capacity**, the **CONR** and **OFFR** Attributes are not enforced by the system. They are for informational purposes only.
Attributes are set in the Course Catalog, and are carried over into the Schedule of Classes for the term. If the attributes set in the Course Catalog are not correct for a specific term, you can change them in the Schedule of Classes for that term.

**Note:** If an attribute is no longer correct for any foreseeable future terms, you must also change it in the Course Catalog. If the attribute is not changed in the Course Catalog, it will not print correctly in the Announcement. You can change it in the Course Catalog and then synchronize it in the Schedule of Classes, or you can change it in both places yourself.

✔ **To add attributes for a term:**

1. On the Basic Data page of the Schedule New Course page group, make sure that you are on the primary component of the course.

2. Scroll down to the Class Attributes area.

3. If the displayed attributes are not correct for the term you are scheduling, you may:
Chapter 5: Scheduling Classes

- Change the attribute by clicking the Lookup button next to the Course Attribute field, and selecting the correct attribute. You will then need to select the appropriate Course Attribute Value for the new attribute.

- Delete an attribute that no longer applies by clicking the Delete Row button to the right of the attribute to be deleted.

- Add a new attribute by either clicking the Add Row button and using the Lookup button to select a Course Attribute, or if there is already a blank row, by selecting a Course Attribute for that row. You will then need to select the appropriate Course Attribute Value for the new attribute.

### Entering a Description for the Offering

The course description from the Course Catalog is displayed on the Description page of the Schedule New Course page group. However, if that is not the description that you want to appear in the Course Offerings for this term, you can change the description in the Schedule of Classes.

**Note:** The Description contains only the general information about the course. Information on the sample reading list, grading, reading & writing assignments, prerequisites & restrictions, and other information are entered on other pages in this page group.

Every course has a web page where students can find information about the course, such as reading lists, email discussion areas, writing requirements, a course calendar, and so on. You can enter the URL of the Blackboard web page for the course, or your departmental web page for the course, on the Description page.

In the fields on the Description page, you can cut and paste text from another source, such as a Word document or a browser. You can specify text to be highlighted as bold or underscored by entering pairs of codes surrounding the text to be highlighted. You can also enter special characters by using character mapping. (See “Inserting Special Characters in Descriptions,” on page 294.)

**Note:** If you copy text from a web page, carriage returns may appear at the end of every line, so make sure you remove them here. If you copy text from a Word document, formatting will be lost, since PeopleSoft does not recognize Word’s formatting codes.
**Tip!** To prevent the inclusion of odd characters resulting from Word formatting codes, select the text to be copied in Word, press the Ctrl + Spacebar keys to remove the formatting, and then press the Ctrl + C keys to copy the text.

This page applies to the entire course, not to individual sections.

1. To change the description and add the course info URL:
   - In the Schedule New Course page group, click the Description tab to display the Description page.

   ![Figure 91: The Description Page for Schedule New Course](image)

   2. Change the description, as needed. This description will be printed in the Course Offerings publication. You can use the standard Windows text editing techniques to work in the Description field, including cut and paste, overtyping, the Home and End keys, the Insert key, and the Delete key. The Description is limited to 650 characters.

   To specify character formatting, you must enter a code before and after the text to be formatted:

   - For bold text use braces {}, for example: \{text\}
   - For underscored text use brackets [], for example: [text]
   - For bold, underscored text use all relevant pairs {{text}}
To enter special characters, such as â, é, ü, ß, etc., use the Unicode character mapping, described in “Inserting Special Characters in Descriptions,” on page 294.

To change text, highlight the text to be changed and then type over it. Be careful not to type over any formatting characters, unless you are removing both characters of the pair.

3. In the Course Web Address field, enter the URL for your departmental web page for the course, or the Blackboard web page for this course. For most courses, this will be blackboard.princeton.edu.

Tip! If you display the web page, you can copy the URL from the browser’s Location or Address field, and then paste it into this field using Windows cut and paste techniques.

Adding the Sample Reading List

The Sample Reading List page allows you to list up to six documents that will be on the course reading list, specifying the author and title of a book, or, if the material was published in a journal, the author, article title, and journal title. If the course has more titles than will fit on the page, or if the instructor does not wish to list all the reading materials in the Course Offerings, you can specify that students see the instructor for a complete list.

The Sample Reading List page has two columns where you can enter names. The first column, labeled Author/Article Title, is where you enter the parts of the reference that are not to be underlined in the Course Offerings. This may be just the author’s name, or may be the author’s name and article name. When entering these names, punctuate them just as you want the names to appear in the Course Offerings publication, except for the final comma, which the system will insert.

The second column is where you enter the title of a book or a journal. Anything entered in this column will be underlined in the Course Offerings write-up.

For example, for an article written by John Smith appearing in InterCom magazine, you would specify the following in the Author/Article Title field:

John Smith, “Reading to Learn”

In the Title/Journal Title field, you would specify the following:
Intercom, April 2000

The above entries would produce this in the Course Offerings:
John Smith, “Reading to Learn”, Intercom, April 2000.

✔ To enter the sample reading list:

1. In the Schedule New Course page group, click the Sample Reading tab.

2. Type the part of the reference that is not to be underlined—the author of a book, or the author and title of a journal article—in the Author/Article Title field, and press the Tab key. Make sure you punctuate as you want the reference to appear in the Course Offerings, except for the final comma, which will be inserted by the system.

3. Type the part of the reference that is to be underlined—the title of the book, or the title of the journal for a journal article—in the Title/Journal Title field.

4. Repeat Steps 2 & 3 for each document on the reading list.
5. If there are more documents than will fit on the Sample Reading page, or the instructor does not yet have his reading list, or does not want to include a full reading list in the Course Offerings publication, select (☑) the See instructor for complete list checkbox. This will print that instruction in the Course Offerings, after listing any documents entered on this page.

**Adding Additional Information**

The Additional Information page provides areas where you can enter information on reading and writing assignments for the course, prerequisites, restrictions, and any other information that you want to print in the Course Offerings.

You can enter up to 500 characters in each of the fields, and you can use Windows editing techniques. You can select existing text and type over it, use the Delete key to delete it, the Ctrl+X key to cut it, or the Ctrl+C key to copy it. You can also use the Ctrl+V key to paste text copied from another location, even from a Word document.

**Tip!** When copying formatted text from Word, select the text to be copied, press Ctrl + Spacebar to remove the formatting, and then press Ctrl + C to copy the text. This prevents the inclusion of odd characters resulting from Word formatting codes.

The information that you enter on the Additional Inf page applies to the course as a whole, not to individual components.

**☑ To add additional information for a course:**

1. In the Schedule New Course page group, click the Additional Inf tab.
To add reading and writing assignments, click in the Reading/Writing Assignments field, and type the text you want to appear in the Course Offerings (up to 490 characters including spaces). If you have entered this text elsewhere, you can cut and paste it into this field using standard Windows techniques.

To add prerequisites and restrictions to be listed in the Course Offerings for this course, click in the Prerequisites & Restrictions field, and type the text (up to 560 characters including spaces), as you want it to appear in the Course Offerings. If you have entered this text elsewhere, you can cut and paste it into this field using standard Windows techniques.

To add other information about the course to be shown in the Course Offerings, click in the Other Information field and type the text (up to 490 characters including spaces), as you want it to appear in the Course Offerings. If you have entered this text elsewhere, you can cut and paste it into this field using standard Windows techniques.
Setting the Grading Requirements

The Requirements/Grading page allows you to indicate how the grade for the course will be calculated. For each item used in the grading calculations, a percentage is entered here to show how much of the grade is based on that item. The total of the percentages entered must equal 100% or zero.

Some items are mutually exclusive, so when one is checked, the other(s) are dimmed. For example, if you select Midterm Exam, the Take Home Mid Term Exam and Paper in lieu of Midterm options are dimmed.

This page also displays the Final Exam field, which is used by the Registrar’s office to create the exam schedule.

Important! If you have not set the Final Exam field to Final, in both the Schedule of Classes and the Course Catalog, an exam time is not established and a room will not be scheduled for the final exam, regardless of any percentages entered in Final Exam percentage field.

To set the grading requirements:

1. In the Schedule New Course page group, click on the Requirements/Grading tab.
2. The **Final Exam** field is set based on the value in the Course Catalog. If it is not correct, select the correct value from the drop-down list:

- **Final**
  - There is a final exam, scheduled by the Registrar’s Office during the final exam period.
- **Other**
  - There is a term paper, lab report, or project in lieu of a final, or the final exam is scheduled on the last day of class, or there is no final.
- **Take-Home**
  - The final is a take-home exercise.

The **Final Exam** field is used to create the exam schedule and must have a value.

3. Enter a percentage for each item that will be used in the final grade calculation for this course. It is not necessary to enter a leading zero.

Percentages are not required; however, if they are entered, they must total 100%. Grading requirements are printed only if the total value is 100%.
Scheduling the Section Meetings

Every section of every component must be assigned a meeting pattern that indicates which days of the week the section meets and for how long, and a start time. The meeting end time will be calculated based on the length of the meeting specified in the meeting pattern. The meeting pattern and start time are specified for each section using the Meetings page of the Schedule New Course page group.

Most courses at Princeton use a standard meeting pattern that is already set with the days of the meetings and the length of each meeting. However, you are not limited to those standard meeting patterns. You can also set non-standard meeting patterns from the Meetings page.

Note: You will have to move through the Class Sections, adding the schedule information for each section. Make sure you are entering the correct schedule for the section identified in the Class Sections area of the page.

For the primary component, you can also change the Instructor. This field will be filled using the Instructor from the Catalog, but you can change the value, if necessary. You can also add an instructor for a non-primary component, if you know who will be teaching the section. However, instructors are not required for non-primary components.

Tip! The instructor entered here is used only for CAFSIS reports. The instructor name printed in the Course Offerings is set in the Course Catalog. All sections must have an instructor entered before the CAFSIS reports are generated.

To set the schedule using a standard meeting pattern:

1. In the Schedule New Course page group, click on the Meetings tab.
2. In the Meeting Pattern area, in the Pat field (Pattern field), use the Lookup button to display the list of meeting patterns. If the schedule will be announced later, type in TBA (To Be Announced).

**Tip!** If the schedule is **TBA To Be Announced** make sure the start and end times are both 1:00AM, and that no days are selected.
Notice that the days when the section meets are shown first, followed by the length of time, in minutes, of the section meeting.

3. Click on the desired meeting pattern or its description in the line.

4. When you are returned to the Meetings page, notice that the checkboxes under the days of the week will be selected (✓) to reflect the selected meeting pattern.

   **Note:** If the meeting pattern for the section is TBA, make sure that no checkboxes are selected for the days of the week.

5. In the *Mtg Start* field (Meeting Start field), enter the time when the section will start in the following format:

   \[ hh:mmXX \]

   where \( hh:mm \) is the time the section starts

   - \( hh \) can be a value from 1 to 12
   - \( mm \) can be a value from 00 to 59

   \( XX \) is either AM or PM.

   For example, a section starting at 1:30 in the afternoon would be entered as 1:30PM.

   **Note:** You should not schedule classes between 4:30 and 7:30 PM, to avoid conflicts with extracurricular activities and student dining.

   **Tip!** You can also enter the starting time in military notation, \( hh:mm \), where \( hh \) can be a value from 00 to 24, and \( mm \) can be a value from 00 to 59. If you enter the time in military notation, you will not have to enter the AM or PM, but the time will be translated to standard notation. For example, if you enter 13:30, the time will be shown as 1:30PM.
6. Press the Tab key or click to the Mtg End field, which will change automatically to provide the correct end time, based on the specified start time and the length of the section defined in the meeting pattern.

**Important!** Changes to the length of the meeting time for undergraduate classes are subject to approval by the Registrar. Do not change the Mtg End (Meeting End) time for a standard meeting pattern unless the Registrar has approved it. Likewise do not change the Start/End Date fields.

7. Use the Previous and Next buttons in the Class Section header to move to the next class section.

You can also click View All in the Class Section header to display all the sections of the class, as shown in Figure 98, on page 154.

---

**Figure 97: Navigation Controls in the Header Bar**
8. Repeat Step 2 through Step 7 until each section has been scheduled.

To set the schedule using a non-standard meeting pattern:

1. In the Schedule New Course page group, click on the Meetings tab.
2. Make sure you are on the section that requires a non-standard meeting pattern.
3. In the Mtg Start field, enter the time when the section will start in the following format:

\[ hh:mmXX \]

where \( hh:mm \) is the time the section starts

- \( hh \) can be a value from 1 to 12
- \( mm \) can be a value from 00 to 59

\( XX \) is either AM or PM.

For example, if the section will start at 1:30 in the afternoon, enter the value 1:30PM.

**Note:** You should not schedule classes between 4:30 and 7:30 PM, to avoid conflicts with extracurricular activities and student dining.

**Tip!** You can also enter the starting time in military notation, hhmm, where \( hh \) can be a value from 00 to 24, and \( mm \) can be a value from 00 to 59. If you enter the time in military notation, you will not have to enter the AM or PM, but the time will be translated to standard notation. For example, if you enter 13:30, the time will be shown as 1:30PM.

4. When you press the Tab button or click in the Mtg End field, the end time will be set to an hour later than the start time. If it is not correct, enter the time when the section will end in the Mtg End field.
5. Select (✔️) the checkboxes for the days of the week that the section will meet.

![Figure 100: Scheduling a Non-Standard Schedule](image)

6. Do not change the Start/End Date values, even if the course meets for less than a full term. Instead, be sure the Registrar’s Office knows the course’s start and end dates for scheduling purposes.

7. When the meeting pattern is correct, click the Save button.

To add or change the instructor:

1. On the Meetings page of the Schedule New Course page group, the instructors assigned to the primary component section are listed in the Instructors For Meeting Pattern section.

Note: The instructors listed here are used for CAFSIS, not for the Course Offerings. The instructor name printed in the Course Offerings is set in the Course Catalog. Grading approval is also authorized only to the Instructor(s) set in the Course Catalog.
2. To change the instructor for this term only, click the **Lookup** button to the right of the *ID* field in the Instructors for Meeting Pattern area.

**Tip!** To add an instructor for this section in this term, click the **Add Row** button before using the **Lookup** button.

3. On the Lookup ID page that is displayed, click the **Lookup** button to see the list of all active professional staff at the University, ordered by ID number. To filter the list, enter search criteria on the Lookup ID page before clicking on the **Lookup** button.

You can filter the list by your *Academic Organization*, or by *Last Name* or *First Name*. You can enter all or part of the organization’s or person’s name. The Search Results will display only the instructors who match your criteria, as shown in Figure 102.

**Note:** If you can find the instructor here but could not assign the instructor in the Course Catalog, contact the Course Offerings Administrator in the Office of the Registrar.
4. Select the desired instructor by clicking one of the links in the line that contains the instructor’s name.

5. The Access field will default to Approve for instructors entered in the Course Catalog, or to Grade for instructors entered here.

**Setting Enrollment Controls**

Enrollment controls are used to limit enrollment during the enrollment period, and to set the room size for classroom assignments. Real-time enrollment tallies are also displayed on the page.

There are three enrollment controls used at Princeton:

- **Class Status**—provides control over enrollment activities permitted for the section. The following are the valid statuses:

  - **Active**—the section is open for enrollment and is only status that permits enrollment. This is used for most sections.

  - **Cancelled Section**—The section has been cancelled. Only the Office of the Registrar is authorized to cancel courses or sections.

  **Tip!** You should change the status of any section you want to cancel to **Stop Further Enrollment** before contacting the Course Offerings Administrator in the Office of the Registrar:
Scheduling a New or Updated Course

- **Stop Further Enrollment**—The section will be closed, regardless of whether the enrollment capacity has been met and the system will no longer ‘see’ it. The section will no longer be visible to students so they will not be able to, for example, add, drop, or swap.

- **Tentative Section**—This status is automatically applied to all optional component sections (precepts, drills, ear training, and film), and blocks the display of these components in SCORE.

- **Enrollment Capacity**—provides a way to limit section sizes without requiring consent for each student to enroll. The system will accept only this number of student enrollments, on a first-come, first-served basis. A value of **999** in this field signifies unlimited enrollment.

- **Requested Room Capacity**—used with the Enrollment Capacity to determine classroom assignments. This field must contain a value equal to or greater than the Enrollment Capacity.

The other enrollment controls are not used at Princeton.

⚠️ **Tip!** During enrollment, you can use the Class Sections page to monitor enrollment, and to change the enrollment capacity and class status.

✅ **To set enrollment controls:**

1. In the Schedule New Course page group, display the Enrollment Control page by clicking on the Enrollment Cntrl tab.
2. Make sure you are on the correct Class Section before making any changes here. If necessary, use the navigation controls in the Enrollment Control header bar to move to the section you want to change.
3. Leave the default *Class Status* value (*Active* or *Tentative Section*), when you are scheduling the class.

4. In the *Requested Room Capacity* field, enter a value equal to or greater than the *Enrollment Capacity* field.

5. In the *Enrollment Capacity* field enter the maximum number of students to be accepted into the section. If you do not know how many students may enroll, or you do not want to limit the number of students, enter 999.

```
Important! The Enrollment Capacity must be greater than 0. If you want to limit enrollment, the Enrollment Capacity cannot be 999.
```

```
Note: The combined Enrollment Capacity of all the sections of a non-enrollment component type should be equal to the Enrollment Capacity of the primary, graded component section. For example, if the lecture has an Enrollment Capacity of 100, and there are five precepts, each precept should have an Enrollment Capacity of 20.
```

If a default capacity was set for the component in the Course Catalog, that value will be used in the *Enrollment Capacity* field by default.

```
Important! The Enrollment Capacity value will be used to enforce enrollment limits during online course selection. When the section enrollment reaches the number of students specified in this field, the section will be closed to further enrollment. If necessary during the enrollment period, you can increase or decrease the Enrollment Capacity as needed. However, to know when such changes are needed, you must monitor the enrollment totals for each section of each course on a daily basis during the enrollment period.
```

6. If the course has no reserve capacity to be set, you can save the record without continuing to the next page, Reserve Cap. Click the Save button to save the course in the schedule for this term.

```
Important! If this is a new course that has never been offered before, after you save the record and move on to another record, you can continue to make changes until you submit the course for approval. When you submit the course for approval, it changes to Pending status, and you will not be able to make any further changes until the course is approved.
```
Setting the Reserve Capacity

The Reserve Capacity is used to control enrollment using student groups. For example, if you want to make sure there will be seats available for freshmen in the fall, you can set a reserve capacity on the primary section for the requirement group, Freshmen Only. If necessary, you can set more than one reserve capacity, and you can also set the date when any unused seats will be released.

Setting Reserve Capacity Sequences

Reserve capacities are set in sequences, one for each requirement group for whom you want to reserve space. You can set as many reserve capacity sequences as you want, controlling up to, but not more than, the entire enrollment capacity.

For example, if a Physics seminar has an enrollment capacity of 50, you can reserve 20 seats for Physics concentrators, 5 for Electrical Engineering concentrators, 5 for Engineering and Computer Science concentrators, 10 for sophomores, and 10 for freshmen. That would reserve every seat in the section for one group or another.

If you don’t want to control every seat, you can reserve less than the total enrollment capacity. For example, for that same Physics seminar, you could reserve 20 seats for Physics concentrators, and 10 for freshmen, and leave the remaining 20 seats unreserved. If a member of a requirement group for which a reserve capacity has been set attempts to enroll after the enrollment total for that sequence has been reached, he or she will be able to enroll only if there are still non-reserved seats available.
Creating Reserve Capacity Sequences In Order

If a student enrolls who is a member of two requirement groups for which a reserve capacity has been set, the enrollment total will be incremented for the first sequence that applies. For this reason, you should create reserve capacity sequences in order, from most restrictive to least restrictive Requirement Group. See Step 5 (below) for a list of Requirement Groups in order—from most to least restrictive.

✔️ To set the reserve capacity:

1. In the Schedule New Course page group, display the Reserve Capacity page by clicking on the Reserve Cap tab.

   If the Reserve Cap tab is not displayed, click the right arrow at the end of the tab row to see the Reserve Cap tab.

2. Navigate to the primary component section, if necessary.

3. Leave the Reserve Capacity Sequence field as is. This value will be incremented by the system each time you add a row to create another sequence.
4. In the **Start Date** field, enter the date when the first enrollment appointments begin for the term you are scheduling. The Registrar’s Office will advise you what date to use.

5. In the **Requirement Group** field, use the **Lookup** button to find and select the group for whom you are reserving seats.

   **Tip!** If you will be using multiple requirement groups, start with the most restrictive requirement group as the first sequence, and move through less restrictive requirement groups in later sequences.

   In order of restrictiveness, the requirement groups are:

   **Most restrictive**
   - XXX Graduate Students Only
   - Open to XXX Concentrators Only
   - Graduate Students Only
   - Seniors Only
   - Juniors Only
   - Sophomores Only
   - Freshmen Only
   - Juniors and Seniors Only
   - Freshmen and Sophomores Only
   - Not Open to Freshmen

   **Least restrictive**

6. In the **Number of Seats Reserved** field, enter the number of seats you want reserved for this group.
Scheduling a New or Updated Course

- This value must be equal to or less than the Enrollment Capacity, set on the Enrollment Control page.
- If there are multiple sequences, the sum of the Number of Seats Reserved values must be equal to or less than the Enrollment Capacity.

7. If you need to add another sequence for a different requirement group, click the Add Row button located immediately under the Reserve Capacity Header. Then repeat Step 4 through Step 6.

![Figure 106: Adding Another Sequence For A Different Requirement Group](image)

8. When you have added all the requirement groups you need, click the Save button to save the course in the schedule for this term.

Setting the Reserve Capacity Release Date

Releasing reserved seats is not required, and in fact, is done infrequently. In the event that you need to release seats, you should set the release date when you set up the reserve capacity, being careful to:

- Set the release date only in sequence 1.
- Set the release date in the 2nd row of the Reserve Capacity Requirement Group.
- Use the release date as the start date in the 2nd row.
You can set separate dates by Requirement Group when reserving seats, but when you release reserved seats in one sequence (for one Requirement Group), you release them for all sequences. This means that you must not release seats too early, since releasing seats for any one group will also release seats reserved for groups such as incoming Freshmen. Since you can set only one release date, you must set it on the first sequence.

**Important!** If reserved seats are not filled by members of the requirement group, and you have not released the seats, the section will not be filled, and other students who want to enroll during the drop/add period may not be able to.

**Tip!** If you want to limit the section only to those who are in one of the reserved requirement groups, do not set a release date.

**To set the reserve capacity release date:**

1. In the Schedule New Course page group, display the Reserve Capacity page by clicking on the Reserve Cap tab.

   If the Reserve Cap tab is not displayed, click the right arrow  at the end of the tab row to see the Reserve Cap tab.

   **Figure 107: Tabbed Pages in the Schedule New Course Page Group**

   Click the arrow to see the Reserve Cap page if it is not in view.

2. Navigate to the primary component section, if necessary.

3. Click the Add Row  button in the Reserve Capacity Requirement Group area.
4. In the **Start Date** field of the new row, enter the date when you want to release the seats. Usually this is the beginning of the term, but you can release the seats earlier or later, if that is appropriate for your section.

5. In the **Requirement Group** field of the new row, enter the same value as in the previous row.

6. In the **Number of Seats Reserved** field, enter the value 0. This releases all reserve capacity sequences for this section as of the **Start Date** specified for this row.

7. Click the **Save** button to save the release date.
Adding and Deleting Sections in the Schedule

Tip! This procedure allows you to create additional sections during online enrollment, as existing sections fill up.

After you have copied a course from a prior term into the new term, you can set up the course schedule for the new term. Sometimes, a schedule will require no changes—all the same sections will be offered at the same times as the previous term. However, if the course in the new term requires more sections (or fewer sections), you can add and delete sections as needed, using the Schedule of Classes page group.

Important! Sections can be deleted only until the Course Offerings is published. After that, they must be cancelled by the Registrar’s Office.

Note: Subsections are not copied to the new term in the Prior Term Copy process.

For information on changing the meeting patterns and times for existing sections, see “Changing the Time and Day of an Offering,” on page 181. For information on changing descriptive information, see “Changing Descriptive Info in the Schedule,” on page 187.

You can add additional sections in the same time period or a different time period. It is important that you be aware of whether the new section is offered at the same time as an existing section or a different time, since the section number assigned to the section will differ, depending on the relative time of the offering.

Note: You cannot add sections for a component type that is not defined for the course in the Course Catalog.

The Schedule of Classes page group contains the same pages as the Schedule New Course page group. However, when you are only adding a new section to a course, you generally use only the following pages:

 Là The Basic Data page—where you add the new section, and specify the class section number, the component type, the class type, and, if necessary, student-specific permission.
Adding and Deleting Sections in the Schedule

- The Meetings page—where you specify the meeting pattern and times, and the instructor that will be shown in the CAFSIS reports. The instructor shown in the Course Offerings comes from the Course Catalog entry, and is also the instructor with grading approval authorization.

  **Note:** Because the Course Catalog Instructor entry controls the grading authorization, you must enter at least one instructor in the Course Catalog.

- The Enrollment Control page—where you specify the enrollment capacity and room capacity for the section. Keep in mind that both capacity values are used for classroom assignment, and the enrollment capacity is enforced by the system during online course selection.

  If you are adding sections of the primary component, you may also need:

  - The Reserve Capacity page—where you can set reserve sequences to control the composition of the section.

  - The Attributes area of the Basic Data page—where you can set course Attributes such as Term Offered, Application/Interview, if they have not already been set in the Course Catalog.

  When you are working on updating the Schedule of Classes, you can use the Next in List and Previous in List buttons at the bottom of the page to work through all of your scheduled classes without returning to the search list to find the next class.

**Accessing the Schedule of Classes Page Group**

All changes to class sections for a single term are made in the Schedule of Classes page group.

**Note:** New or updated courses are scheduled with all the appropriate sections in the Schedule New Course page group. This looks just like the Schedule of Classes page group, but is populated from the Course Catalog rather than a previous entry in the Schedule of Classes. Once a new class has been saved, any further updates are made in the Schedule of Classes.
To access the Schedule of Classes page group:

1. Navigate to Manage Student Records > Establish Courses > Use > Schedule of Classes. The Find an Existing Value page is displayed.

2. In the Term field, use the Lookup button to select the code for the new term that you are scheduling, or type the code, if you know it.

3. If you want to restrict the search results to the courses that are in progress, select In Progress from the drop-down list in the Course Approved field.

The Search Results displays only new courses and those courses that have been copied (rolled) into the selected term. Security restrictions limit the list to the courses in your department.
Adding and Deleting Sections in the Schedule

Adding a New Class Section

When you add a new section, it is recommended that you be at the end of the current group of sections for the component type. You can navigate through the sections on the Basic Data page until you find the component for which you are adding a section.

To add a new section:

1. If you are not already in the Schedule of Classes page group, access the Schedule of Classes page group, as described in “Accessing the Schedule of Classes Page Group,” on page 169.

If you are already in the Schedule of Classes page group, click the Basic Data tab to display the Basic Data page. The Basic Data page shows the class sections and components.

If you are not on the course that needs an additional section, use the Next in List and Previous in List buttons to move through the search list until you find the correct course.

Figure 110: Schedule of Classes Search Results

4. Click on the course to display the Schedule of Classes page group for that course. The Basic Data page will be displayed, with the information that is currently in the Schedule of Classes for the course.
2. If you are not on the last section of the component group, use the Previous and Next buttons to move through the sections until you locate the last section of the component type that you want to add a section to. Notice that they appear in alphabetical and numeric order by Class Section.

![Figure 111: Adding Sections on the Basic Data Page](image)

3. Click the Add Row button to add a row for the new section. The page will look like Figure 112.
4. In the **Component** field, type the 3-character code for the component type, or use **Lookup** button to select it.

5. In the **Class Section** field, enter the new section number using these guidelines:

   - If the section is meeting at a different time or day, use the next sequential number within the component type.
   - If the section (subsection) is meeting at the same time as an existing section, use the current number but with the next sequential letter within the time period.
Use this format for the section number:

1\textsuperscript{st} character A letter indicating the component type of the section:

- B Lab
- C Class
- D Drill
- E Ear Training
- F Film
- L Lecture
- P Precept
- S Seminar
- U Studio

2\textsuperscript{nd} and 3\textsuperscript{rd} characters A sequential number within the component type, starting with 01. There will be a new number for each section of the component that meets at a different time period.

4\textsuperscript{th} character If this is the only section or the first section of the component type meeting at this time, this character is blank. If there are multiple sections meeting at the same time, each section after the first subsection contains a letter in this position, starting with A.

For example, if there are 6 lab sections, three of which meet at 1:30 on Wednesday, and three of which meet at 7:30 on Wednesday, the sections would be numbered B01, B01A, B01B, B02, B02A, and B02B.

6. The \textit{Class Type} field is set to \textbf{Enrollment} if the new section is a section of the primary component, and \textbf{Non-Enroll} if the section is a new section of a non-primary component. Do not change this value.

7. The \textit{Associated Class} field is set to a value of 1 if the section is a new section of the primary component, and a value of 999 for all other sections. Do not change this value.
8. If the course requires an application or interview (has an attribute of APPL), select the Student-Specific Permissions checkbox. This will restrict students from enrolling in the course unless they have been granted permission. (See “Assigning Student-Specific Permissions,” on page 273, for information on granting permissions.)

Note: To list the course in the Course Offerings as requiring an application or interview, the Student-Specific Permissions checkbox must be selected and the Course Attribute (in the Class Attributes area of the Basic Data page) must be set to APPL for sections of the primary component.

The remaining values can be left as they appear by default.

To specify the meeting pattern and time:

1. Click on the Meetings tab to display the Meetings page, which will appear as shown in Figure 113.

![Figure 113: Setting the Meeting Pattern and Time for a New Section](image)

2. In the Pat field, click the Lookup button to display the list of available meeting patterns. If the pattern you need is available, click on any of the links on the line. If the pattern is not available, click the Cancel button on the Lookup Pat page, and then follow the instructions in “Changing to a Non-Standard Meeting Pattern,” on page 185.
If the schedule for the new section will be announced later, select **TBA** (To Be Announced) as the meeting pattern, and make sure the start and end times are **1:00AM** to **1:00AM**.

**Important!** If the meeting pattern is **TBA**, the Mtg Start time and Mtg End time **must be 1:00AM**, and no days should be selected.

3. Enter the time when the section will start in the **Mtg Start** field, in the following format:

   \[ hh:mmXX \]

   where \( hh:mm \) is the time the section starts

   \( hh \) can be a value from 1 to 12

   \( mm \) can be a value from 00 to 59

   \( XX \) is either **AM** or **PM**.

For example, if the section will start at 1:30 in the afternoon, enter the value **1:30PM**.

**Tip!** You can also enter the starting time in military notation, \( hhmm \), where \( hh \) can be a value from 00 to 24, and \( mm \) can be a value from 00 to 59. If you enter the time in military notation, you will not have to enter the **AM** or **PM**, but the time will be translated to standard notation. For example, if you enter **13:30**, the time will be shown as **1:30PM**.

4. Press the Tab key or click on to the **Mtg End** field, which changes automatically to the correct end time, based on the specified start time, and the length of the section that was defined in the meeting pattern.

5. Continue with the next procedure to set the enrollment and room capacity.
To set the enrollment controls:

1. Click on the Enrollment Cntrl tab to display the Enrollment Controls page.

![Princeton University Enrollment Controls](image)

Figure 114: Setting Enrollment Controls for a New Section

2. Leave the default value in the *Class Status* field. The value will be

- **Active** for sections of non-optional components. Students can enroll only in those sections with an Active status.

- **Tentative Section** for sections of optional components. Enrollment in these sections will be done using BlackBoard.
3. The values for the Requested Room Capacity and Enrollment Capacity are populated based on the default value set in the Course Catalog. If the values are not correct for the new section, type the correct number over the incorrect number, making sure the Requested Room Capacity value is greater than or equal to the Enrollment Capacity value.

**Important!** The Enrollment Capacity value is used to enforce enrollment limits during online course selection. When the section enrollment reaches the number of students specified in the Enrollment Capacity field, the section will be closed to further enrollment. During the enrollment period, you can increase or decrease the Enrollment Capacity as needed. However, to know when such changes are needed, you must monitor the enrollment totals for each section of each course on a daily basis during the enrollment period.

**Tip!** You can use the Class Sections page to monitor enrollment totals, and to adjust the enrollment capacity, if needed.

**Note:** Although students will not be enrolling in tentative sections (optional components) through SCORE, you must still set the Requested Room Capacity and Enrollment Capacity to control enrollment totals in BlackBoard, and for classroom assignment.

The Requested Room Capacity value is sent to the Resource25 system for facility assignment. The Enrollment Capacity for tentative sections is sent to Blackboard, where students will be assigned to precepts, ear training, drills, and films.

4. Click the Save button to save the new section. If there are more changes for this course, select the next page where you need to make changes. To continue with the next course in the search list, click the Next in List button.
Deleting a Section

If a section that was offered last term will not be needed this term you can delete it using the Schedule of Classes page group. Before you delete a section though, you need to make sure you have selected the correct section. Information that identifies sections can be found on two pages in the page group:

- The Basic Data page identifies the section by section number, and indicates whether it is a primary component.
- The Meetings page indicates the scheduled meeting times of the section.

To be sure you are deleting the correct section, look at both of these pages.

**Important!** Sections can be deleted only until the Course Offerings is published. After that, they must be cancelled by the Office of the Registrar. See “To cancel a course or section:,” on page 210, for more information.

**To delete a section from a course schedule:**

1. If you are not already in the Schedule of Classes page group, access the page group as described in “Accessing the Schedule of Classes Page Group,” on page 169.

2. When the Basic Data page is displayed, click the Meetings tab to display the Meetings page, as shown in Figure 115.

3. Use the Class Sections header bar to navigate through the sections, checking the Class Section field and Meeting Pattern area until you find the section you want to delete.

**Important!** Never delete the primary section, unless it is the only component, and you are deleting the course from the schedule.
4. When the desired section is displayed, click the Basic Data tab to display the Class Section area.

5. Click the **Delete Row** button to delete the section.

6. Click the **Save** button to save the change. If there are more changes for this class, click on the tab of the next page where you need to make changes. To continue with the next class in the search list, click the **Next in List** button.
Changing the Time and Day of an Offering

After you have copied a course from a prior term into the new term, you can set up the schedule for this term. Sometimes, the schedule will require no changes—all the same sections will be offered at the same times as the last term. However, if a course section will be offered on different days or at a different time in the new term, change the schedule using the Meetings page of the Schedule of Classes page group.

For each component and section, you can select the standard meeting pattern that reflects the days of the week when the section meets. You specify a starting time for the section but the system will provide an ending time, based on the class length defined in the meeting pattern. If none of the standard meeting patterns will work for the section, you can enter a different, non-standard, meeting pattern in the Meeting Pattern area (see “Changing to a Non-Standard Meeting Pattern,” on page 185).

In addition to changing the meeting pattern and time for existing sections, you can add a new section if needed by returning to the Basic Data page and inserting a new row. For more information, see “Adding and Deleting Sections in the Schedule,” on page 168.

Changing a Standard Meeting Pattern

Every section of every component must be assigned a meeting pattern, and start and end times. These values are included for each copied section, but you may need to make some changes. Changes to the schedule might be as simple as changing the start time or selecting a new meeting pattern from the standard meeting patterns, or they could be as complex as entering a non-standard meeting pattern or time.

To select a standard meeting pattern:

1. If you are not already displaying the class that needs a new meeting pattern, access the Schedule of Classes page group, as described in “Accessing the Schedule of Classes Page Group,” on page 169. This will display the Basic Data page.

   If you are already in the Schedule of Classes page group, display the Meetings page by clicking on the Meetings tab.
Chapter 5: Scheduling Classes

2. Verify that you are in the right component and section by checking the Class Section and Component values in the Class Sections area of the page. If you are not in the right section use the Previous and Next buttons to in the Class Sections header bar to navigate through the sections, until you find the one you want.

You can go to a particular class section without having to move through all the other sections by clicking **Find** in the Class Section header bar. In the Find/Explore User Prompt that is displayed, type the alphanumeric code of the class section you want (for example, C02), and click the OK button.

![Find/Explore User Prompt](image)

3. In the Meeting Pattern section, in the *Pat* field (Pattern field), use the **Lookup** button to display the list of meeting patterns.
4. Click on the desired meeting pattern. If the schedule is not yet known, select **TBA** (To Be Announced) as the meeting pattern.

**Important! If you change a meeting pattern to TBA, you must change the Mtg Start time to 1:00AM and the Mtg End time to 1:00AM.**

5. When you are returned to the Meetings page, press the Tab key to move to the next field. Notice that the checkboxes under the days of the week will be selected (✓) to reflect the chosen meeting pattern.

Figure 119: Standard Meeting Patterns
6. Enter the correct starting time for the section in the Mtg Start field, in the following format:

$$hh:mmXX$$

where $$hh:mm$$ is the time the section starts

- $$hh$$ can be a value from 1 to 12
- $$mm$$ can be a value from 00 to 59

$$XX$$ is either AM or PM.

**Important! If you change a meeting pattern to TBA, you must change the Mtg Start time to 1:00AM and the Mtg End time to 1:00AM. This provides a signal to the students selecting the section on the Web that the real times have not been scheduled yet.**

For example, if the section will start at 1:30 in the afternoon, enter the value 1:30PM.

**Tip!** You can also enter the starting time in military notation, $$hh:mm$$, where $$hh$$ can be a value from 00 to 24, and $$mm$$ can be a value from 00 to 59. If you enter the time in military notation, you will not have to enter the AM or PM, but the time will be translated to standard notation. For example, if you enter 13:30, the time will be shown as 1:30PM.
7. Press the Tab key or click on the Mtg End field, which changes automatically to provide the correct end time, based on the specified start time and the length of the section as defined in the meeting pattern.

8. If this is the only change required for this class, click the Save button. If there are more changes for this class, click the tab of the page where you need to make a change.

Changing to a Non-Standard Meeting Pattern

Although Princeton has established a variety of meeting patterns, it is possible that you might have to schedule a section that meets in a non-standard pattern. The length of the meetings might be longer than usual, or the combination of days might differ from the standard offerings. You can enter a non-standard meeting pattern in the Meeting Pattern area on the Meetings page of the Schedule of Classes page group.

To change to a non-standard meeting pattern:

1. If you are not already displaying the class that needs a non-standard meeting pattern, access the Schedule of Classes page group, as described in “Accessing the Schedule of Classes Page Group,” on page 169. This will display the Basic Data page.

2. Click the Meetings tab to display the Meeting page, and verify that you are in the right component and section by checking the Class Section and Component values in the Class Section area of the page. If you are not in the right section use the Previous and Next buttons in the Class Sections header bar to move through the sections, until you find the one you want.
Chapter 5: Scheduling Classes

Figure 121: Class Sections Area of the Meetings Page

3. Since the value in the *Pat* (Pattern) field is no longer correct, highlight the value, and press the **Delete** key to remove it.

Figure 122: A Non-Standard Meeting Pattern

4. If the meeting time is not correct, change the *Mtg Start* and *Mtg End* times by typing the correct values over the existing values.

5. Select the checkboxes for the days of the week that the section will meet.

6. If this is the only change required for this class, click the **Save** button. If there are more changes for this class, click the tab of the page where you need to make a change.
Changing Descriptive Info in the Schedule

Once an approved course has been scheduled, you can change the class information, as needed, based on the worksheets completed by the faculty members. Changes to descriptive information include the following:

- Selecting a different topic for a topics course
- Changing the class description
- Changing, adding, or deleting entries in the sample reading list
- Changing the reading/writing assignments
- Changing the information on prerequisites and restrictions
- Changing the grading requirements

For approved new courses that have never been offered, the following changes must be approved by the Dean of the College or the Graduate School.

Table 8: Changes for New Courses

<table>
<thead>
<tr>
<th>Type of Course</th>
<th>Change that Requires Approval</th>
<th>On Schedule of Classes Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>Undergraduate</td>
<td>Description</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Reading/Writing Assignments</td>
<td>Description</td>
</tr>
<tr>
<td></td>
<td>Prerequisites and Restrictions</td>
<td>Additional Information</td>
</tr>
<tr>
<td></td>
<td>Other Information</td>
<td>Additional Information</td>
</tr>
<tr>
<td></td>
<td>Requirements and Grading</td>
<td>Additional Information</td>
</tr>
<tr>
<td>Graduate</td>
<td>Reading/Writing Assignments</td>
<td>Additional Information</td>
</tr>
<tr>
<td></td>
<td>Prerequisites and Restrictions</td>
<td></td>
</tr>
</tbody>
</table>

All of these modifications are made in the Schedule of Classes page group, and apply only to the course in the new term, not to any prior terms. However, you must be sure that you are working on the primary component, since all of these changes affect either the course as a whole, or the primary component.

Note: Changes in the Schedule of Classes that require approval alter the Course Approval status in the Course Catalog, changing it to In Progress. You must then submit the course for approval from the Course Catalog page group.
In Schedule of Classes page group you can also change the schedule and add sections, and modify the enrollment controls. These functions are explained in:

- “Changing the Time and Day of an Offering,” on page 181
- “Adding and Deleting Sections in the Schedule,” on page 168
- “Changing Enrollment Controls,” on page 207
- “Changing Reserve Capacity,” on page 218

**Locating the Primary Component Section**

Descriptive information about the course as a whole is usually entered on pages that do not indicate a section number. However, some information that pertains to the course as a whole is entered for the primary component. Therefore, you need to be sure you have selected the primary component before you continue to the pages where you will make the changes. To locate the primary component, use the Basic Data page of the Schedule of Classes page group.

The Basic Data page in the Schedule of Classes page group shows identifying information about each component section to be offered, such as the section number and component type.

You can locate the primary component in either of two ways—**View 1** and **View All**.

**View 1.** The default display mode is **View 1** which shows the Class Sections one-at-a-time. In the Course Component header bar, use the navigation controls to move through the sections until you find the component that you want.

**View All.** In the Course Components header bar, click the **View All** link in the Course Component header bar to view all the rows at once. Then scroll down the page until you find the component that you want.

You can go to a particular class section without having to move through all the other sections by clicking **Find** in the Class Section header bar. In the Find/Explore User Prompt that is displayed, type the alphanumeric code of the section you want, (for example, L01), and click the OK button.
To locate the primary component section:

1. Access the Schedule of Classes page group as described in “Accessing the Schedule of Classes Page Group,” on page 169. The Basic Data page will be displayed.

   The Basic Data page shows the course sections and components. If there is more than one section, the navigation controls in the Class Sections header bar are enabled. As you navigate through the sections, you will notice that they appear in alphabetical and numeric order by Class Section.

2. Locate the section that needs to be changed by moving through the sections using the header bar navigation controls—the Next and Previous buttons. The primary component usually will be a lecture, seminar, or class, and will be the only section listed with a Class Type of Enrollment, and an Associated Class value of 1.
You can go to a particular class section without having to move through all the other sections by clicking **Find** in the Class Section header bar. In the Find/Explore User Prompt that is displayed, type the alphanumeric code of the section you want, (for example, L01), and click the **OK** button.

![Find/Explore Prompt](image)

**Figure 125: Find/Explore Prompt**

### Selecting a Different Topic

If the course that was copied from the prior term focused on a different topic than the course that will be offered in the new term, you need to change the topic for the new term. You will be able to select from the list of topics that were defined for this course in the Course Catalog.

**Note:** If the topic is not in the defined list of topics, it will have to be added to the list in the Course Catalog, and approved by the Dean’s Office.

**To change the course topic for the new term:**

1. Access the Schedule of Classes page group, as described in “Accessing the Schedule of Classes Page Group,” on page 169. This will display the Basic Data page.

2. Verify that you are in the primary component (Lecture, Seminar, or Class) by checking the **Component** and **Class Type** values in the Class Section area of the page. Use the **Previous** and **Next** buttons in the Class Sections header bar to navigate through the sections, until you find the one you want.
3. Scroll down to the Class Topic section. In the Course Topic ID field, use the Lookup button to select a new topic from the Search Results (see Figure 127).

Verify that you are in the primary component—usually a Lecture, Class, or Seminar.

Verify that the Class Type is Enrollment.

Use the Lookup button to select a new topic.
Chapter 5: Scheduling Classes

4. If this is the only change required for this class, click the Save button. If there are more changes for this class, click the tab of the page where you need to make a change.

Changing the Class Description

If the description of the class has changed since the prior term, you can change the description to be printed this term in the Course Offerings on the Description page. You can also change the URL for the course Web page on the Description page.

In these fields, you can cut and paste text from another source, such as a Word document or a browser location field. You can specify text to be highlighted as bold or underscored by entering pairs of codes surrounding the text to be highlighted. You can also enter special characters by using character mapping. (See “Inserting Special Characters in Descriptions,” on page 294.)

**Note:** If you copy text from a web page, carriage returns may appear at the end of every line; make sure you remove them here. If you copy text from a Word document, formatting will be lost, since PeopleSoft does not recognize Word’s formatting codes.

**Tip!** To prevent the inclusion of odd characters resulting from Word formatting codes, select the text to be copied in Word, press the Ctrl + Spacebar keys to remove the formatting, and then press the Ctrl + C keys to copy the text.

Each course has a Blackboard web page or departmental web site, where students can find information about the course, such as reading lists, email discussion areas, writing requirements, images of enrolled students, a course calendar, and so on. If the web page URL has changed since the last time this course was offered, you will have to change the Course Web Address on the Description page.

**Tip!** The Registrar’s web site will have links to web sites entered in the Course Web Address field in the Schedule of Classes.

**To change the basic class description or course Web address:**

1. Access the Schedule of Classes page group, as described in “Accessing the Schedule of Classes Page Group,” on page 169. This will display the Basic Data page.
2. Click the Description tab to display the Description page.

3. Change the class description as needed. This description will be printed in the *Course Offerings* publication. You can use the standard Windows text editing techniques to work in the Description field, including cut and paste, overtyping, the Home and End keys, the Insert key, and the Delete key. The Description is limited to 650 characters (including spaces).

   To specify character formatting, you must enter a code before and after the text to be formatted:

   - For **bold text** use braces `{}`, for example: `{text}`
   - For **underscored text** use brackets `[]`, for example: `[text]`
   - For **bold, underscored text** use all relevant pairs `{{text}}`

   To enter special characters, such as â, é, ü, ß, etc., use the Unicode character mapping, described in “Inserting Special Characters in Descriptions,” on page 294.

   **Important!** If this is an approved new course that has never been offered, changing the Description will change the approval status of the course to **In Progress**, and you must submit the course for approval from the Course Catalog page group.

4. Enter or change the **Course Web Address** by typing over the value in the field, as needed. Again, you can use the standard Windows text editing techniques in this field. This means you can copy the URL from a browser and paste it into this field using the Ctrl+V key.

   **Tip!** Most courses have a web page accessible from the Blackboard site, [http://blackboard.princeton.edu](http://blackboard.princeton.edu). However, an instructor can use another site, if desired. The web site entered here will be linked from the Registrar’s web site.
Chapter 5: Scheduling Classes

5. If this is the only change required for this class, click the Save button to save the change. If you need to make more changes for this class, click on the tab for the next page where you need to make changes. To continue with the next class in the search list, click the Next in List button.

6. If this is an approved new course, and you have changed the Description, you must submit the course for approval (see “Submitting a Course,” on page 105 for instructions).
Changing the Attributes

Attributes provide information to be printed in the Announcement or Course Offerings publications. They include the following:

**Enforced by the System:**

- **APPL**
  - By application/interview only (printed in Course Offerings). The student must apply for permission to take the course, or an interview may be required.

  *Important! If APPL is specified here, you must also check the Student Specific Permission checkbox on the Basic Data page.*

- **CONR**
  - Required for concentrators (printed in Course Offerings). Students who are concentrating in this subject area must take this course.

- **OFFR**
  - Term offered (printed in Announcement). Indicates whether the course is offered in the Fall, the Spring, or both terms, or not offered this year. Attribute values for this attribute are **BOTH, FALL, SPRING, or NOTTYR** (Not offered this year).

Unlike course Requirement Group or Reserve Capacity, the **CONR** and **OFFR** attributes are not enforced by the system. They are for informational purposes only.

Attributes are set in the Course Catalog and are carried over into the Schedule of Classes for the term if the course scheduled is new, or carried over from a prior term if the course has been copied. If the attributes set in the Course Catalog are not correct for a specific term, you can change them in that term’s Schedule of Classes.

**Note:** If an attribute is no longer correct for any foreseeable future terms, you must also change it in the Course Catalog so it will appear correctly in the Announcement. You can change it in the Course Catalog and then synchronize it in the Schedule of Classes, or you can change it in both places yourself.
To change attributes for a term:

1. Access the Schedule of Classes page group, as described in “Accessing the Schedule of Classes Page Group,” on page 169. This will display the Basic Data page.

2. Scroll down to the Class Attributes area.

   Notice, in Figure 129, that if attributes were defined for the course in the Course Catalog or in the prior term, they will appear on this page.

3. If the displayed attributes are not correct for the term you are scheduling:

   - Change the attribute by using the Lookup button to select the correct attribute. You will then need to select the appropriate Course Attribute Value for the new attribute.
   - Delete an attribute that no longer applies by clicking the Delete Row button.
   - Add a new attribute either by clicking the Add Row button and using the Lookup button to select a Course Attribute, or if there is already a blank row, select a Course Attribute in that row using the Lookup button. You will then need to select the appropriate Course Attribute Value for the new attribute.
Changing the Sample Reading List

If the sample reading list has changed since the last time this course was offered, you can make the necessary changes on the Sample Reading List page.

The Sample Reading List page has two columns where you can enter names.

- The first column, labeled Author/Article Title, is where you enter the parts of the reference that are not to be underlined in the Course Offerings. This may be just the author’s name, or may be the author’s name and article name. When entering these names, punctuate just as you want the names to appear in the Course Offerings publication, except for the final comma in this field, which will be entered automatically by the system.

- The second column is where you enter the title of a book or a journal. Anything entered in this column will be underlined in the Course Offerings.

For example, for an article written by John Smith appearing in InterCom magazine, you would specify the following in the Author/Article Title field:

**John Smith, “Reading to Learn”**

In the Title/Journal Title field, you would specify the following:

**Intercom, April 2000**

The above entries would produce the following in the Course Offerings:

John Smith, “Reading to Learn”, *Intercom, April 2000*.

✔ To change the reading list:

1. Access the Schedule of Classes page group, as described in “Accessing the Schedule of Classes Page Group,” on page 169.

2. Click the Sample Reading tab to display the Sample Reading page.
3. To add a document to the reading list:
   a) Locate the first empty row.
   b) Type the part of the reference that is not to be underlined (the author of a book, or the author and title of a journal article) in the Author/Article Title field, and press the Tab key. Make sure you punctuate as you want the reference to appear in the Course Offerings, with the exception of the final comma, which will be entered by the system.
   c) Type the part of the reference that is to be underlined (the title of the book, or the title of the journal for a journal article) in the Title/Journal Title field.

4. To delete a reference, highlight the text and press the Delete key. If you delete a reference, copy and paste entries from later rows over the row you deleted.

5. To change a reference, highlight the text to be changed and type the changes directly over the highlighted text. If you are adding text, but not changing any existing text, position the cursor at the point where you want to add characters, and type the characters you want to add.
6. If the checkbox next to *See instructor for complete list* is selected (✔), the instruction “See instructor for complete list” will be printed in the *Course Offerings*. If you do not want this instruction to print, deselect (□) the checkbox.

7. If this is the only change required for this class, click the **Save** button. To continue with the next class in the search list, click the **Next in List** button. If there are more changes for this class, click on the tab for the page where you need to make changes.

### Changing Additional Information

The Additional Information page provides areas where you can enter information on reading and writing assignments, prerequisites and restrictions, and any other information that you want to print in the *Course Offerings* for the course.

**Important!** If this is an approved new course that has never been offered, changing Prerequisites and Restrictions or Reading/Writing Assignments will change the approval status of the course to *In Progress*. If this is an approved new undergraduate course that has never been offered, changing Other Information will also change the approval status of the course to *In Progress*. You must submit the course for approval from the Course Catalog page group.

You can enter text using Windows editing techniques, such as cut & paste. You can also select existing text and type over it; delete it using the *Delete* key; or cut and paste it using the Ctrl+X key to cut, or the Ctrl+C key to copy text, and the Ctrl+V key to paste. You can paste text copied from another location, even from a Word document.

**Tip!** When copying formatted text from Word, select the text to be copied, press Ctrl + Spacebar to remove the formatting, and then press Ctrl + C to copy the text. This prevents the inclusion of odd characters resulting from Word formatting codes.

**✓ To add or change additional information:**

1. Access the Schedule of Classes page group, as described in “Accessing the Schedule of Classes Page Group,” on page 169. This will display the Basic Data page.
2. Click on the Additional Information tab to display the Additional Information page.

![Figure 131: The Additional Information Page in the Schedule of Classes Page Group](image)

3. To add or change reading or writing assignments, make your changes in the Reading/Writing Assignments field, using standard Windows editing techniques. The Reading/Writing Assignments can be up to 490 characters long (including spaces).

4. To add or change the prerequisites and restrictions defined in the Course Offerings for this course, make your changes in the Prerequisites & Restrictions field. The Prerequisites & Restrictions can be up to 560 characters long (including spaces).

5. If you want to add or change the other information for the course in the Course Offerings, make your changes in the Other Information field. The Other Information can be up to 490 characters long (including spaces).
6. If this is the only change required for this class, click the **Save** button.

**Note:** If this is an approved new course, and you have changed the Reading/Writing Assignments or the Prerequisites & Restrictions field, or if this is an approved new undergraduate course and you have changed the Other Information field, you must remember to submit the course for approval from the Course Catalog page group.

7. To continue with the next class in the search list, click the **Next in List** button. If there are more changes for this class, click the tab for the page where you need to make changes.

### Changing Grading Requirements

**Tip!** This applies to the entire course, not just one section.

The Requirements/Grading page allows you to indicate how the grade for the course is calculated. For each item that is used in the grading calculations for this course, a percentage is entered here to show how much of the grade is based on that item. The total of the percentages entered must equal 100%, or zero.

Some items are mutually exclusive, so if one field has a value, the other(s) are disabled. For example, if you enter a value in the Midterm Exam field, the Take Home Mid Term Exam and Paper in lieu of Midterm options are disabled. The Registrar's Office uses the value in the Final Exam drop-down list to create the final exam schedule.

**Important!** If the course is an approved, new, undergraduate course that has never been offered, changing the grading requirements will change the approval status of the course to In Progress. You must submit the course for approval from the Course Catalog page group.

**To change grading requirements:**

1. Access the Schedule of Classes page group, as described in “Accessing the Schedule of Classes Page Group,” on page 169. This will display the Basic Data page.

2. Click on the Requirements/Grading tab to display the Requirements/Grading page.
3. If the Final Exam field is not correct, select the correct value from the drop-down list. This field is used to create the final exam schedule, so a value is required in this field. If you change this value, and percentages are entered on this page, you must change the percentages as needed to match the changed Final Exam value. For example, if you change the Final Exam from Take-Home to Final, you will need to delete the value in the Take Home Final Exam field, and change the Final Exam percentage to the desired percent.

**Important!** If the class does not have a value of Final in the Final Exam field, no exam time or room will be scheduled for a final exam for the class.

4. Enter a percentage for each option that will be used in the final grade calculation for this course. It is not necessary to enter a leading zero. Percentages are not required, however if they are entered, the total percentage must equal 100%.
5. If this is the only change required for this class, click the Save button.

**Note:** If this is an approved, new, undergraduate course, you must submit the course for approval from the Course Catalog page group.

6. To continue with the next class in the search list, click the Next in List button. If there are more changes for this class, click on the tab for the page where you need to make changes.

**Changing the Instructor for a Section**

When you copy (roll) a course from a prior term, all instructors will be copied for each section; when you schedule a new course, the instructor(s)-in-charge will be copied to the schedule for the primary component only.

**Note:** The instructor(s) copied from the Course Catalog are the only instructor(s) authorized to approve grades in PeopleSoft.

If a course has already been scheduled for a term, changes to the instructor in the Course Catalog are not synchronized with the Schedule of Classes. If the instructor in charge changes, or you need to add an instructor with the authority to approve grades, you will have to make the appropriate changes in both the Course Catalog and the Schedule of Classes. Then, to have the grading authority changed to **Approve**, you must contact the Course Offerings Administrator, who can reset the grading access in the Schedule of Classes.

**Note:** If this is an approved new course, or an existing graduate permanent or topics course, the **Course Approved** status will change to **In Progress** when you change the Course Catalog instructor, and you will have to submit the course for approval.

You can enter or change the instructors for each section of the course, using the Meetings page. This information is not printed in the **Course Offerings**, but it is used to produce the reports for CAFSIS at the end of the term, and will be used to report and record grades.
CAFSIS reports tabulate data for each section, taught by each different instructor. To make sure the CAFSIS reports are correct, instructors must be entered on this page for every section some time before the reports are run.

**Important!** If you are changing the instructor for a primary section, be sure to make the change in the Course Catalog as well as in the Schedule of Classes, since that is where the information for the Announcement and Course Offerings publications comes from.

If you can add an instructor in the Schedule of Classes that you could not add in the Course Catalog, contact the Course Offerings Administrator in the Office of the Registrar.

If necessary, you can enter more than one instructor for a section, by clicking on the **Add Row** button. If you need to remove an instructor, you can click the **Delete Row** button for that line.

**To change an instructor for a section:**

1. If you are not already displaying the class for which you want to change the Instructor, access the Schedule of Classes, as described in “Accessing the Schedule of Classes Page Group,” on page 169. This will display the Basic Data page.

2. Click the Meetings tab to display the Meeting page and locate the Instructors For Meeting Pattern area.

**Note:** The instructors listed here are used for CAFSIS, not for the Course Offerings. The instructor name printed in the Course Offerings is set in the Course Catalog. The instructor(s) set in the Course Catalog are also the only instructor(s) with authority to approve grades.
3. To change the instructor for this term only, click the **Lookup** button to the right of the *ID* field in the Instructors for Meeting Pattern area.

4. On the Lookup ID page that is displayed, click the **Lookup** button to see the list of all active professional staff at the University, ordered by ID number. To filter the list, enter search criteria on the Lookup ID page before clicking on the **Lookup** button.

You can filter the list by your Academic Organization, or by Last or First name. You can enter all or part of the organization’s or person’s name. The resulting Search Results will display only the instructors who match your criteria, as shown in Figure 134.
5. Select the desired instructor by clicking one of the links in the line that contains the instructor’s name. You are then returned to the Meeting page and the instructor’s Name and ID fields are filled in.

6. In the Instructor Role field, the value, Instructor, is displayed by default. Leave this value unchanged.

7. The Access field will default to Approve for instructors entered in the Course Catalog, or to Grade for instructors entered here.

8. Leave the Contact field blank, since Princeton does not use it.

9. To change the instructor for another section of this course, use the Previous $\text{Previous}$ and Next $\text{Next}$ buttons in the Class Sections header bar to navigate through the sections, until you find the one you want. Repeat Step 3 through Step 7.

10. If this is the only change required for this class, click the Save $\text{Save}$ button. If there are more changes for this class, click on the tab of the next page where you need to make changes. To continue with the next class in the search list, click the Next in List $\text{Next in List}$ button.
Changing Enrollment Controls

Enrollment controls are used to limit enrollments in the course during the enrollment period. This is especially important with self-serve enrollment on the Web, when students can enroll in courses online.

There are five enrollment controls used at Princeton:

- Class Status—provides direct control over enrollment activities permitted for the class section. For instructions on using the Enrollment Cntrl page to change the class status, see “Changing the Class Status,” on page 208.

- Enrollment Capacity—provides a way to limit the section size without requiring consent for each student to enroll. During online course selection, the system will accept only this number of student enrollments, on a first-come, first-served basis. A value of 999 in this field signifies unlimited enrollment.

The Requested Room Capacity, while not itself an enrollment control, is used with the Enrollment Capacity to determine classroom assignments. This field must contain a value equal to or greater than the Enrollment Capacity.

For information on changing the enrollment capacity and Requested Room Capacity on the Enrollment Cntrl page, see “Changing Enrollment and Room Capacity,” on page 211

- Reserve Capacity—provides a way to reserve seating for one or more specified groups of students. For more information on reserve capacity, see “Changing Reserve Capacity,” on page 218.

- Student-Specific Permissions—used with the attribute APPL, controls enrollment on a student-by-student basis. Students are required to apply or interview for acceptance into the course, and when accepted, are given specific permission to select the course online. For more information, see the following sections:
  - For more information about setting Student-Specific Permission, see “Adding a New Class Section,” on page 171.
  - For information about setting the Attribute, see “Changing the Attributes,” on page 195.
For information about assigning permissions to students, see “Assigning Student-Specific Permissions,” on page 273.

The Course Requirement Group—provides a way to limit enrollment to a specific group of students. Only students in the specified group will be able to enroll in the course during online enrollment. Course Requirement Groups are set in the Course Catalog. For information about setting a Requirement Group, see “Changing the Course Requirements,” on page 99.

You can also monitor the enrollment status for all the sections of a class, and if necessary, change the enrollment capacity and class status, on the Class Sections page.

**Changing the Class Status**

The class status is used to control the enrollment activities permitted for each class section. There are four possible class statuses:

**Active**
The section is open for enrollment, subject to enrollment capacity and other enrollment constraints associated with the section. This is the only status that permits enrollment through SCORE.

**Cancelled Section**
The section has been cancelled. Sections can be cancelled only by the Office of the Registrar. See “To cancel a course or section:,” on page 210 for instructions.

**Stop Further Enrollment**
The section will be closed to any additional enrollment, regardless of whether the specified capacity has been met. This status should only be used when requesting a cancellation.

**Tentative Section**
The section is a section of an optional component, and is not selected through SCORE during course enrollment.

Use the following procedure for all statuses except Cancelled Section. To cancel a section, see the procedure, “To cancel a course or section:,” on page 210.

**To set the class status:**

1. If you are not already in the Schedule of Classes page group, access the Schedule of Classes page group, as described in “Accessing the Schedule of Classes Page Group,” on page 169.
2. Click on the Enrollment Cntrl tab to display the Enrollment Control page (see Figure 135).

3. Make sure you are on the right section, using the navigation controls in the Enrollment header bar to move through the sections, before making any changes.

4. In the Class Status field, select either Active or Stop Further Enrollment from the drop-down list:

   **Active**
   
   The section is open for enrollment, subject to enrollment capacity and other enrollment constraints associated with the section. This is the only status that permits enrollment through SCORE.

   **Stop Further Enrollment**
   
   The section is closed to any additional enrollment, regardless of whether the specified capacity has been met. This status should only be used when requesting a cancellation.
Chapter 5: Scheduling Classes

**Cancelled Section**

Selecting **Cancelled Section** causes an error in the field. Only the Office of the Registrar can cancel sections. (See “To cancel a course or section;,” on page 210 for instructions.)

**Tentative Section**

The section is for an optional component, and is not selected through SCORE during course enrollment. Do **not** change this value.

5. If this is the only change required for this class, click the **Save** button. If there are more changes for this class, click on the tab of the next page where you need to make changes. To continue with the next class in the search list, click the **Next in List** button.

![Checkmark]

**To cancel a course or section:**

1. If you are not already in the Schedule of Classes page group, access the Schedule of Classes page group, as described in “Accessing the Schedule of Classes Page Group,” on page 169.

2. Click on the Enrollment Cntrl tab to display the Enrollment Control page (see Figure 135).

3. Make sure you are on the right section, using the navigation controls in the Enrollment header bar to move through the sections if necessary.

4. In the **Class Status** field, select **Stop Further Enrollment**. This will prevent any additional students from enrolling in the section before it can be cancelled.

5. If there are students enrolled in the section, print a class roster.

```
**Note:** The class roster is deleted when the class is cancelled, so you will not be able to print a class roster after the class is cancelled.
```

6. Send an e-mail to notify the Course Offerings Administrator and the Classroom Assignments Administrator in the Office of the Registrar that you want to cancel the section/course. Specify the class that must be cancelled:

- If specific sections must be cancelled, list each section that must be cancelled.
- If the entire course must be cancelled, indicate the entire course.
Changing Enrollment and Room Capacity

The Enrollment Capacity field defines how many students can be enrolled in the section on a first-come, first-served basis, and is enforced during online course selection. If you do not want the system to enforce an enrollment capacity, or you are not sure what enrollment capacity you want, enter a value of 999 in this field.

Note: While a value of 999 is valid during the pre-registration period, it will have to be changed to an actual enrollment capacity when the time comes to request classroom assignments.

The Requested Room Capacity field should contain a value equal to or greater than the Enrollment Capacity. This field is used to determine the size of the room that must be scheduled for the section.

To change enrollment and room capacities:

1. If you are not already in the Schedule of Classes page group, access the Schedule of Classes page group, as described in “Accessing the Schedule of Classes Page Group,” on page 169.

2. Click the Enrollment Cntrl tab (Figure 136) to display the Enrollment Control page.

3. If necessary, use the navigation controls in the Enrollment Control header bar to move to the desired section.

4. Make sure the Requested Room Capacity field contains a value equal to or greater than the Enrollment Capacity. This value will be used to determine classroom assignments.
Figure 136: Enrollment Controls—Changing Enrollment Capacity

5. If the **Enrollment Capacity** is not correct for this section, type over the existing value with the correct value, which must be greater than 0. If the enrollment capacity is unknown, or if you do not want to limit enrollment, enter a value of 999. Press the Tab key to move to the next field.

**Important!** Students will not be able to enroll in the section after this number of students have enrolled.

If necessary, you can increase or decrease the Enrollment Capacity as needed during the enrollment period. However, to know when such changes are needed, you **must** monitor the enrollment totals for each section of each course on a daily basis during the enrollment period.

**Note:** If you decrease the Enrollment Capacity to a value lower than the actual current enrollment, students who have already enrolled will **not** be dropped. However, if students drop the course, no one else will be able to enroll unless the actual enrollment drops below the adjusted Enrollment Capacity.
6. If this is the only change required for this class, click the Save button. If there are more changes for this class, click on the tab of the next page where you need to make changes. To continue with the next class in the search list, click the Next in List button.

**Making Changes on the Class Sections Page**

You can monitor enrollments for all sections of a class at once, and make changes to the class status and enrollment capacity for each section, on the Class Sections page. This is very useful during the enrollment period; however, you cannot add sections or make other scheduling changes on this page.

✔  **To stop further enrollment on the Class Sections page:**

1. Navigate to Manage Student Records > Establish Courses > Use > Class Sections. The Find an Existing Value page is displayed.

   **Tip!** If you were working on a class in the Schedule of Classes, that class will be displayed in the Class Sections page without displaying the Find an Existing Value page.

2. In the Term field, type or select the code for the term you are monitoring.

3. Enter any other search criteria you need.

4. Press the Enter key or click the Search button to display the search results.
5. Click on any link on the row that lists the course you want to see. The Class Sections page is displayed, with either the Class Status tab or the Class Enrollment Limits tab open, depending on which tab you viewed last.
6. If you are not on the Class Status tab, click it to display the class status information.

7. Locate the section you want to close, and type `S` to stop further enrollment.

8. Click the Save button to save your changes.

   **Tip!** If you are working from a search results list, you can use the Next in List or Previous in List buttons to work through all the classes in the list.

To change the enrollment capacity on the Class Sections page:

1. Navigate to **Manage Student Records > Establish Courses > Use > Class Sections**. The Find an Existing Value page is displayed.

   **Tip!** If you were working on a class in the Schedule of Classes, that class will be displayed in the Class Sections page without displaying the Find an Existing Value page.

2. In the **Term** field, type or select the code for the term you are monitoring.

3. Enter any other search criteria you need.

4. Press the Enter key or click the Search button to display the search results.
5. Click on any link on the row that lists the course you want to see. The Class Sections page is displayed, with either the Class Status tab or the Class Enrollment Limits tab open, depending on which tab you viewed last.

6. If necessary, click on the Class Enrollment Limits tab to display the enrollment information.
During enrollment, the **Tot Enrl** field will display the actual enrollment totals as of that minute.

7. To change the enrollment capacity for any of the sections, type the new capacity over the existing capacity in the **Cap Enrl** field.

**Note:** If you change the enrollment capacity to a number higher than the requested room capacity, you must change the **Requested Room Capacity** on the Enrollment Cntrl page in the Schedule of Classes, and if classrooms have already been assigned, notify the Classroom Assignment Coordinator of the change.

8. Click the **Save** button to save your changes.

**Tip!** If you are working from a search results list, you can use the **Next in List** or **Previous in List** buttons to work through all the classes in the list.
Chapter 5: Scheduling Classes

Changing Reserve Capacity

The reserve capacity is the number of seats reserved for a specified group of students. For example, if you want to make sure there will be seats available for freshmen in the fall, you can set a reserve capacity on the primary section for the requirement group Freshmen Only. If necessary, you can set more than one reserve capacity, and you can also set the date when any remaining seats that have not been used will be released.

Reserve capacities are set in sequences, one for each requirement group for whom you want to reserve space. You can set as many reserve capacity sequences as you want, controlling up to, but not more than, the entire enrollment capacity. For example, if you have a Physics seminar for which you have an enrollment capacity of 50, you can reserve 20 seats for Physics concentrators, 5 for Electrical Engineering concentrators, 5 for Computer Science concentrators, 10 for sophomores, and 10 for freshmen. This reserves every seat in the section for one group or another.

Note: The total reserve capacity for all sequences cannot exceed the Enrollment Capacity set on the Enrollment Control page.

If you don’t want to control every seat, you can reserve less than the total enrollment capacity. For example, for that same Physics seminar, you could reserve 20 seats for Physics concentrators, and 10 for freshmen, and leave the remaining 20 seats unreserved.

If a member of a requirement group for which a reserve capacity has been set attempts to enroll after the enrollment total for that sequence has been reached, he or she will be able to enroll only if non-reserved seats are still available. If a student enrolls who is a member of two requirement groups for which a reserve capacity has been set, the enrollment total will be incremented for the first sequence that applies. For this reason, you should create reserve capacity sequences in order—from most restrictive to least restrictive Requirement Group. (See page 220 for a list of Requirement Groups, in order from most to least restrictive).

Note: If reserved seats are not filled by members of the requirement group, and you have not released the seats, the section will not be filled, and other students who want to enroll during the drop/add period may not be able to do so.
If you want to limit the section to only those who are in one of the reserved requirement groups, it is not necessary to set a release date.

**Important!** You can set when you want to reserve seats by Requirement Group, but when you release reserved seats in one sequence (for one Requirement Group), you release them for all sequences. This means that you must be careful not to release seats too early, since releasing seats for any other group will also release seats reserved for Freshmen. Since you can set only one release date, you should set it on the first sequence.

If a reserve capacity has been set, but the number of seats you want to reserve for the requirement group has changed, you can change the reserve capacity for that group in the Schedule of Classes.

**To change an existing reserve capacity:**

1. If you are not already in the Schedule of Classes page group, access the Schedule of Classes page group as described in “Accessing the Schedule of Classes Page Group,” on page 169.

2. Click the Reserve Cap tab to display the Reserve Capacity page. You may need to click the right arrow at the end of the row of tabs to see the Reserve Cap tab.

3. Locate the primary component. The primary component usually will be a lecture, seminar, or class, and will be the only section listed with a Class Type of Enrollment, and an Associated Class value of 1. If necessary move through the sections by using the navigation controls in the header bar — the Next and Previous buttons.

4. To change the number of reserved seats for the requirement group, simply type over the existing value in the Number of Seats Reserved field in the first row.
5. To change the requirement group, use the Lookup button in the Requirement Group field to select the correct group. Remember to keep the sequences in order, from most restrictive Requirement Group to least restrictive:

**Most restrictive**
- XXX Graduate Students Only
- Open to XXX Concentrators Only
- Graduate Students Only
- Seniors Only
- Juniors Only
- Sophomores Only
- Freshmen Only
- Juniors and Seniors Only
- Freshmen and Sophomores Only

**Least restrictive**
- Not Open to Freshmen

If there is a second row for this sequence, select the same group on the second row.

**Important!** If there is a second row in a sequence, both rows should show the same Requirement Group. You must change the Requirement Group on the second line if you change the Requirement Group on the first line.
6. If you want to change the release date in sequence 1, select the **Start Date** on the second row, and enter the new date, or click the calendar button 🗓 to select a new date.

   ![Calendar Icon]

   **Note:** A release date should be set only on the first sequence.

7. When the necessary changes are completed, click the **Save** button. If there are more changes for this class, click on the tab for the next page where you need to make changes.

### Adding Reserve Capacity for an Existing Section

If a section was scheduled without reserve capacity, and you now need to set a reserve for a particular group, you can add a reserve capacity sequence in the Schedule of Classes. (For information on setting additional reserves when at least one reserve capacity has already been set, see “Setting Additional Reserves,” on page 225.)

To reserve seats for a specific group of students:

1. If you are not already in the Schedule of Classes page group, access the Schedule of Classes page group as described in “Accessing the Schedule of Classes Page Group,” on page 169.

2. Click the Reserve Cap tab to display the Reserve Capacity page. You may need to click the right arrow ➡️ at the end of the row of tabs to see the Reserve Cap tab.

3. Locate the primary component. If necessary, move through the sections by using the header bar navigation controls—the Next ➡️ and Previous ⬅️ buttons. The primary component usually will be a lecture, seminar, or class, and will be the only section listed with a **Class Type** of **Enrollment**, and an **Associated Class** value of 1.
Chapter 5: Scheduling Classes

Figure 142: The Reserve Capacity Page with No Reserves Set

4. If a reserve capacity was already scheduled, and you are adding another, click the Add Row button at the end of the Reserve Capacity Sequence line.

5. Leave the Reserve Capacity Sequence field as is. This value will be incremented by the system each time you add a row to create another sequence.

6. In the Start Date field, enter the date or click the calendar button to select the date when the first enrollment appointments begin for the term you are scheduling. The Registrar’s Office will advise you of the correct date each term.

7. In the Requirement Group field, use the Lookup button to display and select the group for whom you are reserving seats.

Tip! If you will be using multiple Requirement Groups, start with the most restrictive Requirement Group as the first sequence, and move through less restrictive Requirement Groups in later sequences. Step 5, on page 220 lists the Requirement Groups in order of restrictiveness.
8. In the *Number of Seats Reserved* field, enter the number of seats you want reserved for this group. This value must be less than, or equal to, the *Enrollment Capacity* set on the Enrollment Control page. If there are multiple sequences, the sum of the *Number of Seats Reserved* values must be less than, or equal to, the *Enrollment Capacity*.

9. If you are adding sequence 1 for this section and want to automatically release the reserved seats at a specified time, continue with the next procedure ("Releasing Reserved Seats," on page 223). If you are using the reserve capacity to limit enrollment completely, it is not necessary to add a row to release the seats.

**Releasing Reserved Seats**

If reserved seats are not filled by members of the requirement group, and you have not released the seats, the section will not be filled, and other students who want to enroll may not be able to. Generally, you set the release date when you set up the first reserve capacity sequence for the section. However, if a release date has not been set, you can set it at any time. The release date must be later than the start date of the sequence.

**Important!** Only one release date can be entered for all reserve capacity sequences set for a section. This release date should be set for sequence 1, and will release all reserved seats for that section that have not already been used.

✓ **To release reserved seats:**

1. If you are not already in the Schedule of Classes page group, access the Schedule of Classes page group as described in “Accessing the Schedule of Classes Page Group,” on page 169.

2. Click the Reserve Cap tab to display the Reserve Capacity page. You may need to click the arrow ➔ at the end of the row of tabs to see the Reserve Cap tab.

3. Locate the primary component. If necessary, move through the sections by using the navigation controls in the header bar—the Next ▶ and Previous ◀ buttons. The primary component usually will be a lecture, seminar, or class, and will be the only section listed with a *Class Type* of *Enrollment*, and an *Associated Class* value of 1.
4. In the Reserve Capacity Sequence locate sequence 1. If necessary, move through the sequences by using the navigation controls in the Reserve Capacity header bar.

5. Click the Add Row button in the Reserve Capacity Requirement Group area.

![Image of Princeton University interface showing Reserve Capacity Sequence]

*Figure 143: The Second Row in a Reserve Capacity Sequence*

6. In the Start Date field of the new row, enter the date or click the calendar button to select when you want to release the seats. Usually this is the beginning of the term, but you can release the seats earlier or later, if that is appropriate for your section.

**Important!** On the date specified, all remaining reserved seats will be released for the section, not just those in the first sequence.

7. In the Requirement Group field of the new row, enter the same value as in the previous row. This ensures the accuracy of the enrollment total displayed for this sequence.

8. In the Number of Seats Reserved field of the new row, enter the value 0.
9. When the necessary changes are completed, click the 
   Save button. If there are more changes for this class, click the tab of the next page
   where you need to make changes. To continue with the next class in the
   search list, click the Next in List button.

Setting Additional Reserves

If the section had a reserve capacity set for freshmen only, and you need to
add an additional requirement group to reserve seats for another group,
such as for concentrators, you can add another reserve capacity sequence.
You can use as many reserve capacity sequences as you need to control
enrollment in the section.

✔ To set additional reserve capacity sequences:

1. If you are not already in the Schedule of Classes page group, access the
   Schedule of Classes page group as described in “Accessing the
   Schedule of Classes Page Group,” on page 169.

2. Click the Reserve Cap tab to display the Reserve Capacity page. You
   may need to click the right arrow at the end of the row of tabs to see
   the Reserve Cap tab.

3. Locate the primary component. If necessary, move through the sections
   by using the header bar navigation controls—the Next and Previous
   buttons. The primary component usually will be a lecture, seminar,
   or class, and will be the only section listed with a Class Type of
   Enrollment, and an Associated Class value of 1.

4. To add another sequence for a different requirement group, click the
   Add Row button in the Reserve Capacity area.
5. The Reserve Capacity Sequence number is incremented by one for the new sequence. Leave this value unchanged.
6. In the **Start Date** field of the new row, enter the date or click the calendar button to select when the first enrollment appointments begin for the term you are scheduling. The Registrar’s Office will advise you of the correct date for each term.

7. In the **Requirement Group** field, use the **Lookup** button to display and select the group for whom you are reserving seats.

8. In the **Number of Seats Reserved** field, enter the number of seats you want reserved for this group.

![Princeton University](image)

**Figure 146: The Reserve Capacity Page With Two Sequences**

9. When the necessary reserves are set, click the **Save** button. If there are more changes for this class, click on the tab of the next page where you need to make changes. To continue with the next class in the search list, click the **Next in List** button.
Removing Reserve Capacity

If reserve capacity was set for a section which no longer requires this degree of control, you can remove the reserve capacity in the Schedule of Classes. You can remove an entire sequence, or a single row of a sequence. For example, if the course was previously offered in the Fall, and needed reserved seats for freshmen, but will be offered this Spring and won’t need reserves for freshmen, you can remove the reserve capacity sequence for freshmen.

You might want to remove only a single row of a reserve capacity sequence. For example, if the section was reserved for concentrators, and the professor doesn’t want any non-concentrators in the section, you could remove the release date row in the sequence.

To remove a reserve capacity sequence:

1. If you are not already in the Schedule of Classes page group, access the Schedule of Classes page group as described in “Accessing the Schedule of Classes Page Group,” on page 169.

2. Click the Reserve Cap tab to display the Reserve Capacity page. You may need to click the right arrow at the end of the row of tabs to see the Reserve Cap tab.

3. Locate the primary component. The primary component usually will be a lecture, seminar, or class, and will be the only section listed with a Class Type of Enrollment, and an Associated Class value of 1. If necessary move through the sections by using the header bar navigation controls—the Next and Previous buttons.

4. If there is more than one reserve capacity sequence, use the navigation controls in the Reserve Capacity header bar to locate the sequence you want to remove.
5. In the Reserve Capacity area click the Delete Row button. You will be prompted to verify that you really want to delete the sequence.

![Figure 148: Warning Message for Deleting the Reserve Capacity Sequence](image)

6. Click the OK button to delete the sequence.

7. Repeat Step 4 through Step 6 as needed, until you have removed all the reserve capacity sequences that no longer apply.

**Note:** If you have deleted the sequence that had a release date, you will need to add the release date for the sequence that has become the new sequence 1. See “Releasing Reserved Seats,” on page 223, for more information.

8. When your changes are complete, click the Save button. If there are more changes for this class, click on the tab of next page where you need to make changes.
To delete the release row in a reserve capacity sequence:

1. If you are not already in the Schedule of Classes page group, access the Schedule of Classes page group as described in “Accessing the Schedule of Classes Page Group,” on page 169.

2. Click the Reserve Cap tab to display the Reserve Capacity page. You may need to click the right arrow at the end of the row of page tabs to see the Reserve Cap tab.

3. Locate the primary component. If necessary, move through the sections by using the header bar navigation controls—the Next and Previous buttons. The primary component usually will be a lecture, seminar, or class, and will be the only section listed with a Class Type of Enrollment, and an Associated Class value of 1.

4. If necessary, use the navigation controls in the Reserve Capacity header bar to locate the sequence you want to remove.

5. Click the Delete Row button of the second row.

6. You will be prompted to verify that you really want to delete the row.
7. Click the OK button to delete the sequence.

8. When your changes are complete, click the Save button. If there are more changes for this class, click on the tab of the next page where you need to make changes.
When you have completed the changes required for each course, you must print a proof for the course and give it to the faculty member or the department manager for review. The proof shows the full description of the course, as it will appear in the Course Offerings publication.

If the instructor or department manager requests changes to the course, you can make the changes in the Course Catalog or Schedule of Classes, provided you have not yet submitted the course for approval (the course is in Progress). If you have submitted the course for approval, it will be in Pending status, and you may not make changes until the course is approved.

**Tip!** When the instructor or department manager approves the proof, have them sign and date the proof, and file it for reference.

You can print proofs for all courses in your subject area, all undergraduate courses in your subject area, or all graduate courses in your subject area, or you can print a proof for a single course. There will be one page for each course for which you request a proof.

**To print proofs for review:**

1. Navigate to Manage Student Records > Establish Courses > Report > Course Worksheet/Proof.

   If this is the first time you have run this report, you will need to click the Add a New Value link on the Add a New Value Page. Add and create the run control ID.
Tip! You should create a separate run control for Proofs rather than using the run control already created for Worksheets, because you will want to use different parameters for Proofs. To identify the different run control, you might want to call this one Course_Proof.

2. From the Search Results on the Find an Existing Value page, select the run control ID you want to use to print the proofs. The Course Worksheet/Proof page with the parameters of the selected run control is displayed, as shown in Figure 153.
If you have used this run control before, the fields will contain the values you used last. If you are adding the run control, the fields will be blank.

3. In the Subject Area field, type the 3-character code or click the Lookup button and select it from the search results.

4. If you want to print a proof for a single course, enter the catalog number in the Catalog Nbr field.

5. Use the Lookup buttons in the Select From Term and the Select Thru Term fields to select the term code for the new term.

6. If you want to limit the proofs printed to undergraduate courses, type UGRD in the Academic Career field. If you want to limit the proofs to graduate courses, type GRAD in the Academic Career field. If you want to print proofs for both graduate and undergraduate courses, leave this field blank (if there is a value in the field, highlight the value and press the Delete key to remove it).

7. If you want to print courses only for a specific instructor, use the Lookup button in the Instructor ID field.

**Tip!** If you want to print all the courses for a particular instructor, leave the Catalog Nbr and Academic Career fields blank.
8. When the page is filled out correctly, click the Run button. This will display the Process Scheduler Request page for printing the proofs, as shown in Figure 154.

![Figure 154: The Process Scheduler Request Page for Printing Proofs](image)

9. In the Server Name drop-down list choose the PSNT option.

10. In the Process List area, select (✓) Course Offerings Proof.

11. In the Type drop-down list choose the Printer option.

12. In the Format field, select HP to ensure correct formatting of the printed report.

13. In the Output Destination field, enter the full path to your network printer, giving the full network name; for example, `\ntprintserver\hp126alex124`. See “Locating Your Network Printer Name,” on page 297” for instructions on how to determine the name of your network printer.

14. Click the OK button to print the worksheets. There will be one page for each course requested.
Selecting Courses of Interest

About Courses of Interest .................................................. 238
Selecting Courses of Interest ............................................. 239
Printing a Report of Your Courses of Interest ..................... 244
About Courses of Interest

Courses of Interest are courses that may be of interest to students in a particular program or department. The courses of interest are not usually required for a certificate in those programs, but are courses that may be of interest or related to material that the program is offering.

Courses of Interest may be selected from the offerings of any other department, after the courses have been scheduled for the term. Courses of Interest will be listed in the Course Offerings, following the courses offered by or cross-listed for the program.

For those who are authorized to specify courses of interest, there is a brief time period after the deadline for adding and scheduling courses when you can select courses of interest. These courses can be selected from any department in the University, on a term-by-term basis.

Courses of Interest are selected using the Courses of Interest page accessed from the Setup menu.
Courses of Interest are set up by term and program. You can create the list of courses of interest only for your own program. However, you will be able to choose from among the entire set of courses being offered in the specified term, searching through scheduled courses by subject and catalog number.

To find courses that are being offered in a term, you can run the Pre-Worksheet Course List, or the Courses Offered Report, which is one of the reports that can be selected on the Process Scheduler page of the Course/Section Reports, available from the Report menu.

To select courses of interest:

1. Navigate to Manage Student Records > Establish Courses > Setup > Courses of Interest. This displays the Find an Existing Value page for Courses of Interest.

   ![Figure 155: The Find an Existing Value Page for Courses of Interest](image)

   If you have already started a list of Courses of Interest for this term, select Term in the Search By field and enter the term that you are scheduling. Continue to add courses of interest as desired beginning with Step 7 of this procedure.

2. Click the Add a New Value link. The Add a New Value page is displayed.
3. In the Term field, type the 4-character code for the term you are scheduling or select it using the Lookup button.

4. In the Program field, enter the three letter code of your program. You can display a list of all of Programs/Subject Area codes by using the Lookup button.

Figure 156: List of Programs/Subject Areas
Selecting Courses of Interest

5. Click the Program for which you are scheduling Courses of Interest. The Add a New Value page is displayed with your Program and Term fields filled in.

![Add a New Value Page](image1)

*Figure 157: Add a New Value Page with Program and Term Fields Filled In*

6. Click the Add button. The Courses of Interest page is displayed. Use this page to add or delete courses.

![Courses of Interest Page](image2)

*Figure 158: The Courses of Interest Page*

7. In the Subject Area field, use the Lookup button to select a Department/Subject area that you think will have courses that might interest students in your program.
8. In the **Catalog Number** field use the **Lookup** button to display the courses available in that subject area for the term being scheduled.

**Important!** Do not type the Catalog Number in the field even when you know the number; always select from the Search Results. The system does not validate the Catalog Number, so if you type a number that is incorrect, the correct course won’t be listed in the Courses of Interest.

9. Scroll, if necessary, to find the class you want. Click anywhere in the line containing the class to select it.

You are returned to the Courses of Interest Page with the **Subject Area** and **Catalog Nbr** fields filled in, along with the course title.
10. To add another course, click on an Add Row button, and repeat Step 7 through Step 9. Repeat as often as you need to list all the courses of interest for your program.

![Courses of Interest Page](Image)

**Figure 161: The Courses of Interest Page with a Few Courses Listed**

11. Click the Save button on the bottom left of the page to save the selected courses for your program.
Printing a Report of Your Courses of Interest

To verify that you’ve listed all the Courses of Interest that are appropriate, you can print a report at any time that shows your current listings.

✔️ To print the Courses of Interest:

1. From the Establish Courses menu, select Manage Student Records > Establish Courses > Report > Courses of Interest. This displays the Find an Existing Value page.

![Figure 162: Find an Existing Value Page – Run Control ID](image)

If this is the first time you are running the report, click on the Add a New Value link. The Add a New Value page is displayed. Enter a run control ID that you will be able to identify later, and click the Add button.
If you have run the report before, click the Search button, then choose the run control that you created for this report.

Figure 163: Run Control ID Search Results

2. The run control request page for the Courses of Interest is displayed.

Figure 164: The Run Control Request Page for the Courses of Interest

3. In the *Term* field, type the 3-character code for the term for which you want a list of your Courses of Interest, or select it use the *Lookup* button (if the correct term code does not already appear there).
4. In the **Subject Area** field, type the 3-character code for your program or department, or use the Lookup button to select it.

You can use the navigation controls above the Header bar to locate a Subject Area.

![Subject Area Lookup Page – Courses of Interest Report](image)

**Figure 165: Subject Area Lookup Page – Courses of Interest Report**
When you select a Subject Area you are returned to the Run Control Request Page for the Courses of Interest Report.

![Run Control Request Page](image)

**Figure 166: The Run Control Request Page for the Courses of Interest Report**

5. Click the Run button to display the Process Scheduler Request page.

![Process Scheduler Request](image)

**Figure 167: The Process Scheduler Request Page for the Courses of Interest Report**

6. In the Server Name drop-down list, choose the PSUNIX option.
7. In the Type drop-down list, and choose the Printer option. An Output Destination field is displayed.

8. In the Format field, select HP to ensure correct formatting of the printed report.

9. In the Output Destination field, enter the NT printer name (the Windows NT physical share name). See “Locating Your Network Printer Name,” on page 297 for instructions on how to determine the name of your network printer. Do not put “\ntprintserver” in front of the printer name.

10. Click the OK button to run the report.
The Classroom Assignments Process

The classroom assignment process begins after the undergraduate students have enrolled in the classes. For Fall classes, only the upperclassmen will have enrolled, since the freshmen are not on campus in the spring and graduate students don’t enroll until the fall. For Spring classes, only graduate students will still be enrolling when the classrooms are assigned.

The Classroom Assignments process begins with worksheets. You can print the worksheets from the same Reports menu that you used to print the course worksheets. You then fill out the worksheets for each section of each course, and make any changes required in the Schedule of Classes. If you make changes in the Schedule of Classes, you will need to reprint the worksheets and complete the remaining columns on paper before submitting them to the Classroom Assignments Administrator in the Registrar's Office.

**Tip!** You will also have to inform the Classroom Assignments Administrator of any classes that will meet during the Reading Period, since these classes are scheduled separately.

The Classroom Assignments Administrator runs the Resource25 program to automatically assign all unassigned classes to the appropriate room, and then lets you know when you can print the Classroom Assignment Proofs. The proofs are also printed from the PeopleSoft CIS system.
The first step in the process of classroom assignments is to run the Classroom Assignments Worksheet(s) for your department or program.

To run worksheets for classroom assignments:

1. Navigate to Manage Student Records > Establish Courses > Report > Classroom Assignment Proof. The Find an Existing Value page is displayed.

If you have never run this report before, you will need to click the Add a New Value link, and enter a name for your run control for this process. (See “Creating a New Run Control,” on page 287 for information on naming run controls.)

![Figure 168: The Add a New Value – Classroom Assignment Proof Page](image)

**Tip!** Use a name associated with the process, such as Classroom Assignments or Classroom Worksheets, so you will remember it later.

If you have run this report before, click the Search button on the Find an Existing Value page, and choose the run control from the search list.

The Worksheet for Room Assignment page is displayed.
2. In the Term field, type the code for the upcoming term, or use the Lookup button to select the term from the Search Results. Press the Tab key to move to the next field.

3. Leave the Academic Career field blank to print worksheets for both graduate and undergraduate courses, or select one of the following:

   - **UGRD**: To print worksheets for undergraduate courses only
   - **GRAD**: To print worksheets for graduate courses only

   Press the Tab key to move to the next field.

4. In the Subject Area field, type the 3-letter code for the department or program area (for example, **AAS, ENG, HIS**), or use the Lookup button to find and select the code from the Search Results. Then press the Tab key.

5. Click the Run button to display the Process Scheduler Request page.
6. In the Server Name drop-down list, choose the **PSUNX** option.

7. Select the process worksheet(s) that you want to print.

8. In the Type field for the Selected process, choose **Printer** from the drop-down list. The Output Destination field appears as seen in Figure 170.

9. In the Format field, select **HP** to ensure correct formatting of the printed report.

10. In the Output Destination field, enter the NT printer name (the Windows NT physical share name). Do not put “\ntprintserver!” in front of the printer name. See “Creating a New Run Control,” on page 287” for instructions on how to determine the name of your network printer.

11. Click the OK button to print the worksheet(s).
Completing Classroom Assignments Worksheets

The Classroom Assignments worksheet is divided into three sections:

✧ The Course Offerings Information section—shows the meeting pattern and time for each section of each course offered in the term. This information comes from the Schedule of Classes data in PeopleSoft.

✧ The Enrollment Information section—shows enrollment figures for current and maximum enrollment and requested room capacity. On the Fall worksheet it shows the number of places to reserve for freshmen enrollment (from the reserve capacity set for the Freshmen Only requirement group). If there are values in the Schedule of Classes for these enrollment figures, they will be printed on the worksheet.

✧ The Classroom Information section—is where you can write-in a requested building, and specify any required media or other classroom furnishings, such as overhead projectors or seats with tablet-arms.

When you first print the Classroom Assignment worksheet for a term, each course offered that term will be listed, with every section that has been scheduled for each course. You will need to verify that the course list is correct, and if not, you will need to make changes in the Schedule of Classes to add sections, and then rerun the worksheet. To cancel a section you must contact the Classroom Assignments and Course Offerings Administrators.

<table>
<thead>
<tr>
<th>Important!</th>
<th>The Classroom Assignments Administrator will not accept worksheets that contain handwritten information in the following fields:</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Course</strong></td>
<td><strong>Section</strong></td>
</tr>
<tr>
<td>Mtg Day</td>
<td>Beg &amp; End Time</td>
</tr>
<tr>
<td>Reserved for Frosh</td>
<td>Requested Room Capacity</td>
</tr>
<tr>
<td>Enrollment Capacity</td>
<td></td>
</tr>
</tbody>
</table>

If these fields contain handwritten information, CIS has not been updated correctly. The worksheet will be returned to you for correction.
The Enrollment Capacity and Requested Room Capacity entered in the Schedule of Classes will be listed for each class. In addition, the Current Enrollment field will contain values based on the number of students who enrolled during pre-registration (this will not include freshmen for Fall term classes). If Enrollment Capacity and Requested Room Capacity are not correct, you will need to change them in the Schedule of Classes.

**Tip!** You will probably need to increase the Requested Room Capacity if either of these conditions are met:

- The Current Enrollment shown on the worksheet is larger than the Requested Room Capacity,

or

- The Requested Room Capacity minus the Current Enrollment is less than the number of freshmen allowed to take the class.

The remaining columns are where you can note the requirements that the Registrar’s Office will use in the room assignment process. These columns include:

- The Requested Building and Room column—where you can indicate a preferred building, or note that you have assigned one of your own rooms to the class.

- The Classroom Media/Seating requests column—where you can indicate requirements, such as overhead projector or tablet-arm chairs.

**Reviewing the Offerings**

When you first print the Classroom Assignment worksheet for a term, each course offered that term will be listed, with every section that has been scheduled for each course. You will need to verify that the course list, meeting times, and patterns are correct. If they are not correct, you will need to make changes in the Schedule of Classes to add sections, and change meeting times or patterns. Then you can rerun the worksheet.

✅ To review the offerings on the Classroom Assignment worksheet:

1. Review the worksheet, making sure that all sections of each course offered in the term appear on the worksheet.
If a section is missing, add it as described in “Adding a New Class Section,” on page 171.

If a section is listed that should not be included, stop enrollment in the section and request the Course Offerings Administrator to cancel it as described in “Changing the Class Status,” on page 208.

2. Review the meeting times and patterns on the worksheet. If any are incorrect, change them in the Schedule of Classes, as described in “Changing the Time and Day of an Offering,” on page 181.

3. If you have added or canceled sections, subsections, or precepts, or changed meeting times and patterns, rerun the worksheets, as described in “Printing Classroom Assignment Worksheets,” on page 251.

**Reviewing and Correcting Enrollment Capacities**

When you have the corrected worksheet, your next Step is to review and correct the enrollment capacity and requested room capacity figures. The current Enrollment Capacity and Requested Room Capacity from the Schedule of Classes will be listed on your worksheet for each class.

Review the enrollment figures on the worksheet, keeping the following in mind:

- The Requested Room Capacity must be equal to or greater than the maximum enrollment capacity (Enrol. Capac. [Max]).
- The maximum enrollment capacity should be greater than or equal to the Current Enrollment plus the Reserved For Frosh figure.

![Note: If a course has been offered previously, you can use that term’s enrollment total as an indicator of the capacities you should request.]

If these figures are not correct, you will need to change them in the Schedule of Classes. You will also need to change any “unlimited” capacity values of 999 to an actual capacity value.

**To correct enrollment and room capacity figures:**

1. Navigate to Manage Student Records > Establish Courses > Use > Schedule of Classes. The Find an Existing Value page is displayed.
2. In the **Term** field, type the code for the upcoming term or use the **Lookup** button to find and select the code from the Search Results. Press the **Tab** key to move to the next field.

3. In the **Subject Area** field, type the 3-letter code for the department or program area (for example, **AAS, ENG, HIS**, etc.), or use the **Lookup** button to find and select the code from the Search Results. Then press the **Tab** key.

4. Leave the **Academic Career** field blank to see all the courses for the selected term and subject area. To limit the search list to either graduate or undergraduate courses, type or select **Graduate** or **Undergraduate**. Then press the **Tab** key to move to the next field.

5. Click the **Search** button to display the list of selected courses in the term.
Chapter 7: Classroom Assignments

Figure 172: The Search Results for Schedule of Classes

6. Locate the first class that needs changes, and click it to display the Schedule of Classes page group for that class.

7. Click the Enrollment Cntrl tab in the Schedule of Classes page group.
Completing Classroom Assignments Worksheets

8. Make sure you are on the right section, using the Navigation controls in the Enrollment Control header bar to move through the sections if necessary.

9. In the Requested Room Capacity field, type over the current number with the number of seats required. This number is used to select an appropriate classroom in Resource25.

**Important!** The Requested Room Capacity must be equal to or greater than the Enrollment Capacity. You should also include seating for the instructor and any additional seating that may be required for auditors.

For the Fall term, the Requested Room Capacity must also be greater than or equal to the sum of the current enrollment plus any reserved freshmen seating (from your worksheet).
10. In the Enrollment Capacity field, type in the maximum number of students that will be allowed to enroll in the section, including any estimated freshmen enrollment. This number will assist the Registrar’s Office in assigning rooms.

| Note: You must change any Enrollment Capacity values of 999 to an actual enrollment capacity number. |

11. If it is necessary to make any changes to another class section use the Navigation controls in the Enrollment Control header bar to move there. Be sure that all sections that required changes are corrected before continuing with the next class.

12. Click on the Save button to save your changes.

13. To continue with the next class, click on the Next in List button, and repeat Step 8 through Step 12.

14. Continue until all changes have been made.

Completing & Submitting the Corrected Worksheet

After entering all the enrollment control information, run an updated worksheet to show your changes. Then enter the required information on the corrected worksheet, and submit the worksheet to the Classroom Assignments Administrator in the Registrar’s Office.

To complete and submit the worksheet:

1. In the Reserved For Frosh column, a number will appear indicating the Reserve Capacity set for freshmen in the Schedule of Classes. If this number is not correct, change the Reserve Capacity for the Freshmen Only Requirement Group on the Reserve Capacity page in the Schedule of Classes page group. See “Changing Reserve Capacity,” on page 218, for more information.
2. In the Requested Building and Room column, enter one of the following:

- If the class is assigned to one of your own rooms, enter the building and room number.
- If a particular building is preferred, enter the building name only. Include a second and third choice, in case the first choice building is not available.
- If no preference has been expressed, leave the column blank and Resource25 will assign both the building and the room.

Note: Departments will not be able to enter classroom information into the Schedule of Classes in PeopleSoft.

3. In the Classroom Media/Seating request column, enter any special requirements for the course or for a professor. Be specific; for example, TV/VCR, prefer seminar room, tablet-arm chairs, document camera.

4. If you have different courses with the same meeting pattern, such as a shared lecture, that need to be scheduled in the same classroom, note these courses at the bottom of the worksheet. (Examples of courses meeting together include ENV 201A and ENV 201B, or ITA 411 and ITA 555.)

5. Submit your Classroom Assignment Worksheets to the Classroom Assignments Administrator in the Registrar’s Office by faxing all worksheets to 258-6328.

Important! Once you have submitted your classroom assignments, you will not be able to make any changes in the Schedule of Classes Basic Data, Meetings, or Enrollment Control pages until after the completion of the classroom assignment process.
Printing Classroom Assignment Proofs

After the Classroom Assignments Administrator has scheduled (assigned) the classrooms with Resource25, you will be notified that the classroom assignments have been completed. These assignments will be visible on the Schedule of Classes Meetings page in the Facility ID field.

You can print the classroom assignments for review using the same process you used to print the worksheets, but selecting a different report, Classroom Assignment Proof, on the Process Scheduler page.

To print Classroom Assignment Proofs:

1. Navigate to Manage Student Records > Establish Courses > Report > Classroom Assignment Proof. Choose the run control from the search list.

2. The Worksheet for Room Assignment page is displayed, as shown in Figure 175.
3. To print proofs for both graduate and undergraduate courses, leave the Academic Career field blank. To limit the proofs to undergraduate courses only, select Undergraduate. To limit the proofs to graduate courses only, select Graduate.

4. Click the Run button to display the Process Scheduler Request page, as shown in Figure 176.

![Figure 175: The Worksheet for Room Assignment Run Control](image)

![Figure 176: The Process Scheduler for Classroom Assignment Proofs](image)
5. In the Server Name drop-down list, choose the PSUNX option. The Output Destination field is displayed.


7. In the Type field, choose Printer from the drop-down list. The Output Destination field appears as seen in Figure 170.

8. In the Format field, select HP to ensure correct formatting of the printed report.

9. In the Output Destination field, enter the NT printer name (the Windows NT physical share name). Do not put “\ntprintserver\” in front of the printer name. See “Locating Your Network Printer Name,” on page 297” for instructions on how to determine the name of your network printer.

10. Click the OK button to print the proof(s).

### Assigning Rooms for the Reading Period

If you have classes that will meet during the Reading Period (such as language, engineering, or computer science), you must reserve a room for the specific days and times when each class will meet. This can be done by sending an e-mail to the Classroom Assignments Administrator, listing which classes will meet during the Reading Period, with the dates and times for each section.

**Important!** If you do not schedule a room during the reading period for a class, it is assumed that the class will not meet, and the room will be available for other bookings.

The Classroom Assignments Administrator needs to know about Reading Period bookings as soon as possible, but no later than the last day of mid-terms for the scheduled term.
Changes After Classroom Assignments

After classrooms have been assigned, any changes to the schedule (including adding or canceling sections, changing the meeting times, or changing the room in which a class meets) impact two systems: the PeopleSoft Course Information System, and Resource25. Therefore, you must inform the Registrar’s Office (specifically, the Classroom Assignments Administrator and Course Offerings Administrator) of any changes you make.

Adding or Canceling Sections

When you add additional sections in the Schedule of Classes, the Registrar’s Office will be notified automatically by Resource25 that an assignment is required. When the Classroom Assignments Administrator has completed the assignment in Resource25, the assignment will be sent to CIS. If the sections you have added will be scheduled in your own room, an office, or a conference room, you must inform the Classroom Assignments Administrator to ensure that Resource25 will not give the sections an unnecessary assignment.

**Important!** When you need to have a class canceled that has already been assigned a classroom, you must copy the Classroom Assignments Administrator on the e-mail requesting the cancellation, so she can make the appropriate changes in Resource25.

You should also notify both the Classroom Assignments Administrator and Course Offerings Administrator by e-mail when you add sections after classrooms have been assigned.

**Important!** After a class has been scheduled, you should never delete it; classes that will not be offered after they have been scheduled must be canceled by the Registrar’s Office.
**Changing a Classroom Assignment**

To request a room change after the assignment process, contact the Classroom Assignments Administrator by e-mail. List the course number and section, days and times, and the reason for the requested change.

If you re-assign a section to your own room, inform the Classroom Assignments Administrator of the change, so he or she can update Resource25 and CIS.

**Changing Meeting Times and Patterns**

If you change a meeting time, day, or pattern after a classroom has been assigned to a section, you must notify the Classroom Assignments Administrator and the Course Offerings Administrator of the change, since the currently assigned classroom may not be available at the new time. The Classroom Assignments Administrator will assign a new room.

When you change the meeting time, day, or pattern of a section that has already been assigned a classroom, a warning message will be displayed (Figure 177), indicating that the classroom assignment has been removed.

![Figure 177: Warning for Post-Room-Assignment Changes](image)

You must inform the Classroom Assignments Administrator of the change, so that the class can be assigned a classroom at the correct meeting time.
Enrollment Issues

What You Need to Know About Web Enrollment . . . . . . . 268
Enrollment Controls and Web Enrollment . . . . . . . . 269
Enrollment Totals and New Sections . . . . . . . . . . . 271
Assigning Student-Specific Permissions . . . . . . . . . 273
What You Need to Know About Web Enrollment

Before the term’s enrollment period, students meet with their academic advisers to plan their program and have their course selections approved. Students must complete the Course Enrollment Worksheet, which is available on the web, and bring two copies of the worksheet to their adviser for approval. The adviser will sign both copies, keeping one for the record and letting the student keep the other for reference during enrollment.

After the advisement period, students select their courses on the web during the enrollment periods. Students are assigned an enrollment appointment that specifies when they can begin their course selections. The appointments for undergraduates are assigned based on seniority; seniors will be first, followed in turn by juniors, sophomores, and freshmen. Their appointments are overlapping, but the start times are separated by two or three days. All graduate students have the same appointment start and end dates.

Students are able to add, change, drop, and swap courses online until they are satisfied with their selections, or the enrollment period closes. They can add to their schedule little-by-little, or all in one session, whichever they prefer. However, the system will not allow them to add more than a specified maximum or drop below a specified minimum number of courses (based on whether their degree track is AB or BSE).

Online course selection for undergraduates closes at the end of the appointment periods for a week, and then opens for an add/drop period during the second week of final exams. During the first two weeks of the term, students are also able to add, drop, and swap courses in SCORE without penalty. After this, students must bring the course change form to the Registrar’s Office if they need to add, change, or drop a course.

Online course selection for graduate students begins after registration in September for the Fall term classes, and concludes on Friday of the tenth full week of classes. For Spring term classes, graduate students can select courses on the web beginning mid-November and ending on Friday of the tenth full week of classes.

For both graduate and undergraduate students, course changes after web enrollment ends must be personally submitted to the Registrar’s Office, and must have the appropriate adviser’s approval.
Enrollment Controls and Web Enrollment

The information you have entered in the Course Catalog and the Schedule of Classes controls which students can enroll in which classes. When students attempt to enroll in a class for which they are not qualified (for example, a non-concentrator selecting a course open to concentrators only), they will get an error message and are not permitted to select that class. Students can be prevented from enrolling for several different reasons:

- The section has reached the enrollment capacity set in the Enrollment Control page of the Schedule of Classes. Additional students will not be accepted into the section after this point. There are several ways you can permit additional enrollment:
  - You can set the Student-Specific Permissions checkbox for the section, and assign permission to the specific student you want to allow into the section.
  - If the Requested Room Capacity is larger than the Enrollment Capacity, you can increase the Enrollment Capacity to allow a few more students into the section. See “Changing Enrollment and Room Capacity,” on page 211, for more information.
  - You can add another section to accommodate more students. See “Adding a New Class Section,” on page 171, for more information.

- The student is not a member of a group for whom a reserve capacity was set, and all non-reserved seats have been taken. Or, the student is a member of a group for which a reserve capacity was set, but all seats for that group have been taken, and all non-reserved seats have been taken (there are openings for another group). There are several ways to permit enrollment:
  - You can set the Student-Specific Permissions checkbox for the section and assign permission for the student you want to allow into the section. This allows only the specified student into the section. Be aware that this will take a seat from the reserved seats.

Note: If you need to increase the Enrollment Capacity and the Requested Room Capacity, you will need to notify the Classroom Assignment Administrator of the change in room requirements.
You can adjust the reserve capacities up or down as required to allow more students to enroll. Increasing a reserve capacity allows more students in the requirement group to enroll; decreasing a reserve capacity allows more non-reserved students to enroll. See “Changing Reserve Capacity,” on page 218, for more information.

Alternatively, you could increase the Enrollment Capacity to increase the number of non-reserved seats (see Note, page 269). See “Changing Enrollment and Room Capacity,” on page 211, for more information.

**Note:** Increasing enrollment capacity allows any student to enroll. It does not guarantee that a particular student will be able to enroll, since other students may select the course first.

- The student does not have permission for a class that requires an application or interview. The student must complete the required application or interview, and be accepted for the course. You will then be able to assign the student permission to select the class. (See “Assigning Student-Specific Permissions,” on page 273 for more details on how to do this.)

- The student does not meet a requirement set on the Offerings page of the Course Catalog. This includes limitations for concentrators only, or grade levels such as juniors or seniors. The only way a student can get into a course for which they do not meet a requirement, is to be enrolled by the Registrar’s Office, or to be given student-specific permission to enroll in that section. Before you can assign permission to the student, you must set the section as requiring Student-Specific Permissions on the Basic Data page of the Schedule of Classes.

- The student did not select a required related section, for example, the lab component of a course that includes a lecture and lab. If a course is set up with multiple non-optional components, the student must select one section of each non-optional component in order to register for the course. If a student is unable to select a required related section, it may not have been scheduled.

**Important!** You must be sure to schedule at least one of each non-optional component of a course that is set up in the Course Catalog with multiple components. If a non-optional component in the Course Catalog is not scheduled, students will not be able to enroll in the course, because they will not be able to select the related component.
Should there be a problem with one of these controls, it can be addressed only by the academic department, or in an emergency, the Registrar’s Office, during business hours. The Help Desk cannot resolve or manage any of these enrollment controls or resolve problems resulting from them. Consequently, this kind of help for students will not be available outside of normal University business hours. Since it is likely that the students will be accessing the web site after hours, it is extremely important that you set up the enrollment controls, requisites, and reserve capacities correctly.

Note: Students will not enroll in optional components (precepts, drills, ear training, and film sections, and if the department requests that they be optional, labs or classes) through SCORE. However, you will still need to schedule the sections, to provide the section data to the BlackBoard section assignment application.

Important! You must monitor the enrollment totals on a daily basis during online enrollment in order to manage the enrollment controls as needed.

Each night during the enrollment period, class lists are extracted for the Data Mall and Blackboard, providing a snapshot of the enrollment for each section at the time the data was extracted.

**Enrollment Totals and New Sections**

During enrollment, the Enrollment Control and Reserve Capacity pages in the Schedule of Classes, and the Class Sections page, will show actual enrollment totals. Keep a close eye on these totals, since they indicate if/when you should create additional sections. If a section has reached capacity, or is filling faster than expected, you can create a subsection or an additional section that will be immediately available for enrollment.
You can also see if too many seats have been reserved for a group, and release some or all of them to allow more students who are not in the requirement group to enroll. Conversely, you may need to increase the reserve capacity, if the enrollment totals for that sequence are approaching the limit. This change also takes effect immediately if you set the Start Date to the current date.

**Important!** Once online course selection for the term has ended, the actual enrollment totals displayed in the Enrollment Control and Reserve Capacity pages will not reflect any adds or drops processed by the Registrar’s Office.
Assigning Student-Specific Permissions

If a student is required to complete an application or interview before he or she can be accepted into a course, the primary component sections of the course in the Schedule of Classes must be set with the attribute APPL, and the student-specific permissions checkbox must be selected on the Basic Data page. When a section has been set for Student-Specific Permission, a student can select that section only if they have been assigned permission by the department in PeopleSoft. You can assign student-specific permissions using the Class Permission Numbers page (Manage Student Records > Establish Courses > Use > Class Permission Numbers).

Until the student uses his or her permission to enroll in the section, the Class Permission Numbers page will show their permission as Not Used. When they enroll in the section using the permission, the page will show their permission as Used.

**Note:** Used/Not Used cannot be relied upon to count the number of enrollments, since the permission continues to say Used, even if the student drops the course. In addition, if the student later decides to add the course again, their permission is still valid.

**To assign student-specific permissions:**

**Important!** Before you can assign student-specific permissions the class must be set to require them. To ensure that the Student-Specific Permissions checkbox is selected (✔️), navigate to Manage Student Records > Establish Courses > Use > Schedule of Classes. On the Basic Data page, locate the primary section, and see that the Student-Specific Permissions checkbox is selected. Be aware that when you assign class permissions to a student, enrollment controls, such as the Enrollment Capacity, are overridden. If you have added student names to the Class Permission Numbers page without setting the section attribute to APPL, you are granting these students an override into the course whether it is open or closed.

1. Navigate to Manage Student Records > Establish Courses > Use > Class Permission Number. This displays the Find an Existing value page.
2. In the Term field, type the code for the term you are giving permissions for, or use the Lookup button to find and select the code from the search results.

3. In the Subject Area field, type the 3-letter code for the department or program, or use the Lookup button to find and select the code from the search results.

**Tip!** If you know the Catalog Nbr of the course you can enter it into the Catalog Nbr field then press the Enter key to go directly to the Class Permission Numbers page for that class.

4. Click on the Search button to display the list of classes.

![Figure 178: The Find an Existing Value Page for Class Permissions](image)

5. Click on the class for which you are assigning permissions. This displays the Class Permission Numbers page.
6. If the *Class Type* is a Non-Enrollment Section, use the Navigation controls to scroll to locate the Enrollment Section. Only sections labelled **Enrollment Section** can be assigned permissions.

7. Leave the *Default Date* field unchanged. This is the date that will be used by default as the expiration date for each permission you assign for this class. The Default Date provided by the system is the last day of the term.

**Tip!** If there are no open fields in the bottom area of the page, verify that you are on the right section, and that Student-Specific Permission is selected on the Basic Data page for that section in the Schedule of Classes.

8. Use the **Lookup** button in the *ID* field to display the list of students. This list includes all students who are active for the term.
9. You can narrow the list by entering all or part of the Last Name of the student you are looking for, or you can enter the student’s EmplID number, if you know it. Click the Lookup button to display the students that match the criteria.

- If the criteria you used results in a list of 1, the system automatically selects that student and redisplays the Class Permission Numbers page.
- If the criterion you used results in a longer list, select the student from the list by clicking on any link in the row that contains the student’s name. You are returned to the Class Permission Numbers page.

10. The Expire Dt field (Expiration Date) defaults to the date set in the Default Date field. This is the date when the permission will expire. You can change this value, but there is generally no need to do so.

11. The Perm Type (Permission Type) field defaults to A (Add). This allows the student to add the class. Do not change this value.
12. Click the **Save** button to save the permission.

13. To assign permission for another student, click on the **Add Row** button and repeat Step 8 through Step 12, as needed.

---

**Figure 182: Second Row Added for Another Student**
Tip! Class permissions override Enrollment Capacity and Requirement Groups. Be careful not to assign more permissions than can be accommodated in the assigned classroom, or you will have to change the classroom assignment.

Figure 183: Two Permissions Assigned
Academic Group. The division of a University, such as Natural Sciences, or Humanities. Each department or program falls under one of these academic groups.

Advisement Period. A time frame before the enrollment appointments begin, during which students meet with their academic advisers to plan and have their course selections approved.

Attribute, Course Attribute. An attribute is a characteristic of a course. The Course Attribute field is used to include such information as “course is required for concentrators” in the Course Offerings publication. Course attributes are not enforced by the system; they are purely informational.

Catalog, Course Catalog. The database that contains all the information that defines all of the courses offered at Princeton. This database is used to create the Undergraduate Announcement.

Class Number. The number that identifies a section of a course for enrollment on the web. This number is assigned by the system when the course is scheduled, and can be seen on the Schedule of Classes pages.

Component, Course Component. A component refers to the type of meetings a course has, such as lecture, lab, class, and precept. A course can be made up of any of nine components (see Table 3 on page 62 for Course Component Types).

You can define as many components as you need for a course, and as many instances as you need for each component. For example, in Physics 101, we have 1 lecture component, 4 class components, and 6 lab components.

See also, Optional Component.

Course ID. Each course in PeopleSoft has a unique ID number in the Course Catalog, which is assigned by the system when the course is created. The Course ID number is numeric; for example, the Physics 101 course has the ID 000027. You can find the course ID on top of every page in the Schedule of Classes and Course Catalog page groups.

Cross-Listing, Cross-Listed Course. A course that is offered by more than one department. The course may have different Catalog Numbers in each different subject area, and an entry will appear in the Course Offerings in each subject area. However, the full description will only appear under the home department, and enrollment will be in the home department offering.

Enrollment Appointments. Time frames for each student when they can enroll on the web. Enrollment appointments are assigned based on class year; each class has a different appointment, with some overlap with other classes.

Enrollment Capacity. This field indicates the maximum number of students who can enroll in each section of a course, and is used to control section size during online enrollment. You can control the number of students in every section of every type of component. An enrollment capacity of 999 indicates that enrollment in that section is unlimited.
Enrollment Controls. Settings that automatically control online enrollment. These controls include class status, enrollment capacity, reserve capacity, and student-specific permissions (all set in the Schedule of Classes), and Requirement Groups (set in the Course Catalog).

Graded Component. The graded component is the section of the course that gets the final grade. It is the primary component of the course: the lecture or seminar, or the class when a course has no lecture.

Grading Basis. Sets of possible grades that a student could receive in a course. The grading basis is set for the course in the Course Catalog, and depending on what is set there, the student may be able to select a grading basis when enrolling in the class. For example, if a course is set with a grading basis of A-F,P,Aud, the student may select GRD to receive a letter grade, SPF to take the course pass/fail, or AUD to audit the course.

Hold. A flag that has an effect on enrollment. For example, a student with an infirmary hold is not permitted to enroll until he or she has submitted the required immunization information to McCosh Health Center. Instructions for releasing the hold are provided on the web as part of the hold message.

Limited Enrollment Course. Limited enrollment has been replaced by a combination of enrollment controls and enrollment appointments that will provide the same functions.

Optional Component. A component of a course that is not selected for enrollment through SCORE. Optional components include precepts, drills, ear training, and film components. In addition, departments may request that labs and classes be set as optional components.

Note: This is an internal designation only; the students must enroll in the section, but not through SCORE.

Page. The PeopleSoft display that fills the empty window after you have selected a page or page group from the Use menu. Pages are the tools you use to manipulate data in the PeopleSoft application database.

Page Group. A group of related pages that are shown with tabs across the top of the display, right under the menu bar. Pages in a page group contain related information. For more detailed information about page groups, what they are and how to work in them, See “Understanding PeopleSoft Page Groups” on page 27.”

Primary Component. The component of a course in which students may enroll, and for which grades are entered in PeopleSoft. Generally this will be a class, lecture, or seminar.

Prior Term Copy (Roll). The process that copies classes from one term to another in the Schedule of Classes. This process is also referred to as rolling classes.
Provisional Save. Saving changes with a Course Approved status of In Progress. You may continue to make changes to the course in the Course Catalog and the Schedule of Classes until you submit the course for approval, when the status changes to Pending.

Related Classes. Sections other than the primary component that are required to be a full participant in the course. These can be labs, precepts, drills, ear training, and films, and classes when the class is not the primary component.

Requested Room Capacity. The total number of seats that will be required for the room in which the section will be taught. This number is used to determine classroom assignments, and must be greater than or equal to the Enrollment Capacity.

Requirement Group. A defined group, such as a class (Freshmen, Juniors, etc.), or department concentrators, which can be used to control enrollment. When set as a requisite, a requirement group limits enrollment to only those who are in the group. When set as a reserve capacity, a requirement group ensures that a specified number of group members will be able to enroll.

Reserve Capacity. An enrollment control that allows you to set aside a number of seats for a specific group of students in order to control section composition during online enrollment. You can reserve all the seats in the section, or subsets of seats, as required.

Reserved for Frosch. This column in the Classroom Assignment Worksheet for the Fall Term is where the number of freshmen expected to enroll in the section when they arrive in the fall is indicated. This number comes from the Reserve Capacity set for the Freshmen Only Requirement Group for the section.

Resource25. The application used to schedule rooms for events or classes on an ad-hoc basis. This application is used to change the classroom assignments after the initial assignments have been made.

Roll (Term Roll, Prior Term Copy). The process that copies courses from one term to another in the Schedule of Classes. This process is known in PeopleSoft as Prior Term Copy.

Run Control ID. A name assigned to a set of parameters used by a specific user to run a process. The user creates the run control ID by assigning the ID name, and selecting the parameters. Once the run control ID has been created and saved, the user can run the process using those same parameters by simply selecting the run control ID.

Schedule of Classes. A set of tables associated with the Schedule of Classes and the Schedule New Course page groups. The page groups display all the information about courses offered each term, including the meeting pattern and times for each section of each component of each course. The set of tables is where the information is stored. The information is separated by term, and can be copied from one term to another.

SCORE. Student Course Online Registration Engine. This is the web enrollment application.
**Service Indicator.** See Hold.

**Standard Meeting Pattern.** The days and times when a course is offered. Sample standard meeting patterns would include Tuesday and Thursday for 80 minutes each day, and Monday, Wednesday, and Friday for 50 minutes each day.

**Student-Specific Permission.** An enrollment control that limits enrollment to students who have been given explicit permission to enroll. A student must be given permission to enroll in any course that requires an application or interview.

**Tentative Section.** A non-primary section in which students do not enroll through SCORE. Tentative sections are sections of optional components (precepts, drills, ear training, and films).

**To Do.** A reminder, visible on the web, to a student to complete a task. For example, all graduate students will receive a reminder to sign and return their Graduate Readmission Contract by May 1 of each year.

**Topic ID.** A course can be taught several times, but covering a different topic each time. To distinguish the various themes taught each time the course is offered, a different topic can be defined for each term. Topics may not be repeated for graduate courses, but may be repeated up to three times for undergraduate courses.

Topics are identified by a course topic ID number, which is associated with the topic name, so you can select the desired topic when scheduling a class.
## Appendix B: Tips and Techniques

<table>
<thead>
<tr>
<th>Topic</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>Running Processes</td>
<td>286</td>
</tr>
<tr>
<td>Run Controls</td>
<td>286</td>
</tr>
<tr>
<td>Creating a New Run Control</td>
<td>287</td>
</tr>
<tr>
<td>Editing an Existing Run Control</td>
<td>288</td>
</tr>
<tr>
<td>Using the Process Scheduler Request Page</td>
<td>288</td>
</tr>
<tr>
<td>Using the Process Monitor</td>
<td>290</td>
</tr>
<tr>
<td>Setting Your User Defaults</td>
<td>291</td>
</tr>
<tr>
<td>Inserting Special Characters in Descriptions</td>
<td>294</td>
</tr>
<tr>
<td>Locating Your Network Printer Name</td>
<td>297</td>
</tr>
<tr>
<td>PDF Reports</td>
<td>301</td>
</tr>
<tr>
<td>Creating a Report in PDF Format</td>
<td>301</td>
</tr>
<tr>
<td>Displaying a PDF Report</td>
<td>302</td>
</tr>
<tr>
<td>Saving a PDF Report Without Displaying It</td>
<td>306</td>
</tr>
<tr>
<td>Viewing an Instructor’s Schedule</td>
<td>308</td>
</tr>
</tbody>
</table>
Running Processes

If you run a PeopleSoft process or report, you will use a run control. The run control allows you to specify the parameters the process will use before you run the process or report.

When you run a process or report, you must schedule the process using the Process Scheduler, where you can also indicate where the output from the process will be sent. For example, you can send a report to a printer.

If you want to track the progress of a process or report, you can check the current status of any process you initiate on the Process Monitor.

This appendix provides basic information on run controls, the Process Scheduler, and the Process Monitor. Information on using these features for a specific process is included in the description of that process.

Run Controls

Although you may run many processes on a regular basis (for example, monthly or weekly), you do not need to enter the same criteria repeatedly. Instead, PeopleSoft allows you to save processing and reporting criteria as run controls. Then the next time you need to repeat the process, you can select the run control, and the Request page appears with the stored criteria as the default.

Run controls are required for any type of data processing, such as the transfer of information from one table to another, or the generation of reports. When you click the Run button, the parameter page for the run control is displayed with the default settings previously set for the run control ID. However, you can change the settings, if necessary.

Important! Before running a run control, make sure the values are still appropriate. Remember that when you open an existing run control, it will show the values from the last time you ran it, which may not be appropriate this time.
You need to set up a run control for each type of process or report that you run. However, you do not need to add a new run control each time you run the same report or process. You can just change the values in the run control to include the specific parameters that you want for this particular run.

**Note:** Run controls are specific to the user ID. This means that no one else can see or use your run controls. You can name your run control ID with the same name as another user, without worrying about naming conflicts, or their parameter selections showing up in your run control.

To create or edit an existing run control, select the desired process or report from the Process or Report menu. Then, to create a new run control, click the **Add a New Value** link and enter a run control ID. To display an existing run control, click the **Search** button and select from a list of established run controls.

**Creating a New Run Control**

For a new run control, enter a Run Control ID name on the Add a New Value page. The name can be up to 30 characters long, and must not contain spaces or forward slashes (/). It is recommended that you name the run control according to the process it runs.

After you add a new value you are taken directly to the run control request page. At first, all of the fields on the page are empty. To specify the criteria you want the system to process, you must enter your process parameters and click the **Run** button.

**Tip!** **Clicking the Run button does not start the process. It will only start after you schedule it on the Process Scheduler Request Page and click the OK button.**

The next time you enter or select the same run control, the Request page will appear with your previously set process parameters.
Editing an Existing Run Control

To edit an existing run control, enter the run control ID, or click the Search button on the Find an Existing Value page. The run control request page appears with the data that was specified when the run control was created or last modified. To edit the run control parameters, simply make any necessary changes, and click on the Save button to save the parameters without running the process, or the Run button to save the parameters and run the process.

**Tip!** Clicking the Run button does not start the process. It will only start after you schedule it on the Process Scheduler Request Page and click the OK button.

Using the Process Scheduler Request Page

The Process Scheduler Request page is displayed any time you run a process in PeopleSoft, for example, to roll classes into a new term, or to run a CIS report. The Process Scheduler Request page appears after you complete a run control and click the Run button.

**Tip!** Clicking the Run button does not start the process. It will only start after you schedule it on the Process Scheduler Request Page and click the OK button.

![Figure 184: The Process Scheduler Request Page](image)
The Process Scheduler lets you specify the following:

- When the process will run—instantly, at a specific time, or on a recurring basis
- Where the process will run—locally on your workstation or remotely on the server
- Where the output will be directed—to a file, a printer, or an online display

**Tip!** Generally when running a report, the Output Destination should not be File, since the default file type is not one you can actually display.

To display the Process Scheduler Request page, click the Run button from the process request (run control) page. When the Process Scheduler Request page appears, change your scheduling options as needed, and click on the OK button to start the process.
Using the Process Monitor

To review the processes you have initiated, click on the Process Monitor link on the run control request page, or navigate to PeopleTools > Process Monitor > Inquire > Process Requests. The Process Requests page displays the Instance Sequence, Process Type, Process Name, User, Run Date/Time, Run Status, and Details.

The Process Monitor tracks the status of all completed and pending Process Scheduler requests. Some processes take only a few moments and others can take considerably longer. To ensure that the page displays up-to-date information, click the Refresh button as needed until the Run Status changes.
Setting Your User Defaults

User defaults are data entry aids that can be set for each individual user, by the user. These entry aids control the default values that appear in various fields and on the Find an Existing Value pages.

Although the default values are displayed on pages, you can always change the values on each page if you do not want to use the defaults. Your user defaults will remain unaffected by any changes you make on other PeopleSoft pages.

You can set default values to appear in the various PeopleSoft pages for several fields. You can change these defaults as often as you like, or leave them unchanged, if you prefer. For example, if you will be working on only undergraduate courses for a few weeks, and then will be working on only graduate courses, you could set your user default for the Academic Career to **UGRD**, and then reset it a few weeks later to **GRAD**. At the same time, since your department does not often change, you might want to set your user default for the Subject Area field, and never change it. You can set and reset the default each time you sign onto PeopleSoft.

You will notice that the Academic Institution, Career Group SetID, and Facility Group SetID are already set to **PRINU**. Do not change these values.

User default settings take effect as soon as you save the page.

To change your user defaults:

1. Navigate to > Design Student Administration > Specify User Defaults > Use > User Defaults to display the User Defaults page. The first page of the page group is displayed as shown in Figure 186.
2. If you are working on both graduate and undergraduate courses, leave the Academic Career field blank. If you work primarily on graduate courses, enter GRAD. If you work primarily on undergraduate courses, enter UGRD.

3. If you work on just one academic group, enter the 3-character code in the Academic Group field for that group, or use the Lookup button to select it. If you work on more than one academic group, leave the Academic Group field blank.

4. If you work in a single subject area, or mostly in one subject area, enter its 3-character code in the Subject Area field, or use the Lookup button to select it. If you work in multiple subject areas, leave the Subject Area field blank.

5. If desired, you can set the term value to the term you are currently scheduling. In the Term field, enter the numeric code for the term or use the Lookup button to select it.

**Note:** If you are setting a default for the Term, you must also set a default for the Academic Career, since term is dependent on career.

6. The remaining fields are not used for maintaining the Course Catalog or scheduling classes, so you can leave them blank.
7. Click on the Save button to save the defaults, which will be effective immediately.

Figure 187 shows the user defaults used for the work shown in this manual.

Figure 187: User Defaults Set in this Manual
Inserting Special Characters in Descriptions

You can enter special characters, such as â, é, ü, and ß, in description fields in both the Course Catalog and the Schedule of Classes, by using Unicode character mapping. The Character Map program is available through the Windows Start menu, under Programs, Accessories, Character Map.

To insert special characters in a text field:

1. Keep the PeopleSoft window open and click the Start button on the Task bar at the bottom of your screen.

2. Navigate to Programs > Accessories > Character Map (in Windows NT) or Programs > Accessories > System Tools > Character Map (in Windows 2000 or Windows XP). The Character Map opens.

3. Select the font from the drop-down list in the Font field.

4. Locate the character you want to insert in the text field, and click once on the character. As you click on the character, it will be enlarged, so you can confirm that this is the character you want. In the following figure, the ö is highlighted.

If necessary, you can change the font here.

Click here to select the highlighted character.
5. Click the Select button at the top of the window to select the highlighted character. This displays the character in the Character to Copy field.

6. Click the Copy button to copy the character to the Windows clipboard.

7. If this is the only character you need to copy at this time, close the Character Map window by clicking on the Close button.

8. In the PeopleSoft window, select the character you want to replace, or position your cursor where you want to insert the special character.

9. Press the Ctrl+V key to paste the copied character into the text field.
10. Continue entering information as usual.
Locating Your Network Printer Name

To run SQR reports you must enter a printer name in the Process Scheduler Request page. That printer name is the Windows NT share name of the printer. The physical share name may be the name you see in the print dialog box for other windows activities, but it may be a different name. This procedure will tell you the right name to use.

Note: The preferred printing method is to use a network printer. If you require local printing, please contact the Help desk.

Tip! You can also use the Quick Reference Card, Using the Process Scheduler for CIS, to learn how to choose a network printer as an output destination. The procedure on the card shows you only those printers that are already defined for your local PC. The procedure that begins on this page, however, enables you to choose from all NT print servers that are available on the network.

To find Your Windows Printer Name:

1. Click the Start button and choose Settings > Printers from the menu.

2. The names of any printers you have installed will be listed in the window. (If your window displays icons, click on the Detail button or select Details from the View menu to change the view to show names.)
3. Make a note of the name of your default printer. If you have multiple printers listed, and do not know which is your default printer, right-click on each printer name until you find the one for which Default Printer is checked. That one is your default printer.

4. Click on the Start button and select Run.

![Image of Run dialog box]

5. Type \ntprintserver and click on the OK button. This opens an Explorer-style window that lists all the printers defined on NTPrintServer (all the networked NT printers).

![Image of NTPrintServer window]

6. If your window does not look like this, click on the Detail button (or select View > Details from the menu) to display the detail view of the printer list.

7. Look in the Comment column for the name you noted in Step 3.
8. When you find the name in the Comment column, the corresponding name in the Name column is the name you must use in the Process Scheduler Request page. Make a note of this name.

To set the Output Destination in PeopleSoft:

1. When the Process Scheduler Request page is displayed, choose the **PSUNX** option in the **Server Name** drop-down list.

2. In the **Type** drop-down list, choose the **Printer** option, and in the **Format** field, choose **HP**. The **Output Destination** field is displayed.

3. In the **Output Destination** field, enter the NT printer name—the name you identified at the end of the previous procedure. Do not put "\ntprintserver\" in front of the printer name.
Appendix B: Tips and Techniques

Enter the name of the printer identified in the Name column of the ntprintserver window.
You can produce reports for web delivery, in PDF format, which you can then print, or save to your computer and attach to an e-mail (if, for example, you want to send it to an instructor).

Creating a Report in PDF Format

To create a report in PDF format, you select a Type of Web and a Format of PDF on the Process Scheduler page for the report. When the report has been generated, you can view the report from the Process Monitor Detail page or from the Report Manager Detail page.

To generate a report in PDF format:

1. Select the desired report from the Report menu, and complete the run control as described for the specified report.
2. Click on the Run button to display the Process Scheduler page.
3. Select the Server Name PSUNX.
4. Select (✓) the desired report.
5. In the Type field, select Web, and in the Format field, select PDF.

Figure 188: The Process Scheduler with PDF Settings
6. Click the OK button to run the report. You are returned to the run control page, where a process instance number will appear below the Run button.

![Image of the Run Control Page with the Process Instance Number]

Figure 189: The Run Control Page with the Process Instance Number

7. Make a note of the process instance number, in case you have multiple processes on your process list.

**Displaying a PDF Report**

You can display a PDF report from either the Process Monitor or the Report Manager. If you are not sure whether the report has run successfully, you should use the Process Monitor, which shows you the run status of the report. If you know the report has run successfully, you can navigate to the report more easily through the Report Manager.

To display a report from the Process Monitor:

1. Generate the report in PDF format, as described in “Creating a Report in PDF Format,” on page 301.

2. Click on the **Process Monitor** link to display the Process List.
3. Locate the report (it should be the top line), and check the **Run Status**. If the **Run Status** is not **Success** or **Posted**, click the Refresh button until the report process has completed.

4. When the report has successfully completed (the **Run Status** is **Success** or **Posted**), click on the **Details** link to display the Process Detail page.
5. Click on the View Log/Trace link to display the Report/Log Viewer page.

![Figure 192: The Report/Log Viewer](image)

6. Click on the link for the PDF file to open the Acrobat Reader and display the report. From this point, you can save a copy of the report, or print it, using the Acrobat toolbar.

✔ To display a PDF report through the Report Manager:

1. Generate the report in PDF format, as described in “Creating a Report in PDF Format,” on page 301.

2. Click on the Report Manager link to display the Report List.
3. Click the View link in the row for the report you want to see.

Tip! You can determine which is the correct report by matching the Prcs Instance to the Process Instance noted on the run control page, or by checking the Request Date/Time.

4. Click on the link for the PDF file to open the Acrobat Reader and display the report. From Acrobat, you can save a copy of the report, or print it, using the Acrobat toolbar.
Saving a PDF Report Without Displaying It

If you are confident that the report is correct, or you have already displayed it and now want to save it without redisplaying it, you can save the report using a shortcut menu on the Report/Log Viewer.

Once the report has been saved, you can email it to an instructor for review, or display it and print it from Acrobat.

To save a PDF Report without displaying it:

1. Generate the PDF report as described in “Creating a Report in PDF Format,” on page 301.

2. Navigate to the Report/Log Viewer:
   - From the Process Monitor, click the Details link, and then the View Log/Trace link.
   - From the Report Manager, click the View link.

3. Right click on the link for the PDF file to display the shortcut menu.

4. Select Save Target As... from the shortcut menu. The Save As dialog box is displayed.
5. Select the location where you want to save the file, and if desired, rename the file using a meaningful name. Just be sure to leave the .pdf extension.

6. Click the Save button to save the report file. Once the report is saved, you can attach it to an email to send to an instructor, or display it in Acrobat.

7. When you have finished with the Report/Log Viewer, close the window by clicking the Close button at the top right corner of the window.
Viewing an Instructor’s Schedule

You can review an instructor’s schedule for a specified term on the Instructor Schedule page. This page shows the subject and catalog number of the class, the section number and type, the meeting time and days for each section. The schedule data is obtained from instructor entries in the Schedule of Classes Meetings page.

To display an instructor’s schedule:

1. Navigate to Manage Student Records > Establish Courses > Use > Instructor Schedule. The Find an Existing Value page is displayed.

![Figure 197: Find an Existing Value for the Instructor Schedule Page](image)

2. In the Term field, select the term for which you want to see the schedule using the Lookup button, or type the term code, if you know it.

3. In the ID field, click the Lookup button to display the Lookup ID page.
4. Enter the search criteria for the instructor. Most often, this will be the first few characters of the instructor’s Last Name and First Name, but if you know the instructor’s social security number, you can enter that in the National ID field.

5. Press the Enter key or click the Lookup button to display the search results.

6. Select the instructor from the search results list by clicking any link on the row. You will be returned to the Find an Existing Value page, which will have a single line in the search results list.

7. Click on any link in the row in the search results list to display the instructor’s schedule.

8. For additional information, click on the Instructor Schedule 2 tab.
Appendix B: Tips and Techniques

Instructor Schedule

Richardson, James

Term: 2004-2005 Fall

<table>
<thead>
<tr>
<th>Class Number</th>
<th>Subject</th>
<th>Catalog</th>
<th>Sect</th>
<th>Component</th>
<th>Start Date</th>
<th>End Date</th>
<th>Session</th>
<th>Institution</th>
<th>Acid Group</th>
</tr>
</thead>
<tbody>
<tr>
<td>20000</td>
<td>ENGR</td>
<td>201</td>
<td>C02</td>
<td>CLS</td>
<td>09/09/2004</td>
<td>01/13/2005</td>
<td>Regular</td>
<td>PRNU</td>
<td>H/UNH</td>
</tr>
<tr>
<td>22002</td>
<td>ENGR</td>
<td>200</td>
<td>L01</td>
<td>LEC</td>
<td>08/28/2004</td>
<td>01/13/2005</td>
<td>Regular</td>
<td>PRNU</td>
<td>H/UNH</td>
</tr>
</tbody>
</table>

Figure 200: The Instructor Schedule 2 Page
Appendix C: Announcement Process

Preparing to Run the Announcement ........................................... 312
Choosing a Drive Letter ............................................................. 312
Mapping the Drive .................................................................... 313
Creating a Shortcut to the Announcement Folder ...................... 314
Running the Undergraduate Announcement ............................... 317
Viewing and Saving a Report ...................................................... 320
Preparing to Run the Announcement

In PeopleSoft 8, the CIS Undergraduate Announcement Process writes an announcement report for your courses to a shared network drive. To easily retrieve the report you must first map a network drive and create a shortcut to it on your desktop. You need do this only once.

Choosing a Drive Letter

You must check to see which drives have already been mapped on your computer, to be sure that the drive letter you choose for the Announcement is not already in use.

✔ To choose a drive letter:

1. Double-click the My Computer icon on your desktop. The My Computer window opens.

2. In the example above, the drives A, C, D, F, J, S, T, & U are in use and cannot be mapped to a new drive. Choose a drive letter that is not in use and make a note of it. It is recommended to use drive P if it is available.

3. Close the My Computer window.
Mapping the Drive

Mapping the network drive to a drive letter you have selected on your PC allows you to setup the shortcut to the Announcement folder.

To map the drive:


2. Click Tools > Map Network Drive. The Map Network Drive dialog box is displayed.

3. In the Drive field choose the drive letter from the drop-down list that you made a note of earlier (drive P: if available).

4. In the Folder field, type `\ProdCtrl\Public`.

5. Select (✓) Reconnect at Logon.
6. Click the Finish button.

7. The drive will be mapped and a window opens showing all the folders and files in `\ProdCtrl\Public`.

8. Close the window.

**Creating a Shortcut to the Announcement Folder**

Creating a shortcut on your desktop enables you to go straight to the Announcement folder when you need to retrieve a report, without navigating through drives and folders.

✔️ **To create a shortcut to the announcement folder:**

1. Click the Start button on the Task bar at the bottom of your screen and choose **Program > Accessories > Windows Explorer**. The Explorer window opens.

   ![Figure 204: The Explorer Window](image)

   - **Figure 204: The Explorer Window**

2. If the right pane is not visible, click the Folders icon in the windows Tool bar.
Preparing to Run the Announcement

3. In the left pane of the Explorer window, navigate to the Announcement folder:

   a) Click the plus sign next to the My Computer icon.
   b) Click the plus sign next to the Public on ProdCtrl icon.
   c) Click the plus sign next to the ProdData folder icon.
   d) Click the plus sign next to the HRSA folder icon.
   e) Click the plus sign next to the SA folder icon.
   f) Click the UgradAnnouncement folder icon. The right pane of the window shows the contents of the folder.

   ![Figure 205: Left Pane of the Explorer Window]
4. In the right pane of the Explorer window, locate the **UgradAnnouncement** folder, and right-click on it.

![Figure 206: The UgradAnnouncement folder In the Right Pane of the Explorer Window](image)

5. From the popup menu, select **Create Shortcut**.

6. The message below is displayed.

7. Click Yes.

8. Close Windows Explorer. Locate where on your desktop Windows put the shortcut to the Announcement folder. It will be labeled, “Shortcut to UgradAnnouncement”.

---

**Page 316**  
**PeopleSoft Student Administration: Course Information**
To generate an Undergraduate Announcement you use the Process Scheduler Request page to run a report. The report is then written to the UgradAnnouncement folder.

To run an Undergraduate Announcement:

1. Log on to PeopleSoft as described in “Signing In to the System,” on page 21.


3. If you have run the Announcement before, click the Search button to view existing Run Controls. Click on the name you earlier assigned to the Run Control for the Announcement.

   If this is the first time running this report, click the Add a New Value link. Enter a name, such as UA, and click the Add button.

   **Note:** The name of a report cannot contain any spaces. If you need a space use the underscore character ( _ ).
4. In the Academic Career field enter **UGRD**, and enter the code for the department or program (for example, **PHY** for Physics) in the Academic Organization field. This will run the department’s entire course list.

**Note:** The output file path will always begin with this string:
`\ProdCtrl\public\ProdData\HRSA\SA\UgradAnnouncement`.
The last portion of the output file path is generated by combining your NetID and the Academic Organization (or Subject) you select.
The example below shows the output file created when user JBRONSON runs the announcement for the Physics department’s Plasma Physics program. PeopleSoft 8 automatically designates the Input/Output file. You cannot modify the output file name.

![Image of Announcement Publication Page Run Control Page]

**Figure 209: The Announcement Publication Page Run Control Page Filled-in**

5. Click the Run button to open the Process Scheduler Request page.

![Image of Process Scheduler Request Page]

**Figure 210: The Process Scheduler Request Page**

6. In the Server Name field, select PSUNX.
7. Select (✓) the Undergraduate Announcement field.

8. In the Type field, enter Printer. In the Format field, enter HP. Leave the Output Destination field blank since the UA Process does not print a report. Leave all other fields blank.

9. Click the OK button to run the report. You are returned to the Announcement Publication Page Run Control page.

![Figure 211: The Announcement Publication Run Control Page](image)

**Viewing and Saving a Report**

This procedure shows you how to save a report in Word format on your C: drive.

**Note:** If you haven’t yet created a shortcut to the UgradAnnouncement folder, follow the instructions in “Creating a Shortcut to the Announcement Folder,” on page 314 before starting this procedure.

**To view and save the report as a Word document:**

1. Launch Microsoft Word, if it is not already running.

2. Choose File > Open from the menu. The Open dialog box is displayed.
3. In the Open dialog box, locate **Shortcut to UgradAnnouncement** and double-click on it. The contents of the Open dialog box changes to show the contents of the **UgradAnnouncement** folder.

4. Locate the HTML file that has your ID and department and double-click it. The file opens in Word.
5. Choose **File > Save as** from the menu. The Save As dialog box opens.

6. Click the Up-One-level button to navigate to your C: drive.

7. In the **Save as type** field, select **Word Document(*.doc)** from the dropdown list.

8. In the **File name** field, type **nameofdocument.doc**. You can rename the document here, but be sure that it has the **.doc** extension.
9. Print a copy for review and markup.

10. Make all proposed changes in ink, then send them with a memo explaining the requested changes to the Dean’s Office.

If the changes have been approved, the Dean’s Office will enter the changes in CIS. Specific instructions about updating the course lists, including deadlines, will be e-mailed to the UA contacts from the Dean’s Office.
Index

A

Academic Career
  changing for an existing course 77
  setting a default value for 292
Academic Group
  changing for an existing course 77
  defined 280
  for a cross-listing 56
  for a new course 80
  setting a default value for 292
  values listed 78, 80
Academic Organization
  for a cross-listing 56
Academic Structure
  changing 77
Access
  obtaining 21
Active Processes
  and logging off 25
Adding a Course
  academic groups, listed 54, 80
  approval pending 41
  reporting course changes 42
  the Effective Date for 45
  adding attributes 141
Adding Components
  for a new course 94
  to an existing course 94
Adding Reserves
  for a scheduled class 221
Adding Sections 171
  after classroom assignment 265
  enrollment capacity value 178
  restrictions 168
  setting enrollment controls 177
  to scheduled courses
    introduced 168
Adding Topics
  for a new course 52

...
defined 280
Author/Article Title Field
on Sample Reading List page 145

B
Basic Data Page
described 132
using to add sections for a new course 135
Basic Data page
Schedule New Course page group 139
Basic Data Page6
Schedule of Classes page group
introduced 168
Blackboard
and the Course Web Address 193
Bold Text
entering in text fields 143, 193

C
CAFSIS, Instructor for
changing 204
setting for a new course 156
Cancelling a Class 210
Cancelling Sections
after classroom assignment 265
Catalog
defined 280
Catalog Data page
adding a new course 43
introduced 40
Changing Course Data
academic structure 77
accessing the course 68
after scheduling the class 107
and approvals 66
and effective dating 66
attributes 91
components 92
cross-listings 79
grading basis 75
instructor 87
requisites 99
topics 85
Changing the Course Catalog
after scheduling the class 107
Character Map Program
using to insert special characters 294
CIS 15
Class Meetings
changing after classroom assignment 266
changing the schedule of 181
changing to non-standard meeting pattern 185
scheduling 150
Class Number
defined 280
Class Offerings
reviewing the Classroom Assignment Worksheet 255
Class Permission Numbers
page, navigation and purpose of 29
Class Section Field
on the Basic Data page 137
Class Status
changing for a scheduled class 208
on Enrollment Control page
values for 208
values described 158
Class Type
on Basic Data page 137
Class Worksheets
introduced 119
printing 121
printing for a single course 122
printing for a single term 122
printing for a specific instructor 122
printing for several consecutive terms 122
using to identify classes to be copied 125
Classes
add sections for a new course 135
cancelling 210
copying to a new term 126
defined 8
finding in the Schedule of Classes 169
in the Course Offerings 12
related, defined 282
scheduling new 131
searching for 32
shared, and classroom assignment 261
Classroom Assignment
adding sections after 265
and requested room capacity 207
and shared classes 261
assigning your own rooms 261
cancelling sections after 265
changes after 265
changing 266
changing meeting times after 266
changing section meetings after 266
completing the worksheet for 260
correcting enrollment capacities for 256
displayed on the Schedule of Classes Meetings page 262
during the reading period 264
indicating special requirements 261
introduced 250
overview 250
printing proofs of 262
printing worksheets for 251
requesting a building 261
reviewing offerings on the worksheet 255
worksheets
described 254
filling out 260
printing 251
Closing Sections
of scheduled classes 208
Component
graded, defined 281
primary, defined 281
Component, Optional
defined 281
Components
adding for a new course 94
adding for an existing course 94
and prior term copy 126
changing for an existing course 92
defined 280
deleting from an existing course 96
graded and primary 56
listed 62
primary, adding for a new course 63
setting the primary for a new course 64
synchronizing changes to the primary 96
components
graded and primary 64
Components Page
described 62
introduced 41
Concentrators, course required for
setting the attribute 51
Consent
and the APPL Attribute 51
on the Catalog Data page 49
Controlling Enrollment
with Enrollment Capacity 211
with Requirement Groups 58, 99
with Reserve Capacity 162, 218
with Student-Specific Permission 138, 175
assigning permissions 273
Copying Classes
course management 11
overview 126
using Prior Term Copy 126
Course Administrator as Instructor-in-charge 138
Course Approval
pending status and changes 41
See also Approval
Course Attributes
changing for a term 195
Course Catalog
accessing an existing course 68
changes that require approval 66
changes, accessing for 68
changing course attributes 91
defined 280
management of 11
Pages, navigation and purpose of 29
transferring data to the Schedule of Classes 134
Course Changes
adding a new topic to an existing course 85
adding or changing a cross-listing 79
after scheduling the class 107
and publications 68
changing attributes in the Course Catalog 91
changing components 92
changing requisites 99
changing the instructor-in-charge on the Instructor
page 87
fields that can’t be changed after approval 68
new effective-dated row for 73
that must be synchronized 107
to the academic structure 77
Course Components
listed 62
setting the default enrollment capacity 64
See also Components
Course ID Number
assigned 43
defined 280
Course Information System
defined 15
Course Offerings
reviewing proofs for 232
schedule of classes 12
Course Requirements
defining for a new course 57
Course Topic ID
changing in the Schedule of Classes 191
Course Type
and the Topics page 52
defined 45
for a new course 45
Course Web Address
changing 193
standard address 193
Course Website
  described 142
Course, New
  See New Course
Course/Class Synchronization
  running the process 108
Courses
  accessing for changes 68
  changing a cross-listing 79
  copying to a new term 126
  defined 8
  displaying a list of 72
  searching for 32
  types of, listed 9
Courses of Interest
  defined 238
  Page, navigation and purpose of 29
  printing a report of 244
  selecting 239
Cross-Listed Course
  defined 280
Cross-Listing
  a New Course 55
  Adding for an existing course 79
  changes to 79
  defined 280
  deleting 84
  inserting a new row
    for a new course 56
  making changes to existing 82

D
Default Value
  dependencies 292
Defaults, operator
  setting 291
Deleting a Cross-Listing
  on the Offerings page 84
Deleting Sections
  and Course Offerings 179
  from scheduled courses
    described 179
    introduced 168
  vs cancelling sections 179
Department
  changing for an existing course 77
Description
  changing in the Schedule of Classes 192
  entering text in 143
  setting for a term 142

Description Field
  and approval status 193
  and Word formatting codes 192
  in the Course Catalog, described 47
  in the Schedule of Classes
    limit 193
Description Page
  introduced 132
  Schedule New Course page group
    using 142
Descriptive Information
  changes to, listed 187
  described 187
Distribution Area field
  described 50

E
Editing Techniques
  for text fields 193
  in the additional information fields 146
  in the Description field 143
Effective Date
  and saving changes in progress 102
  explained 16
  for course changes 71, 74
  for the new course 45
Enrollment
  and Enrollment Capacity 161, 212
  and Reserve Capacity 163, 218
  on the web, overview 268
Enrollment Appointment
  defined 280
  explained 268
Enrollment Capacity
  and classroom assignments 260
  and course selection 161
  changing 211
  correcting for classroom assignments 256
  defined 280
  field, described 159
  limiting enrollment with 178
  on Enrollment Control page, defined 207
  overriding limits set by 269
  setting the default in the Course Catalog 64
Enrollment Control Page
  introduced 133
  Schedule of Classes page group
    introduced 169
Enrollment Controls
  and the Help Desk 271
  and web enrollment 269
cancelling a class 210
changing course requisites 99
changing existing reserve capacities 219
defined 281
described 158
enrollment capacity, defined 207
limiting the number of students in a class 211
releasing unused reserves 223
removing reserve capacity 228
Reserve Capacity 162
setting additional reserves 225
setting enrollment limits 158
setting for a new course 159
setting for a new section 177
Student-Specific Permissions checkbox 138
using Requirement Groups 58
using to limit enrollment 207, 211
Enrollment Problems
troubleshooting 269
Enrollment Section
and primary component 275
setting 137
setting for a new section 174
Enrollment Totals
during enrollment 271
Exam Scheduling
and the Final Exam field 202
F
Facility ID
process for assigning
introduced 262
Filling out the Classroom Assignment Worksheet 260
Final Exam Field
and room assignment 148
and the final exam schedule 201, 202
on the Course Component page
values listed 65
on the Requirements/Grading page 149
Freshmen Enrollment
on the Classroom Assignment Worksheet, defined 282
G
Graded Component
defined 281
Grading Basis
and approval 75
changing in the Course Catalog 75
defined 48, 281
listed 48
values, described 76
Grading Calculations
for a new class 148
Grading Requirements
changing for a scheduled class 201
setting for a new course 148
H
Hold
defined 281
I
Identifying Classes
running the pre-worksheet course list 115, 119
Instructor
adding for a section 156
adding for an existing course 90
adding for CAFSIS 156
assigning for the course 60
changing for the current term 157, 205
changing in the Course Catalog 87
filtering instructor list in Schedule of Classes 157, 205
for CAFSIS 150
for Course Offerings 204
in the Announcement and Course Offerings 59
in the Schedule of Classes 150
changing 204
multiple entries for scheduled class 204
page
displaying 60
troubleshooting entry of 157
Instructor Role Field
in Schedule New Course page group 158
Instructor Schedule
viewing 308
Instructor-in-Charge 87
and course administrator 138
instructor-in-charge as course administrator 138
Interview courses
assigning permissions for 273
L
Limited Enrollment
replacement for, defined 281
Limiting Enrollment
and classroom assignment 256
changing Enrollment Capacity 211
enrollment controls, described 207
using Enrollment Capacity 178
using Reserve Capacity 162, 218
using the Student-Specific Permissions checkbox 138
Locating a Course in the Course Catalog 68
Locating Classes
using the Pre-Worksheet Course List 115, 119
Locating the Instructor
problem in Course Catalog but not Schedule of Classes 60
Logging off 25

M
Meeting Pattern
changing 181
changing after classroom assignment 266
non-standard 185
changing to 185
defined 185
Pat field 151
setting for a new section 175
standard
changing for a scheduled section 181
defined 150
setting for a new course 150
TBA defined 183
value list explained 182
Meeting Schedule
changing 181
changing after classroom assignment 266
See also Meeting Pattern
Meeting Times
and TBA meeting pattern 176, 183, 184
and TBA sections 176
changing after classroom assignment 266
changing for TBA sections 176, 183
entering 184
military, notation in 184
Meetings Page
introduced 132
Schedule New Course page group
using 150
Military Notation of Time
used in Mtg Start field 152, 155, 176, 184
military time 184
Mtg End Field
default end time 155
Mtg Start Field
on Meetings Page 152, 155, 176, 184

N
Navigation Controls in the Header Bar 153
Network Printer
entering the name in PeopleSoft 299
finding the name of 297
New Course
adding components for 94
creating sections for 135
entering the reading list for 144
providing additional information in the schedule 146
scheduling 131
scheduling meetings for 150
setting enrollment controls for 158
setting grading requirements for 148
setting reserve capacity for 162
Non-Standard Meeting Pattern
changing the default end time 155

O
Offerings Page
deleting a cross-listing 84
for a new course 55
for cross-listing a new course 55
use of 53
Operator Defaults
setting 291
Optional Component
defined 281
Optional Component checkbox
on the Components page of the Course Catalog 64
Other Information
changing for a scheduled class 199
field limit 200
Output Destination
entering the network printer name 299

P
Page
defined 281
Page Groups
Course Information System, listed 29
defined 281
explained 28
introduced 27
working with 28
Password
resetting forgotten 24
Pat Field
on the Meetings Page 151
PDF
creating a report in PDF format 301
displaying reports from Process Monitor 302
displaying reports from Report Manager 304
saving a report 306
Pending Status
and approvals 41
and Course Catalog changes 66
and publications 68
Permission Date
setting the default for 275
Permission, Student-Specific
defined 283
See also Student-Specific Permission
Prerequisites & Restrictions
adding for a new class 147
changing for a scheduled class 199
field limit 200
Pre-Worksheet Course List
use in course management 11
using to locate classes 115, 119
Primary Component
and enrollment section 275
Associated Class value for 137
defined 281
identifying in schedule of classes 189
locating for changes to schedule information 188
setting for a new course 64
Student-Specific Permissions checkbox 175
Printer Name, Network
entering in PeopleSoft 299
finding 297
Printing
Classroom Assignment Worksheets 251
Printing Worksheets 121
for a single course 122
for a single term 122
for a specific instructor 122
for graduate classes 122
for several consecutive terms 122
for undergraduate classes 122
Printing worksheets
for a single course 122
Prior Term Copy
defined 281
introduced 126
Page, navigation and purpose of 29
using to copy classes 126
Prior Terms
locating classes in 115, 119
Process Monitor
described 290
Process Scheduler
explained 288
Processes
active, and signing out 25
running 286
scheduling 288
tracking progress of 290
Program
changing for an existing course 77
Proofs
of classroom assignments 262
reviewing class schedule information 232
run control for 233
R
Reading List
adding to an existing 198
changing an entry in 198
changing for a scheduled class 197
deleting an entry in 198
entering for a new class 144
example 197
punctuation for 144
punctuation in 197
Reading Period
assigning rooms for 264
scheduling rooms for 250
Reading/Writing Assignments
adding for a new class 147
changing for a scheduled class 199
field limit 200
Records
retrieving for display or update 32
Releasing unused reserves 223
Reports
Classroom Assignment Proofs, printing 262
Classroom Assignment Worksheet 251
Courses of Interest 244
creating in PDF format 301
displaying a PDF report 302
new and changed courses 42
Pre-Worksheet Course List
introduced 11
printing 115, 119
Proofs, Course 232
saving to your hard drive 306
Worksheets, Class
introduced 11
printing 119
Requested Room Capacity
and Enrollment Capacity 161
changing 211
defined 282
described 159
on Enrollment Control page, defined 207
when to increase 255
Required for concentrators
setting the attribute for 51
Requirement Groups
defined 282
order of restrictiveness 164
requisites vs. reserve capacity 58
Requirements
and enrollment 99
changing for an existing course 99
defining for a new course 57
Requirements/Grading Page
introduced 132
using to change grading requirements 201
Requisites
changing for an existing course 99
defining requirements for a new course 57
deleting for an existing course 101
introduced 41
overriding for enrollment 270
Reserve Capacity
adding for an existing class 221
and Enrollment 163, 218
and Enrollment Capacity 218
changing existing reserves 219
changing for scheduled classes 218
changing to allow enrollments 270
defined 282
page, introduced 133
releasing unused reserves 223
removing from a scheduled class 228
setting additional reserves 225
setting for a new course 162
Reserve Capacity Sequence
described 162
removing 228, 229
removing a row in 230
Reserved for Frosh
defined 282
Reserving Seats
for selected student groups
existing course 218
new course 162
Resource 25
defined 282
restrictions 171
Retrieving a Single Record
on the Course Catalog page 69
Rolling a Class
defined 282
Rolling Classes into a New Term 126
Room Assignment
See Classroom Assignment
Run Control
creating new 287
defined 282
described 286
editing 288
naming 287
Run with Default
explained 286
Running Processes
described 286
Running the Pre-Worksheet Course List 115, 119
S
Sample Reading List
changing for a scheduled class 197
entering for a new course 144
introduced 132
Save
provisional, defined 281
Saving Changes
and effective-dated rows 102
Schedule Changes
and approvals 114, 115
Schedule New Course Page Group
accessing a course 133, 134
described 132, 133
navigation and purpose of 29
using 131
Schedule of Classes
and classroom assignment 250
capturing changes from the Course Catalog 107
defined 282
loading data from the Course Catalog 133
synchronizing changes with the Course Catalog 107
working with a list of scheduled classes 169
Schedule of Classes Page Group
navigation and purpose of 29
pages used for adding a new section 168
Schedule, Instructor
viewing 308
Schedule, Meeting
changing 181
Scheduled Classes
displaying, in the Schedule of Classes page group 169
Index

Scheduling a New Course
adding the reading list 144
changing attributes 140
changing the description 142
entering the web site 142
providing additional information 146
scheduling the meetings 150
selecting the topic 138
setting enrollment controls 158
setting grading requirements 148
setting reserve capacity 162
Scheduling Classes
introduced 114
Scheduling Meetings
for a new course 150
Scheduling Processes
using Process Scheduler 288
SCORE (Student Course Online Registration Engine)
defined 282
Scrolling
in a text field 46
Search List
displaying for a single record 31
filtering 35
filtering a search list 35
maximum number of records 34
navigating though 35
retrieving a list of records 32
retrieving a single record 30
using to find courses 72
Section Number
for subsections 137
format of 137, 174
Section, Enrollment
and primary component 275
Sections
adding for a new course 135
adding to scheduled courses
introduced 168
cancelling 210
changing scheduled meeting times 181
deleting from scheduled courses
described 179
introduced 168
deleting vs. cancelling 168
numbering format 174
scheduling for a new course 150
sequence of display 172
setting enrollment section 174
setting standard meeting pattern for 150
tentative, defined 283
timing of 168
watching enrollment totals for 271
See Instructor Checkbox
in Reading List, using 199
on Sample Reading List page 146
Selection Lists
for Look up buttons, introduced 17
Service Indicator
defined 282
Setting a non-standard meeting pattern 154
Setting Defaults
for operator-specific values 291
Setting Enrollment Capacity
and classroom assignment 260
Setting Enrollment Controls
for a new course 159
Setting Meeting Pattern
for a new section 175
Setting Reserves
for selected groups of students 218
Shared Classes
and classroom assignment 261
Short Title Field
on the Catalog Data page 46
Signing off
PeopleSoft Student Administration System 25
Signing on 21
Signing out
and active processes 25
Special Characters
entering in text fields 46, 144, 193, 294
Standard Meeting Pattern
defined 282
setting for a new course 150
Stopping Enrollment
when cancelling a class 210
Student-Specific Permissions
assigning 273
assigning, introduced 270
defined 283
determining use of 273
setting the default date for 275
using to override enrollment capacity limit 269
Student-Specific Permissions Checkbox
and application/interview attribute 138
and application/interview courses 175
on Basic Data page 138
Subject Area 241
setting a default value for 291
Subsection
and prior term copy 126
defined 137, 174
numbering of 137, 174
Synchronization
  introduced 107
  of Course Catalog and Schedule of Classes 107
Print Report Only mode 108
Update and Print Report mode 108

T
TBA (To Be Announced)
  and meeting times 176
  changing meeting times for 176, 183
  meeting pattern, defined 183
Tentative Section
  defined 283
Term
  setting a default value for 292
Term Copy
  defined 281
Term Offered
  setting the attribute for 51
  values 51
Term Roll
  defined 282
Text Fields
  inserting special characters in 294
The Instructor List, Filtered by Academic Organization
  206
Title/Journal Title Field
  on Sample Reading List page 145
To Do
  defined 283
Topic ID
  defined 283
Topic Page, Schedule New Course Page Group
  using 138
Topics
  adding for a new course 52
  adding for an existing course 85
  and approvals 85
  changing in the Schedule of Classes 190
  selecting for a term 138
  term and course catalog 140
  when not in the defined list 190
Topics Page, Course Catalog
  using 52, 85
Transcript Field
  on the Catalog Data page 46

U
Underscored Text
  entering in text fields 47, 143, 193
Unlimited Enrollment
  defined 280
Update/Display Search List
  retrieving a single record 30
UserID
  obtaining 24

V
Viewing an Instructor’s Schedule 308

W
Web Address
  entering for the class 144
Web Enrollment
  and enrollment controls 269
  overview 268
Worksheet, Classroom Assignment
  completing 260
  described 254
  printing 251
Worksheets, Class
  introduced 119
  printing 121
  printing for a single course 122
  printing for a single term 122
  printing for a specific instructor 122
  printing for several consecutive terms 122
  use in course management 11
  using to identify classes to be copied 125